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1. A7 by 7 Eol~AfarCa—ZEF TV v 7 LET,
2.CD-ROM RIA 7% EZ T2V v LET,

3.ty N7 v I T F ¥ — (MASCOTSetup.exe) X 7NV v 795,

3. XA M A=a2—K%V, <Install license key>%#®{R L, Y27/ K« F—+ FTANNEAL LA F—)L
LET,

KA A=V FEHE, 1-53. TAEBLV A F—+ RTIARDA A M—VEZBH
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H1wE

A MVA=a2—5D, <Install MASCOT> %R L, TMASCOT| 77V r—va UARIKEA A |
—/LLET,

A A M= FIEIZ, 156, 77V r—valdDf A N—ILERR
WMENZ)G U, <MASCOT License Publishing Tool > #H¢R L, B TEHEAL CWeZWEEY 2 — L %
FESNTWDET AR« F— (USB F—) TEHEWVWWZZTL2CT74 B ANFEEESHBXE

’9‘_‘0

BT, 4R == T T,
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1-5-3. SA4EVR-F—+ FSANRDA VR =)L

1. By T o7 I70Fv—DFA b A=a2—5D, <Install license key> % #3 & |

F—=nU 4P — FREBLET,

Sentinel System Driver Setup is preparing the InstallShield \Wizard
|y1-.’—1 which will guide you through the program setup process. Please

W wait.

ENNNNREER

Cancel

Welcome to the InstallShield Wizard for
Sentinel System Driver

The InstallShield(R) Wizard will install Sentinel System Driver on
your computer, To continue, click Next,

License Agreement

Please read the following license agreement carefully.

em Driver - IhetallShield Wizard

<Next>%- vy LZEY,

All Products (including developer's kits, Sentinel hardware keys, diskettes or other 4
magnetic media, software, documentation and all future orders) are subject to the

charges.

terms stated below. If you disagree with these terms, please return the Product and
the documentation to Rainbow, postage prepaid, within three days of your receipt,
and Rainbow will provide you with a refund, less freight and normal handling

RIARDA A

1. Youmaynot copy orr
authotized in item 2 below.
patt of the Product constitr

roduce all or any part of the Product, except as

@ [I accept the terms

| icense

in the

emoval, emulation of reverse-engineeting of all or any
s an unauthorized modification to the Product and is d

' 1 accept the terms in the license agreement

" T do not accept the terms in the license agreement

Q@<Next>%2 Y vy LET,

Instalistield

Cancel

N\

« Back

1-12




{& Sentine Shield W
Setup Type

Choose the setup type that best suits your needs.

Please select a setup type.

" Lomplete : < ©)

[Complete] # IR L FT,

program features will be installed. (Requires the most disk
space.)

' Custom

Choose which program features you want installed and where they
will be installed. Recommended for advanced users,

<Next>%2UwoLFET,

@
rg

< Back (I Mext > I Cancel I

Installstield

ield Wizard

Ready to Install the Program

The wizard is ready to begin installation.

Click Install to begin the installation.

If you want to review or change any of your installation settings, click Back. Click Cancel to
exit the wizard,

IMPORTANT:
Please remove all USB SuperPro keys before continuing!

Installstield

3 Cancel

<InstalI>Z2Uw o LET,
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Installing Sentinel System Driver

The program features you selected are being installed.

[d] Please wait while the InstallShield Wizard installs Sentinel System Driver.
This may take several minutes.

Status:
Generating script operations for action:

Installshield

InstallShield Wizard Completed

The InstallShield Wizard has successfully installed Sentinel
System Driver. Click Finish to exit the wizard.

<Finish>Z2 Vv L%EY,

¥ <Finish> % L72%. Windows OFEBEIZ{ET A v —URNEREINTEHEIEL. A v =2t
WHEREIZIT o TR EW,
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6. TAEBUAF—% USBaxs X |IEEHELET,

L0 — EaTPHERNELE

ADAR=IHFTE

l Windows 735 £ £ 2 « ¥ —Diik%
HERIICITVE T,

E Rainbow USE SuperPro

LON—EOIPAR M0ELE

PETTIAEBVR «F— 1 RTARNDA LA F—)VIFFET TT,
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1-5-4.

B
1t

SAEVR - XF—FA VR M—LENCEH/LE-BE

Windows 74 B A « F—O#HETZHKL T, RTANDA VA M—/VEEPERSINET,

LGN - EOIPAR DANELE

%@ USB Token

D
ADAR=IFTT .

B

FHLON —EOT7ORFEIY - OFE

FLON-FOIPOREOH -

cOH—FTE, N—FI17 FEA2ABOT A A B3 ROA 2
AR=IETOFET.

BEATEBIEL. GRA] BDURHUTEE D

#v‘ﬁz»/\l

\

CITR<FyYoEL>EYVYYYILT,
N—FOz7DBREVAF—FERTSEET,

1-16



1-5-5. SA4 VR - F—HBEBSIIG LGS

RN, TA B R« F—D RTA "DBEBHL TV HENREZALNET,
ZOHEIT, ROFIRTREH L. FIA 2HIERL, BEETLZ LIk TR TE X7,

TAR VA F—% PCICHERLET,
L. [FTrgxvwx—Ux]zEshLET,
2. [ZOMOFT AL RJHEBIZ, TA 3 AZHEW SO [USB Token] REFENTHET DT,
EOTAarELA7 Dy L, THIRTLET (FREZZM]),

} J—iy B ;IQJ&
Jt%ﬁs(n) awm]«--»l%l@ |

BB KRR

w-¢2) DVD/CD-ROM k3547

I % IDE ATA/ATAPI 2/ b0—3

= SCSI & RAID J/bO0-2

USB {Universal Serial Bus) 2/ hO0-3
Rt e e

IR W P e R

-G YU R EFA BAUY -L 303
B YATL TSR

E] ‘g' ZOMOT /A A

67,\ USE Token

l D F4AD B4
w- ) FaAF A PR =
e A I S T2 Ty S
#-53 70vE- F1A!
- #-&D J0vE - T4 2087 1(R)

w-  R—b (COM & LPT)

A @ OIAEEDEMDAA T8 TIAA
; E-R

310

3. IAEBVR - F—Z PCOLIVAL, PCERERLET,

4. PCEBILE LS, [Administrator] HEfR % Ff o2 —F—& T, v/ (v LET,

5, TAEVA-F—%HPCICERLET, ELWKRIANRDA A=V ERBLETOT, V4 FUD
FRRITHEV, D TT SV,

6. MUFELEL, BETAA AYX—Uy]28EIL, RIAARELLERINZ0EMELET, KK
DEITRIARNPRHAENTWVWELEL, EFTY,
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- % IDE ATA/ATAPL Tk0—5
& SCSI & RAID Jvh0-3

frnl

oy DO o O e DO o O e O o O O )

rw B rw )

o)

frul
e

frul
=

USB (Universal Serial Bus) I/ bO0—3
22 F—h-F
P e R
< HOU R, BT BEUS -4 O 0-3

- AT L T
H-E3 T4AD B34
o Ay =D PEIA

H- 20vE— F«AHD 2 b0-3
H-&3 20— F(AD B3
Jg IIAEEOENORA T8 FIAA

W F T THEIR

K- (COM ¥ LPT

=4
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1-5-6. 77Us—LavmA4A R =)L

1. By T v FT70Fv—DFA L A==2—5V, <Install MASCOT > %##f9- &, TMASCOT] 77V
= a VRIEDA A =T 4 = FREE L £,

AN - O ERELTUET .

MASCOT Offshore 73 P 2HE, 204341y Py OFNE%
gﬁ@gé InstaliShield Wizard 22E{RLTHET. LIESHETS

Windows Installer 533 ELTOET

MASCOT OffshorefADInstaliShield 44— FALSCE

InstaliShield(R) ™ — k{3, C{ERAOIE1-5A MASCOT
ggfhore EAUAR=ILET, DRAIEIIALT, FHITLT
Fatal NS

EE: CO70NTLE. FEEESLUEMRBE(CL-TIREE
ENTHET.

SRA>ETIVILES,
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{ERFEEE2R
AROERFEINEE IR BEGIEN

A VA= IHIHCLTHHRMILIES

LBERZEA VA - INTBAIC. FEROV I I 7ERFEEELT
HBEAHIEE 0,

@ [FERAFEZHOFEICABELES W]
EERLES,

B JrD 7P ERASFESE

o, BHEREIBACEEZ RICBEY DR IE TS,
@R8N 7k Zrr  FarasecoT () 1 R ¥R ParascoT tud
® (FRFEEOEACRIELET(A)

o 00 =

InstallShield

- <maB( [ ram)y> | D) x|

Q<KRA>ED VY I LET,

AUAR=ILFEOTAHILH

COIFNAA A=W BIHEE. DRAJED DU THEED, S'Jél
SAR-NERIHER. TEE IR »ILET, i

[j_j MASCOT Offshore (A4 A b—JL5E:
’ C:#Program Files (x86¥MASCOT¥MASCOT Offshore V1¥ | @ (q)... |

InstaliShield

L <EaE) | Eam)> | ) Fevta |

SRA>EVIVYILES,
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FOUSLEA LA M-I DEERITERLE
8- FEL AVAR- LV ERNE S DEERIT EF L.

TA AR IED ST, A AR ERE LTS,

ALAL-NOEREESRBUNERE IDIHSH. TRIEDIIUTEED T ED
Uehdde. I -FERTLES.

InstallShield

- <ma@ (| ar-nm | ) et |

S<AVAF=I>EVIYILETS,

MASCOT Offshore %4 A M-)LLTOET
BRLEZ DI LIRER VA M- LLTOFS,

InstaliShield 4 —kiF. MASCOT Offshore &4 A —JLLTHET. L
[IECBIFEEE

AT—RA:
LG IPA LEIR-LT0ES
||

InstallShield

< F5(8) SRAN) >
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InstaliShield 2+ - F&5E T LELE

InstaliShield ™.r— {3, MASCOT Offshore %1E¥(C1 /A
b=l LEL, TFET 1B 9DLT, oY - FER T LTS

(Y

<ET>EVUvILFEYS,

e G

9. AVAPM=AREFKTLET L, Windows D[AF—MA==2—D[F 1 /T Al
[MASCOTI & WS ZRiID A =2 —MEFSNET,

MAA VA F—FiL.NET 2.0 Framework ZF|H L TWE,
A VA b—=nN%%T7 5 PCIZ.NET Framework 84 2 h— /L ERTORNEE, £ VA b—VERT Ay E—U
FREET,
EAE—VPRRENE LD, A VR F—=TF DRI, VX b=V EfToOTFEL,

MASCQOT Offshore - InstallShield Wizard

InstallShield optionally uses the Microsoft (R) .NET 2.0 Framework.
Would you like to install it now?

UETT 7V r—varOf VA M—/M35ET T,
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1-5-1.

FoAVA =)L

<T7IIVr—o3 D7 oA VR F—=IL>

1.  Windows D[A % — MNA =2 —DRREINS, [ar be— xR E 7,

2. [Fes5r07 A4 A M= RIRLET,

3. FRENEFATuasDY R M5, [MASCOT Offshore] Z#IR L, <7 A A M= >%ELET,

®© v 1 E > IO SERIL > FATOTISNI-)L SRIVEE » TDOS5ALHEE vi¢| | T0¥5h.. £

RS TOISLOTIAVAP-NERGES
%‘j}r—wmrzﬁﬁfﬂﬁbi TOGSLETIAVA-NT B} —ENSTOTFLERRUT [FoAYAM-IL], [ZE] £l H8E] 20 0wHLET.
Z

& windows QHEEOEMLELR
it

r’J‘ Aquatic Zone Network Co.,LTD. E&/(-2z>: 1.02.0007

ANILTOUS:  http://www.AquaticZoneNetworkCo.,LTD..com

BB - AN EE &8 = -
28 ‘ T Si-5ay
= -

[[&]MASCOT Offshore ST etwork Co,LTD. __ 1.02.0007
ZE(C)
1&15(E)

4. HIBROHEREZMWEDLETCEETOT, <IIWVW>EMLET,

,;i!\ MASCOT Offshore 274> Ab—JLLETH?

O 2% zo54708 fwhzemsian | Bwy) | [ wwam) |

5. TUAVAM—ANREBENET,

6. TUALVAI—ANRETTDHE, KT LEZEEETDAvE—UNREREINETOT, <OK>ZEIRL

T, 7oA A M=V EFET LET,
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<FLEVR - F— - FIANDT oA VA —IL>

Windows D[A ¥ — A =2 —DREIND, [7r br—n "XV 2f&E £7,

[77V r—va ot Bkl 228K L £,

FRENTELZA T T DY AR5, [Sentinel System Driver InstrallerX. X . X] & #4R L |
F—>%EMLET,

&= » 2> PO tRL » TOS5A )y TOUSACKE <[4 7o
3 hO—I SR =L FOISADT o4 YA —LERRES
AR b—LENZEH/0 TOOSLET YA P—ILTRCE. —ENsTOISATERUT (P21 2R MLl
HSLERT [ZE]. Fizid HEE]l 22V HLET.
B Windows OEEEDEIMLER
L BE v FUAVAN-L EE BE =~ @
A . R s
% Realtek Ethernet Controller Driver Realtek
% Realtek High Definition Audic Driver Realtek Semiconductor Corp.
$&f Realtek PCIE Card Reader Realtek Semiconductor Corp.
B Sentinel System Driver Installer 7.5.8 SafeMet, Inc. 5
Pa' Sierra Wireless AirCard Watcher Sierra Wireless Inc. i
g Sierra Wireless QMI Driver Package Sierra Wireless Inc.
[@) Synaptics Pointing Device Driver Synaptics Incorporated -
4| [} »
‘ SafeNet, Inc. HR/(—T=2: 7.5.8
k LT DI 4 htkp:/fwww.safenet-inc.com/Support

HIBROMERZRWEDbETCEETOT, <V >EMLET,

JOT5 AR

i Sentinel System Driver Installer 7.5.8 P A b—ILLETH?

[l &%, coy(700 fwsrzmmian | @By | [ vuam |

T oA VA M= ENET,

#
1t

<T AR

TUoA A R=ABERTTEE KT LIEZER2EFA A v =R ERENFTTOT, <OK>EZIRL

T, 7oA VA= E5%ETLET,
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1-6. 7IVs5—2arnEMERT
1-6-1. 28

1. USB: A4k A-F—%, USBaxZZl#kkLET,

2. Windows O[AFZ—hA=a—Lv, [FXTHOF e F A]-[MASCOTI-[MASCOT Offshore]-[MASCOT
Offshore V1] A = = — i & V. MASCOT Offshore Z#£8) L ¥4 (FrROHNXEZSR),
i MAscoT
MASCOT Project Selector
E MET. Database k=l
&, NEDO-DB Converter
@) TSA Wizard
| MASCOT Offshore
X MASCOT Offshore Manual
[ 78] MASCOT Offshore V1 |v
> IRw0TII5A | il
[GoTsneor e 2| |Fod5uETr1v0Es 2|
T;: |n:| & ol
None[Project]
1-6-2. #T

MASCOT Offshore ®[File]-[Exit] # = = — & 8IR, & L < I1Lw ¢ > F"70> RELEIY 7B L
12X V. MASCOT Offshore % T L £,
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%28 Quick Start Tutorial (BHr=EIB)

ARFETIZ, MASCOT Offshore DEEARR 2N 2 B+ 2 72012, fHER2E1 2 W TRI L £7,

% 2 E Quick Start Tutorial (BRHTTEME)  .oooovieeieeiieeieee ettt ettt ettt e et e e e e seae st e saeeeteeteeatesaaesasesteeeteeresnesnnas 2-1
271, BUREOITETR .otttk h ekt k ekttt ettt 2-2
22, MASCOT OffShore DERE ......cvoveieieiieeieie et 2-3

2271, I D B DAERL ceeeeetieeee bbbttt h ettt b et ne bt ne b ene 2-4
2-2-2, BT — R AIE D EREE oveveveveiiiiee ettt bbbttt b bbbt sttt bbb e 2-6
2-2-3, FRHTHLAE D JETE EEZE D AR 1ovoveveveeitiiiieeee ettt a ettt st b bbb b s seses st bbb e b e st et es s s s s b esne 2-8
2-3. MPEKXEGEOFEMFHE] X0 [RIMFHEZ B L7 RO HIFIC X 2 FERE) OMITRE............. 2-11
223, B Rl DB A 1ottt R kbRt ettt ettt aneeee 2-11
27372, JEHT O TEAT etttk ekttt 2-13
2373, JEHTAE T DD ZRITR co ettt bbbkttt 2-14
2-4. B & FHIRDOIREREICI T 2 FREEIE TS L OYEBLDFEA ...coovoveeee e 2-17
2o, B Rl DB A ¢tttk bt e ekttt ettt ettt eeee 2-17
22, T D) BT ottt ettt b et b et b et et a ettt h st b st b st s bRt sk e st s b e st b s e st s b eat s ete st s esens 2-23
243, FEHTAE T ODZRITR co ettt 2-24
2-5. ZEFIIL/ ST A= B D w71 ottt 2-33
2-5-1. 2 M AR AN BRI EE T 2 OB vttt b e bbbt s s 2-33
2-5-2. AMeDAS 7 — ¥ 2 B TEHUR DIRERFIT — H ZAERL coveieeiieieiscceeiee e 2-36
2-5-3. 7 AKX ARERINT — & OJRFEIEFLHIAL SO et 2-38
25, AFEFERIEGE DT .ottt 2-42
2-5-5. BJA & FHIEIZ X DIRA KBTI DR RKBIE DO FFBFHMEZ FE oo 2-44
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2-1.  PIEDMRES

MASCOT Offshore IZLL T 4 S OfEEH L £ 7,

o HLIIBUDZHLWERNATA—FDOT —HX—2R

o HJA L FHEDRARMEICI T 2 MEEE O FETEERE (%)

o HELEHIEDRARMEICLT 2 ENO MRS

o ELMREEE, FEKEE, BEELZO~ v SIEFME (REL)

o  FREHCXEZR 1AFEFHMMOME, FHMRER 1 R OB ~OZEHERE (R3EEE)
KA T —HZ X—2 (BI5E) IREFTHY T8, FHEAST XA —XITFEREL 2V T,

MASCOT Offshore |2 X 5B EFIEIL TN R T THERS- SIS N7 E S 100.0m ORFEEZEHTHZ L2 BELT
WET,
BIEIZRIT 5 7 u Y =7 F41%, “tutorial Offshore”: L, 7’82 Y= 7 M OIERBFTIZY T NATF—Z DA v A2 b= T
LA R¥a A MNELET,
¥ A RFX2 AV MIPCREICEIVAERDVETOT, Av=271TiE [ 00@® | LERLET,

EEE

!
\

- E=E FIER)I| ;
56 . L‘_"“-\@
/ o @ *"’f%.?w.s_r

— HEE#S

B 2-1 BB E O FIREHR
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2-2.

MASCOT Offshore MDEEE}

1.

b

MASCOT
Offshore V1

File View Help

DEH a6
Project a
None[Project]

Ready

Output

L x|

W <« » ¥ \log/

CAP/ NUM SCRL

2-3

B

Rl

Windows DO[A % — R A ==2—X v [MASCOT Offshore V1] %33R L. MASCOT Offshore Zi&&E L £,



2-2-1. FAYz ) FOER

1. [File] # = = —»>5[Create New Project...  Ctrl+N]Zi®R L £7,

File | View Help
- L) Create New Project.. Ctri=N
o E Open Project... Ctrl=0

Print Setup...

Exit

2. FREINTEXATuZT, [Folder list]inb 727 MEEMRTSH 7 40X %2IRLE T, [Project namelic”
nYxs NMaEANILTLET,

Folder list Project name
i g TAD b A Imtorial_OFFshore
S k| R

[+ Create folder of the project name

Description
Imhorial_DFFshore

b

i

IV
W
W
W
o
Al
Wl
ol

e

—_—————

Project file
C:¥Users¥ 0 ¥Documents¥tutorial_Offshore¥tutorial_Offshare.mof

3. W&IZ, <Create>%# L, 7uv= FEEKRLET,

VERR S NT= 7 5 : @ @@ tutorial Offshore¥
A=RVES/ BN % : tutorial Offshore.mof
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4.

WwEl, 7u Y= b ZB< BRI MASCOT Offshore % ) L, [Filel-[Open Project...

Ctrl+O] Z @R L. Y

HEFRL T =7 N7 7 A/ (fF] : tutorial_Offshore.mof) ZBIR L CT<PHO)>%227V v LE1,

‘| File | view Help

| 1 Create New Project... Ctri=N
p L7 Open Project... ctrl+0
Print Setup...
Exit

1 L. « MASCOT_Samples » Tutorial_Offshore » v & Tutorial_Offshoreig= »r
=By FLTHS- =~ I @
) MASCOT_Samples A~ 2% ’ =5 H4Z
FTECRAR o 2
1. Project .

| b Tutorial_Offshore.mof MASCOT Offsho... 18]

v

F7A1%(N): | Tutorial_Offshore.mof v| | MASCOT Offshore Projects ( v|

[ o) || e |




2-2-2. BRAT—A2AR—REHROER
1.  [Tooll-[Typhoon database...] # = = —Z3#&IK L £7°,

File Edit Run View [Tool | Window Help

NEH | =5 | & ¢ Typhoon database..
;roject | Design site & Speed up ratio 4
E- Tmoria'[ProjeCt] Create wind speed ratio...

- [EtV]

i Convert time series data...
®- [Monte-Carlo]

AMeDAS data converter...
Divide the wind velocity according to the origin...
Composition of the tropical cyclone and the extratropical cyclone...

2.  FrrEN7z[Typhoon Databasel ¥ A 71 7/ OFEE 2% E L £,

Database directory IC:¥Program Files¥MASCOT¥MASCOT Offshore V1¥TDBY

Kind of the database IR.DSCt ;I

Period of extracted data " Al periods of data Beginning : |1951 End: IZﬂU?
% Arbitrary period Beqinning : |1951 End : |2007

DE information file name C:¥Users¥ 8 ¥Documents¥MASCOT_Samples#. . ¥tutorial_R15_1961-2007.mtdb

Save

EJ S

Database directory IC:¥Program Files¥MASCOT¥MASCOT Offshore V1¥TDB¥

Kind of the database IR-lE ;I

Period of extracted data " Al periods of data Beginning : Ilg?'? End: IZ’:‘l6
|197? End : |2015

DB information file name C:¥Users¥ i ¥Documents¥MASCOT_Samples¥. . ¥tutorial_R15_1977-2016.mtdb

' Arbitrary period Beginning :

Save

[Database directory] CRET R ARSI TWA T A NV EERELET,
PCOYAT L) C KTA 7 OY6E @HIZLLFO 7 4V Z[TDBI&ZHEE L £7,
C:¥Program Files¥MASCOT¥MASCOT Offshore VI¥TDB¥

[Kind of databasel NSV S B RT — ¥ X—2AOHEEEEELET,
wE, FELTHhE “RDSCt” &, L ThT “R-157 28R L £ 7,

[Period of extracted datal : fEHTICHAVD ERT — & X—2AOHMZHEELE T,
WHE 1. [All periods of data 1% 7#IR L £,
[Kind of database] T “RDSCt” #4R7E L7=HA 1% 1961 4:LAKE, “R-15”7 & 4R7E L7
AL 1977 LA ZARE L £,
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[DB information file name] :

<Save>

< Cancel >

ENTIZH WD BT — X RXR—AHFRERTT D7 7 A NVAERELET,
BRT = RX=AFERT 7 ANDT T AV FORGFERIT T =7 b7V ZANOD

[Libraryl-[Offshore_DB] T,

EDRIFEATVE T,
i 2 Al L CRITIIE (R D F 9

2-7
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2-2-3. bR EORELEDOEE
1.  [Tooll-[Design site & Speed up ratio]-[Create...] * == —Z#IR L 7,

‘ File Edit Run View | Tool | Window Help

Rl gl £y ’ & Typhoon database... I

i’roject i Design site & Speed up ratio 4 Create...
Edit...

E--'I:utorial[Project] Create wind speed ratio...
+- [EtV]
[Monte-Carlo]

Convert time series data...

AMeDAS data converter...
Divide the wind velocity according to the origin...

Composition of the tropical cyclone and the extratropical cyclone...

2.  FrEN7-[Design site & Speed up ratiol ¥4 7 0 FOKIER ZHE L £,

MASCOT project file D
Project tree Site information Add... | Edit. .. | Delete |
None Mo. | Site name | Latitude | Longitude | Height

Site list file

2-8



=L
23

£

B -

MASCOT project file

Project tree

C:¥Users¥ & ¥Documents¥MASCOT_Samples¥Engineering_for_Typhoon¥Engineering_for_Typhoon.meg

=

Delete |

Site information Add... | Edit... |

- Project
E}-Default Site
. L~ CHOSHI_MET(New)
i i-ObsTower100m
.. A Ocean
B Tutorial
... Site

| Latitude | Longitude
35°40°41.87"  140°49'35.91"

No. I Site name
1 Site

| Height
100.0

<

Site list file

[MASCOT Project file]

[Project tree]

=]

[Site information]

IC:¥Users¥ . ¥Documents¥MASCOT_Samples¥Tutorial_Offshore¥Library¥W5S_Ratio¥tutorial_sitelist.min

: MASCOT Engineering D71 =27 b7 7 A L &EIFE L £7,

H I MASCOT Engineering TERREBEDMIBIC & A EI8EE (EstoBHEL) 25
ELTBMEIHYET,

: [MASCOT Project file] CH5 /€ L 7= [Project treel 3F R S E T,
: [Project tree] THIR L7z 7' m ¥ = 7 ME#H A MASCOT Offshore D77 = 27 MIA VR

—hFLET,

DA VA= B LTEATHURIE RO U 2 b D3RR SR T

A UR—FrENDLZT Vs MERIZLLTD 75T,

- [Site name] s FRATHL R 4

- [Latitude] s AT M OO R

+ [Longitude] : FRAT LR DR EE

- [Height] - AT HEAL D ) & (m)

- [EtV] 2 JEL A B O - IR O ML & B B RS
- [Yaw]  JEL ) 31 0D R 1 {1

- [EtS] : JELE) B 0> 2 Bl R OO ML & B A IEAR SR

« BRI o AR B OEHRIZONWTHHRFEI N TOE T, \m E TR+ Lid T EHA,
RSB/ 4 1%, MASCOT Engineering 7> HRER L TL 72 &0,

L AT LR fE O ORI FE DI R RTF T2 7 7 A VA B RRELE T,

RN RS DO EGE L ITE R 7 7 A VDT 7 3V hOIRIERIZ T 0 =7 R T 3V E RO
[Library]-[WS_Ratio]l T,

: [Site information] &R U 7= AT S OSLEF R, EABIE RSN FE RS E T

(A ZH),

[Site list file]
<View >
<Save> D ERIE
< Cancel > R

EDORAFZITVET,
2 e U CRITME ISR Y £,
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No.

1

Site

Site

Latitude

35° 407 41.87"

Longitude

140° 45" 35.917

Height

1o0.0

T i o
¥ird Directicn [eg )

T i o
¥ird Directicn [eg )

2-10

il T il
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2-3.

R OEFEE

2-3-1. RHEHORE
1.

[FRAREOBERMFIE] LU TARAFEEEE L-FHREDHTIC K HFHE

[Project] > V —m5[EtVIZA4 2 U v 27 L, [Create New Case... ]2 == — &R L £7,

File Edit Run View Tool Window Help

DEH wl ae
Project o
= Tutorial[Project] ‘

- [Em

- [M¢ Create New Case...

Tool 4

Start run of all cases

Start run of select cases...

2.

Fr &N 7z[Create New Casel ¥ 4 7T u V7 OXHBEZHELET,

Case name
Description IEt‘u'_Case 1

—Basic settings —Generation of virtual tropical cycdones
Latitude |35 d |40 m |41-87 5 Simulation length I 10000 years
Longitude Il“U d I“'g m |35-91 5 Consider the correlation between parameters Yes -
Typhoon database information file Modify the parameters Yes <

IC:¥User. . $tutorial_1951-2007.mtdb

Reference... |

to fit the original probability distribution

—Prediction of wind speed

Vertical wind profile model

—Ewvaluation of tropical cydone parameters

—Analytical functions Consider the effect of local topography Yes -
Central pressure difference &p IMPDF jv Correction of averaging time Yes -
Radius of maximum winds Rm IMPDF 'I Consider the uncertzinty Yes -
Translation velodty [ IMPDF 'I site fist file
Approach direction 8 |”°""a' :I' Ci¥Users¥., ¥tutorial_sitelist.min Select... |
Minimum approach distance dmin Iquadraﬁc VI
Annual occurrence rate A IPoisson 'I

Correlations between parameters Yes

—Speed up ratio

-

ﬂ

Recurrence period

Swve | Cancel
[Case name] DRHRE — AR mERE
[Description] D ERHENAEERERT S
[Basic settings]  : T4 O HARNE & % E
[Latitude]l — : FeBET/ T A — X O R ORMEE, 4y, B)XAbiE+, FfE—. HANMHR
[Longitude] : fHilT /T A — X DR ORI, 47, FXHRIR+, IR —. HANHR

[Typhoon database information file]

<Reference >
[Evaluation of tropical cyclone parameters]
[Analytical functions]

[Central pressure difference AP]

: [Tooll-[Typhoon databasel

TRIE LT, BRT— 4= A

77 A NVEERE

BT =2 R 2ERT 7 A BR R E
C BT A —F ORI FE DS
| RO AN B A HRE

DL AUEAR R

=Ju

X E

2-11



- MPDF

[Radius of maximum winds Ry,]
- MPDF

[Translation velocity Cl
- MPDF

[Approach direction 6]
* normal

[Minimum approach distance dp;,]
+ quadratic

[Annual occurrence rate Al
* Poisson

[Correlations between parameters]

[Generation of virtual tropical cyclones]

[Simulation length]

#
[\
Rl

D IRA R BAECR
R K Tl J ok - %
D IRE R AT BAECK

s IEBLO A PR

: IR

D RBA%CR

: B RAERIFEAERAR

CANT Y oA B

CEENT A — ORI O RIE 21T 9 BIRK

AR R FE L DS AR E

AR R AT DR R (10 TR & LTSIZEW)

[Consider the correlation between parameters]

P BRENT A — 2 B OABREE B LT AT O I O EER

[Modify the parameters to fit the original probability distribution]

[Prediction of wind speed]

[Vertical wind profile model]

+ Engineering model

[
[Correction of averaging time]
[Consider the uncertainty]
[Site list file]

<Select>

[Speed up ratiol

[Recurrence period]
<Save>

< Cancel >

XKITEEEREZHPEHERLTCVET

o JEGEH
D BRELE T L D TFRR ¥

Consider the effect of local topography] :
B O CIRER O EZAT O D E N ORTE

D RRAEERBRET D NENORE

D M HERET LS T 7 A LV DFRE

: [Tooll-[Design site & Speed up ratiol Ta% /& L7=. EELFRFHHA T 7

D EREL LIRS AmITIR 9 £ 212, BELTAT A—ZOR/MELE

ZAT O I OIER

VR RE R SIS E S & B

e

: LEMET L

JRIFTHIIZAZ & 2 G OO 3 & R A 8 & 5 S 2 I O E

A VA EIR—IEE

R RV 2 B L T MRS & 2 B RUE OB D Y AR E D SE &

2

AX B

CEND USRS E TUE T D PRI 2 R E
D REME Z ORAT
CHTRATD, R LT BOEE A Ll &2 P U5
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2-3-2. FRITORTT
1 [Run]-[Start] # = = — &3 U, FEET, F#EPIEEZTOET,

File Edit Run View Tool Window Help

DEH a6 e

El Tutorial[Project]

2. [Runl-[Start] # = = —#BR L, FHHEE(T, FEPIEEZITOET,

—— FRAHFORX -

8. REMTOAyE—VBRFSNELED, FEZTTT,

@ Calculation finished.

A

HEKRTOA v E—Y

2-13



2-3-3. BITRROETR
L [Viewl 2 == —#@R L, ARMKEER, AR T A —5 OfEN RS ER 2R LET,

File Edit Run View Tool Window Help

[Monte-Carlc
Il IMA Best track data...

Prediction sites...

Estimated probability distribution of tropical cyclone parameters...
Estimated topographic multiplier...

of the annual

wind speed of tropical cyclone...

(1) [JMA Best track datal
BT A — 2SR L R o T BERDOEBRE S I L ET,

(2) [Prediction sites]
FABUT /R T A —Z AT & & R AR O W X & 4l L E

-5000—

=10000—

-15000t= | | | | | |
- 15000 10000 5000 [ 000 10000 15000

2-14



#
[\
Rl

(3) [Estimated probability distribution of tropical cyclone parameters]
BERT A— 2 OWRSAMEERR & AARE RO ARE R 2 RH L E T,
BAE. REEASSUIMEKICS SEE/S A —8 DRBEDH BE/NS A —2 DERI BB & UL
“J Estimated probability distribution of tropical nglée parameters -... = EoR

anpar ison between the measured probablitiy distribution I The functions
f tropical cyelone parameters and the model function 1
Gl prozars diffwwss 2P Fadivs &= macimm winds Fm ! 7@«.. i [l mimal Fanction naw © pommeter [

::?/

R 1. 55
[l dizar 'M'“:_Ed-d e |l 147
1 foamtral praces diffarance|2p

“F luwibul| distribution

= k=
i Loprrmal diztributi
|| Fafiuz of mcimm winds fm

lnlin,

fhuibul | distribution =
Hized diztribution »_WNizing cofficient|. 20

[ R Il

A
I
|
|
|
|
|
I
[
|
i
_ ¥ 23
: Tranzlation valosisy © lppronch dirwction & I feprorme] diztribution| =
T |I [Tranzlation wwlocity G N . I-: Fhaps poramter |1 5
| | faibull dizeribion (2 e P Ze
| oo " Il Tembaim o Wiming seaffimiant L 000
I|z" :, Decroach direction £ Porml disteibution 1_%1;“%
1=, z :
. = 1L ) ) N = T codfficiam [E0 W08 |
I II Minimm approech diztence  win Pl momial T T
il - II T T A S g T o B [T
. . I
: T g E = 0 II
1|..., Sinime sprouch diztancy dein \ o fomu] acarrace rate } it Frequenc\_.' distribution of annual mawinom gradient wind speed
1 it (bazed on_ measurement and_sinu lat jon
1=
| - |
k o
i : I == .
0. il |: |
i- b ! !
1L--- .. Lbd X ’ i TP I L.t X
] e of T Il 1
|
| g g g L . ’ r 5 |
_____ e e e ———a
= S o Tomt T imimE Beumr oo sl S iors SrameTare — — — 3
arrelation coefficient between tropical cyclone parameters N
! baszed on measurement ! ﬁlﬂ“ﬁtﬁ*@ ﬁl-;éigﬁwﬂiﬁtﬁﬁ
1 EEETGHRCa T e TerraTam T e B !
i ™ bt Fiud o heegemne] oozt o methead 1
i | | 05 T Bn LD L |00 T En 1
i In 2 1. 000 i. 00 1
ol Lo T T (N0 "
1 |COI Ssa] 3] 1. 000 (1] i (]
[| T FimE e o (] e ST ) [AEa] I
P O T = T e O P S ST = (0] 1

BAELRBERICE T SER/T A -5 OHEERE

(4) [Estimated topographic multiplier]
JEE R 2 B R L7 M L A TP EUEOFI 0 RO R e R A2 TR LET

. .
B Estimated topographic multiplier - [EtV_Casel] o -5
Clipboard copy | Export csv file... | Number of decimal places m
Case : IEW_Casel
No. | site [ etv|  Etv@d) |  Ets@d) | Eti(8d) | 6d |
1 Site 1.055 1.057 0.955 0.903 193.068

2-15



(5) [Estimated probability of the annual maximum wind speed of tropical cyclone]
FUTANBY I 2 b= g AT KD R SRR A U KD AR ORBOE O R R =R A s KL OV IR ELNME
ZHEE L ET,

BAEIC L 28E/T A —42 OHEEFRYK

Sinl-inle

Sl DBERHUSD 1 N DICRARENROVERICHT R R — P OEIR ATV E T,

DRSS OF RRIEO BB EE O —TER (TR) BNERREhET,

Export csv file... |

[Ufea)  [Thetad [Etv | Ets | Ea | sigma_U(... | sigma_P(r... |U(fat) | Sigma_U(... | Sigma_P(F... |
48.4009 180.2181 1.0557 0.9600 0.9040 0.3409 0.0000 45,8484 0.3184 0.0000
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2-4. ERLFHAOESKEICHITIBERES & VRN
2-4-1. BEFHOERTE
1.  [Project]> U —7>5[Monte-Carlol %47 V v 2 L. [Create New Case...] * =2 —Z3&R L 9,

‘ File Edit Run View Tool Window Help

PECIEETN

Ej-l- Tutorial[Project] -
-» [EtV]

B S = =
“7 ~ Create New Case...

‘ Tool

Start run of all cases

Start run of select cases...

2.  FR&EN7z[Case Settings-General-Createl # 1 7 1 7 OFIEHR 2% E L £,

Case name IMcnhe—Casel

Description IMonbe—Casel

Prediction site Select sitefst... |

| | siteo | Latitude | Lontigude
| sit= 354 40m 41875 140d 49m 35.91s

[Case name] DRHR — AR mERE

[Description] DR - ANE AR T D

[Select site list] D RN B GR U7 B R G LR Y Rk A jER
<Save> L BB & RAT

< Cancel > DHTRATD R LT ROEIE A EE Ll 2 P U5

2-17



3.  [Edit]-[Tropical cyclone parameters...] A =2 —%&R L, BED/ T A —F EZFRELF9,

File Edit Run View Tool

Window  Help

IR

=- Tutorial[Project]
- [EtV]
&1 [Monte-Carlo]

Delete

Tropical cyclone parameters...

Extratropical cyclone parameters...

- Edit » Edit Case...
Run 4
View »|
Case Option
Copy...

4.  FREN7z[Case Settings-Tropical cyclone parameters] %A 7 0 7 OEIEH Z % & L £,

Case name IMC_CBSEJ-

Description IMC_Casel

—Tropical Cyclone Database
Information file {*.mtdb)

C:¥Users¥ s ¥Documents¥MASCOT_Samples¥Tutorial_Offshore¥library¥Typhoon_DB¥tutorial _1961-2007.mtdb

—Evaluation of Tropical Cydone Parameters

—Generation of virtual tropical cydones

— Analytical functions
Central pressure difference Ap
Rm

Radius of maximum winds

Translation velocity C
Approach direction

Minimum approach distance

Annual occurrence rate

Simulation length

Consider the correlation between parameters

Modify the parameters
to fit the original probability distribution

—Prediction of wind speed
Vertical wind profile model

Consider the effect of local topography

Correlations between parameters Yes

Correction of averaging time

-

Consider the uncertainty

[Tropical Cyclone Database]
[information file(*.mtdb)]
[Evaluation of tropical cyclone parameters]
[Analytical functions]
[Central pressure difference AP]
- MPDF
[Radius of maximum winds R,,]
- MPDF

[Translation velocity (]

: [Tooll-[Typhoon database] TEXE L= BT — & ~— A {FH %
ERT = R=AFERT 7 A NVERE

D BIBST A —Z OWERGAFIE OS2 E

s RS A E

CPORUER T &=

DIRB MR BB

R OK T JE G > %

—Speed up ratio
Recurrence period

5
Fi



#
[\
Rl

- MPDF IR B RS A BAEOK
[Approach direction 6] AT M

* normal s ML BAECK
[Minimum approach distance ~dy,] — : FclEITERA

- quadratic D IRBAECK
[Annual occurrence rate Al B R FE A BUR

+ Poisson CART Y A A B

[Correlations between parameters] CRENT A —H I OMHBIRE DB E FIT 5 5D ORPUK
[Generation of virtual tropical cyclones] ARRAE RGOSR R E

[Simulation lengthl] AR R E AT HERERE (10 TERHE LTI EEW)
[Consider the correlation between parameters]

C AT A — 2 OB E B LT RAE AT O IS OEER

[Modify the parameters to fit the original probability distribution]

[Prediction of wind speed]
[Vertical wind profile model]

+ Engineering model

[Consider the effect of local topography] :

[Correction of averaging time]

[Consider the uncertaintyl

B L LM OAMIZI D &
ZAT O I I OIER
DG, A RESR SR E Sk
: ERIEE T L ORI

D LT T LK

JRFTHI I & % mGH
s BRI E LR O E %
: WA R O A FEME & BT D D

tnm

T, AL AT XA —Z ORUIMETE

DR & R & BT D SN OBGE

A

%r—'—»
DETE

RIEDOBIER OB EEET 25A13
[Option]-[Consideration of the uncertainty | Ci% @ L £

[Speed up ratio] R R A B R LT IS KX D R EGEOE 0 1 UREGR E DS &
RE
[Recurrence period] W UARE A BE T 2 B A 5 E
<Save> R ENE & PR AT
< Cancel > CHHAT . AW LB ARIE Ll AP C S

KITEEERE R PHAZR L TVET
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5. [Edit]-[Extratropical cyclone parameters...] * = = —ZER L, FHADO/ T A —F ZFRELFT,

 File Edit Run View Tool

PECTEET

Window Help

pjed

r.5|-: Tutorial[Project]
-» [EtV]
B [Monte-Cado]

Edit 4 Edit Case...

Tropical cyclone parameters...

Extratropical cyclone parameters...

Case Option 4

Copy...
Delete

6. For&ENiz[Case Settings -Extratropical cyclone parameters] %4 7 0 7 OFHEH R E L £,

Case name IMC_CESEJ-

Description IMC_Casel

—The Annual Maximum Wind Speed

The database of the annual -
maximum wind speed @ User define

Prediction sites

Site Mame | He_ightl Avaggeul Wing
Site 100.0 28.02

< I——

™ Power Curve File

[The Annual Maximum Wind Speed] : Ffx KJEGH X T A — & OF%E J7 k% B4R
[The database of the annual maximum wind speed]

ARG T — # X — 2 bl

[AMeDAS] : TAMeDAS data converter| FERDFERKEET 7 1 /L “ymax.dat” 22 HERE
[User define] TEEANTA—EE AT
< Close-up > : fRATREIE 2 5K ([The database of the annual maximum wind speed]F
DHFEN)
<Save> P RE M RIT
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i

< Cancel >

Prediction sites

CEELUREEAELME AL S
[User Define] #3#R L, FERAMET —F X—AERZELET,

7. FoRSNlEdit. XA 7w T EFEEE « AT EE O ERE ORI EITOE T,

Site Name | Average U | Sigma U | ‘Years |

Average u 128.019 1555
Sigma u I2.0566823
Years I 13

—Weibull

¥ Tropical Cydone

Weibull K 2,07

Alpha |0.0059778

IV Extratropical Cydone

Weibull K |1.87

Weibull C 9.51

[Prediction sites]
[Site name]
[Average Ul
[Sigma U]

<OK>
< Cancel >

2

2

x|

Cancel |

DA MER

DR LA M4

s AR RO

o AR IR R OO A YA 72

WA & il
WA & il

ERA)

%

e i
e i

o

I
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8.

Prediction sites

Site Name | Average U | Sigma U | ‘Years

0191555  2.056€

<Save>#ML T, IRFELET,

Case name IMC_CBSEJ-

Description IMC_Casel

—The Annual Maximum Wind Speed

e The database of the annual
maximum wind speed

% User define Edit... |

Prediction sites

Close-up |

Site Name__ | Height | Average U |

Winc

ul

Direction |

Site 100.0 28,02

< I——

™ Power Curve File

2-22




2-4-2. FRITORTT
1 [Run]-[Start] # = = — &3 U, FEET, F#EPIEEZTOET,

File Edit Run View Tool Window Help

DEHE a8

=- Tutorial[Project]
- [EtV]
& [Monte-Carlo]
B

Ll
o

2. <PFVWY>ZEEIRT D&, HENBRBSNET,

@ Does it calculate?
[LA(Y) I LWAE(N)

Case :MC_Casel [Monte-Carlo] §+§5@}qu DA t— o

Site : Site

Calculating...

1 I

3. FEMTOAYE—UBRRFRSNELED, FEZTTT,

A

ARETOA Y=Y

BRI O — RTHOWT, BT A — 24, BE/RT A —Z OfERDMRHEE,

DI UARBOEEEITOET,

2-23
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2-4-3.
1.

2w

BIFTERORT
[View]-[Estimated topographic multiplier...] A = = —&®R L, FHFERLZFERLET,

File Edit Run View Tool Window Help

DEH w6 e

5. Tutorial[Project]

@- [EtV]

g [Monte-CarIo]

J } List of estimated probability distribution of the annual maximum wind speed...

(1) [Viewl-[List of estimated probability distribution of the annual maximum wind speed...]

I — TR LT RT R AR T O, BRSO FER R 2 FR LET,

Case: [MC_Casel
T R —
[No.] ;LR No.
[Site] o R ELEERR M A B
(R] D HEMR (5F)
[ucl RARBEIC T B R
[6d] : FRATSE B JE )
(UT] CEEUC XD EE (RHEEMEOEE AL LI2ha3 o UT, o PT 258)
[UE] D RHIELC K R (REEMEOEBEE A E LIEHA13 o0 E 258)
[oC] DIREA MK L 2 EE O R [X]
[oUT] DRI K D G o AR (R = (RE O BURIE R K 2524 DX
[oPT] DRI K D EGE O ENR 7= (KUE OBLAIEEIC K 2340 k2l
[0UE] D BRI & 2 RGOSR ]
[al : JEGE OIEHEIR 2 351 D BRI O RS [3K]
< Clipboard copy > VR NEI Y T AR—FRlzar—
< Export csv file > : URAM&E CSVIEXT 7 A VI )
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[Sitel-[View] # = 2 — &R L, BEBKEK, BE/NT X —Z OfERSAR, FRFEREEZRRLET,

© File Edit Run View Tool

D@ 2 6e

Window Help

EI Tutorial[Project]
- [EtV]
B [Monte-Carlo]

JMA Best track data...

Prediction sites...

Estimated probability distribution of tropical cyclone parameters...

Estimated probability distribution of the annual maximum wind speed...
List of estimated probability distribution of the annual maximum wind speed...

Weibull...

(1) [Viewl-[JMA Best track data...]
BHHE/RT A =2kt g L o - B RO FEE RS A4 L ET,

182 188 T 150
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©)

TN T A — 2 AHIHALE & R AR D V-1 [X] 2 6 T

[View]-[Prediction sites ...]

LET,

Prediction Sites - [MC_Casel]

= e

=5000—

= 10000—

-15000H= | | | | |

-15000 =10000 -5000 o 5000 10000

_l
15000

(3

BENT A —F DRSS

BAlE, FESASLUSHBERICESER/NS

B GREA) : KAl
® (F M) : AA-ERE

IXT A —Z AL E

[View]-[Estimated probability distribution of tropical cyclone parameters...]

AT E A A & AR S IR 0D S A R A i

LET,
A= DEEST

#
[\
Rl

BE/NTS A =5 OERSHEARE S UEHE

-7 Estimated probability distribution of tropical cyclone/pémeters - [MC_Casel] [ -2 S

|
]
|
|
|
|
I
I3
-
L
|
B

[ET]

P_/

I

Winlaum appraach dlctanca duln

Ilr.

onpar ison between the mezsured probablitiv distribution
F tropical cvclone parameters and the model function
Cantral pragsurd diffaranca AP

Radlus ta maximum minds R

L | )

Carttral prazare di Farenc |2

|V petiue o mrimm wind: fm

T T T wimud

Translatian walacity © Appraash dirgstian B

I [frunslation wloziey

Mormal diztribution

I| Perroach direstion é

L

ferTEimal diztan

SET ’ T wwa

Annual accurrancd rata A

OTTITS
-

Correlation coefficient between tropical cyclone parameters

based on measurement

FAELREERIZEITHEE/NS

A —5 OEERYK

i bul | disei £ g5
fizing coefiziwn]
- o | Pinimam wpproech diztance  |dminpolmamis] I =
- / N T N N e R e B
I

|| Frequency distr ibution of annual maximom gradient wind speed
hased on measurerent and =simolation

I

arralatian saafficiant basad an maasuramant Carralatian caafficlant basad an !

2411194 arthazanal dacampasitian mathad 1

Tag [P} [Tag[Rmy__ [loz [of [ [ Tog [4P) [lag[Fmp__ [lag [t} [ duin 1

Tag [&F} |1 000 [T 1
Tag [Rmy_|-0. 373 T - 367 1.0

Taz Gl |-0.020 0.dz1 T aan (AL [RELE] (AT I

[l -1, 120 RN RN [T -1, 128 R 0. TA1 T_an 1

[0 1366 RAH c_367 RAELT] T_00n LRELE] RE] 0T REL] .00 |
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w2

» Comparison between the measured probability distribution of tropical cyclone parameters and the

model function (BAIMEELFHEMICESER/NT A —2 DEERS )

Compar izon between the mezsured probablitiv distr ibution
of tropical cyclone parameters and the mode| function

Gentral prazsure difference AP

o et
—Fariim
i |
s
o i
-1
=
a Ll
Li
L 1 1 1 1 ! 1

= 3
Inl-In|1-F}}

Tranzlation valocity G

0t st
—Fartim
i |
EE HH o
"
Z i
Li|-
Ll + =+ | 1
Inl-in[1-F})
_ Ninimun approach distance duin
2
-
=
h

.I1
I In+1)

[Central pressure difference AP]
[Radius of maximum wind R,, |
[Translation velocity Cl

[Approach direction 6]

[Minimum approach distance dp;,]

[Annual occurrence rate Al

® G A): BHIME (7272
— (B & =7

x (FAY) AR (7272

prababl |ty

__Radiuz to maxinun windz Rn

o et
—Fariim
)

Lik 1 1 1 1 1

= 3
Inl-In|1-F}}

_Approach diraction &

or 1
| < g T
narmslny

T.i.rmual ocourrence rate 1

L4 ¥ L
numb4ars af acsurranad

DL ARUEAR R

s IRAET
B AR AR

. BREERTEBIIES T 7)

. BEGERIZEAERITHERR)
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The model functions (BE/35 * —4 OEELSHEBAEE & UEHHE)

The mode | functions

Typhoon parameter name fnalytical function name & parameter Yalue
o 4. | |Mean 1.5830
Losnarmalsdlstilbutlon e andind deviat Ton | 151208
Central pressure difference|fp Weibull distribution k |[Shape parameter 3.6064
C |Scale parameter 44,3359
Mixed distribution a |Mixing coefficient [1.0000
oo .. | & |Mean 2.1081
Lognormal distribution = dard deviation |0.2538
Radius of maximum winds Rm . . : . k |Shape parameter 1.9228
Velballdistelbublon: o tocile varanster |168,0008
Mixed distribution a |Mixing coefficient |[0.6140
\ \ \ L |Mean 1.6460
Losnommalcd [ty Bt o & |[Standard deviation|0.1926
Translation velocity C k |Shape parameter 2.8111
Weibul | distributi
BBl CIStrIBR IO = Scale parameter  [54.2511
Mixed distribution a |Mixing coefficient |0.0950
i ; P STy & |Mean 139.43586
fpproach direction & Normal distribution 5 [Stendard deviation |25 7722
K : g . z |Model coefficient |-548.0374
Minimum approach distance |dmin|Polynomial ~oritical distance 1500.0000
fnnual occurrence rate A |Poisson distribution |[Am|Mean 3.0526

[Typhoon parameter name]
[Analytical function name & parameter]
[Value]
[Central pressure difference AP]
[Lognormal distribution]
[u Mean]
[0 Standard deviation]
[Weibull distribution]
[K Shape parameter]
[C Scale parameter]
[Mixed distribution]
[a Mixing coefficient]
[Radius to maximum winds R,,]
[Lognormal distribution]
[u Mean]
[0 Standard deviation]
[Weibull distribution]
[K Shape parameter]
[C Scale parameter]
[Mixed distribution]

[a Mixing coefficient]

P BENT A= L

D eI AN BE A L BN T A =S 4

BN T A — 2 BREM

PLREETE
L RSB RLS3 An B
;A fE
IR 7S
D UA TN B
N2 INES
s REERRER
S HRE AR R
CRE R
s I R s
: ORPECE R AR B
R
;BT
D UA TN
2D
D RERRER
R ARSI AT AR
CRE TR

2-28

op



[Translation velocity C]
[Lognormal distribution]
[z Mean]
[0 Standard deviation]
[Weibull distribution]
[K Shape parameter]
[C Scale parameter]
[Mixed distribution]
[a Mixing coefficient]
[Approach direction 6]
[Normal distribution]
[z Mean]
[0 Standard deviation]
[Minimum approach distance dp;,]
[Polynomiall
[z Model coefficient]
[r Critical distance]
[Annual occurrence rate Al
[Poisson distribution]

[4, Mean]

TR
s R BOERL AR B
D EEE
VRS
D U A TV B
BV 2N
s REERREL
SR itk
D RERE
AT I5 1
D IEFRAAR RE
D EEE
YRR
© I BRI PR
TIRPEBBRK
HBURIYEE
: PR PR
D BROFMIE L
CIRT YV oA B g
D SERERIFE A

B

Rl

Correlation coefficient between the tropical cyclone parameters based on measurement and the

simulation (BENE & {RBERIZEITHER/INT

A —43 OFEEFRE)

Correlation coefficient between tropical cyclone parameters

based on measurement

Correlation coefficient based on measurement Correlation coefficient based on
odified orthogonal decomposition method

log(aP) log (Rm) log(C) g dmin log (& P) log (Rm) log(C) & dmin
log(a P) [1.000 1.000
log (Rm) [0.005 1.000 0.004 1.000
log(C) 0. 151 0.338 1.000 0. 161 0.305 1.000
=] 0.1886 0.018 -0.130 1.000 0.173 0.032 -0.177 1.000
dmin 0.214 -0.286 -0.291 -0.253 1.000 0.203 -0.271 -0.2686 -0.248 1.000
[Correlation coefficient based on measurement] BB L2 RRRT A —Z B OFHES

[Correlation coefficient based on modified orthogonal decomposition method]

MEIEEAREHIEIC L DB RO BT A — X OB

[In(aP)]
[In(R,,)]
(In(0)]
[e]
[dminl

o

UL AUEAR R R Ol
R ORI R A D e H Al
s AT O E
D AT

EESUREL
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2w

Frequency distribution of annual maximum gradient wind speed based on measurement and

simulation (FiAELREEARICK S LEZRADERKEE)

60.0

o Measurement

50.0— Sinulation

40.0—

2 b o 20 50 1U|U 200 5EIIEI IEI|EIEI ZUIEIEI

RO RFORER Q). W] X, VI 7BLOREYVRERZ U THINI VT 58 BINEDY T 78
FOEDBY ¢ v Ry TR REINET,
% : (4)D[Central pressure difference APID T 7~ AR Z L THEINI ) v o T 5L, FTRIBEFERINET,

) Estimated probability distribution of tropical cyclone parameters -... oo
2 e o
,,central pressure difference AP
2.8 o Measurement 2
Function
2.6— x Model
2.4
o 2.
fl, 2.0~
b0
© 1.8
1.6—
1.4
1.2—
| | | | | |
1.0 ) =3 E o 1 T 2
In(-In(1-F))

NDEH =2 @e.

KBiC, Ve e D DR HEIY I FBE BRI TND L 2—DNEES U v

JIR— R~ar’™—CTx%x7,
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(4) [View] -[Estimated probability of the annual maximum wind speed...]
FTrTHNO Y 2 b— g KA SR AR & B AR KRR O FEB AR A B X O S AHE &
L £,

[Tropical Cyclone] RO T T 7 E
[Extratropical Cyclone] C ERROD T 7
[Combined Cyclone] RAERBED T T 7w
[a11] U ETRTO ST 7 A

& = |[Tropical Cyclone - -55‘5 =« -Hbdrafrop«cal Cyclone + !E‘s‘v =
= I
; S 5 3
Site g 3
8.9 . : . : : 0% . . site 1
s0.0F . s0.0F
40.0F B 40.0
» »
= o 1 = 3‘3-0/
= >
w.0b : w.0f 1
10.0f 1 10.0 ]
ﬁ i 1? 2? 50 100 2*0 5%0 1“?0 2000 2 5 10 20 50 100 200 500 1000 2000
1 1 ] L 1 | | I 1 | 1 ] ]
0.0 j 3 1 ¢ 0.0 i ] 1 3
=lnlt=inlF)) =In(-In(F))

«=c omblned ydone - !Eé& = « -HL : !E’& =
> >
0.0 : site 4 -~ site &
50.0 50.01
0.0 0.0
I w
L = wa
=) =
20,0 1 20.0f
1007 2 § 10 20 S 100 200 500 1090 2000 | 1007 2 § 10 20 50 100 200 500 1000 2000 |
L R Gl B il O el i L e ol B Tl A B i
0.0 i 7 1 3 0.g 1 ) 1 i
-In(-In(F)) -In(-In(F))
PHN N o
DBERHUSD 1 R DICERIR E N R ORFCHIER S P OBIREITVET,
= . .
=] B RO E RO TSSO R (FH) ARRSRET,

Clipboard copy Export csv file... Number of decimal places |3 "
| uc~ [ 6d |ut~ =

186.677 49.986 35.284

[Clipboard copy] : —E#£% 7 U v 7 H— RIch v~ KHY Tat—L, =7 &A%k LIclio T 3.
[Export csv file] : &£ % csv 7 7 A VBN THA L E T,
[Site name] - AT H AL R
[RI] C BHME ()
[Ucl DIRARE BT D iR s
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[6d]
[UT]
[UE]
[oCl
[oUT]
[oPT]
[cUE]
[a]

#
[\
Rl

AR (B, dEA B RFEHE Y O 4 )

BRI L DEE (REFHEOBELHNE LizHE1L oUT, oPT 25E)

DR & 2 (RHERMEDOEEEZ AL LT25E13 ok 25 E)
RBRIANC K 5 RO [5%]

D EEUC & 2 G O R HE R 2= (R O BLIE R & 2 28 DX

D EEUC & 2 G OREHER 2= GUE OBLIIERNC & 2 R 28) [kl

FERC & 2 JBUH OIE R A [X]
 EUH OAFYER 222 36 1 D kIR o AR K]

BRI ENEZ B8 L= 5E 0 A FoR

(5)  [View]-[Weibull...]
IR D 7= 8 DR JASEERE R 2 TR L ET,

=

ALL B &

Weibull - [MC_Casel - Site] = e |

1,000,000

100,000

10,000

1,000

1an

10

0.1

Weibul Site

Tropical
Estratropical
Conib ined

15 a0 El [41] kL
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2-5. FHIRANTA—ZOHHY—L
2-5-1. 2 MiRFEBEFRGIEEL T—42 OER
1. [Tooll-[Create wind-speed ratio...] * = = — %R L, MASCOT Basic DR GrET 07 7 A4 L) b,
LS & AT R & DR A RO — L A B L £ T

File Edit Run View | Tool | Window Help

0 & H| CENC [
;roject ‘
g Tutorial[Project]

@- [EtV]

@ [Monte-Carlo]

Typhoon database...
Design site & Speed up ratio 4

Create wind speed ratio...

Convert time series data...

AMeDAS data converter...

Divide the wind velocity according to the origin...

Composition of the tropical cyclone and the extratropical cyclone...

2. UUTOBEPERSNET BliE, T A =2 AT A T3, Y CITaEA NZEHTT),

MASCOT Basic folder IO:¥ Users¥ ¥Documents¥MASCOT Samples¥Engineering_for Offshore¥

—Reference Site

Label IEngineering_for_Offshore

Latitude 36" 437 00

Longitude 140" 507 3007

Extraction height 100

Edit...

- Prediction Site

Add from offshore case.. | Add.. Edit. |  Deete |  View. |

No. | Site name

| Latitude | Longitude |

1 Site

Extraction height |l].l] m

35" 407 41877 140° 49" 3591"

Description Icasee 1

Output folder IO:¥Users¥—¥Documents¥MASOOT_Sa mples¥Tutorial Offshore¥Library¥CompareMPD [g‘

Import settings... | Detail... I RUN Close I

[MASCOT Basic folder]

[Reference Site]

<Edit>

: MASCOT Basic D7/ r ¥ = N7 4 NVFEFRELET,
CRGREE A RET 2 5E OREERS (R LR DR DM - RE - mSRERS

F7. T 74N Tik, MASCOT Basic DFENTF.LEESRESNET,

CDUTF OB AFR S, FUEH S OFREEORE ATV ET,
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Site name IEngineering_for_Offshore

"

Latitude |35 ° |43 ’ |o.0

Longitude |14o ° |so ‘ |30.0 L

oK | Feutz)l I

[Prediction Site] ERGEIEEEET DA O TR (1) Lo ORRE - RE - B EEELET,

T 7 %V I Tix, MASCOT Basic ®[Edit]-[Option]-[Site] T&& L - SRR S E
< Add from Offshore case> : MASCOT Offshore T®& L7727 — AN b gfERZ A AR—FLET,

MASCOT Offshore project file

C:¥Jsers¥ i ¥Documents¥MASCOT _Samples¥Tutorial_Offshore¥Tutorial_Offshore.mof

Case list

[EtV] - Etv_Casel
[Monte-Carlo] - MC_Casel

<View > 2 2 HS R oo E A B EGE Ee s X OVRAR A 7T 7 2R Lk, FoaRDEE, 2 Hus R o a5
JEGHE s K OVE AR A 2 R (KRUN>Z4T) RICERLTLEEN, RREOEAITE
LLFEREINEREA,

__¥ind Speed Ratio

No. 1
Site Site
Latitude [35° 407 41.87"
Longitude [140° 497 35.97°
eizht 100.0

Rind 3paed Ratla
g, e

T T e
Rind Diraction [09z.)
_ Deflection Angle

Daflactian angla

2 -

T T e
Rind Diraction [0az.}

[No.] ;MR
[Site] : R
[Latitude] LR
[Longitude] : R
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[Height] : & (m)

[EtV] M T K 2 PR G oo B AR A

[Yaw] s AR £

[EtS] : B EGH O A IEAR S

[~ 7] : MASCOT Project 2351 AR — b L7z & ZI3EEmM & B GRIL) BERESNET,

[Extraction height] : FHIMLEOEH I ZHELE T,
[Output folder] : MEHILEERERERTFT D7 A NFLERELET, T 74/ b Tid, MASCOT Offshore D~
Y=z 7 VENO[Library]l-[CompareMPD] % 3R L %7,

4 |, Tutorial_Typhoon
4 |, Library

1, AMeDAS_TS

p| 1. CompareMPD

b Ly CompositionTandS

> J. ConvertTimeSeries
J. Typhoon_DB
>}, WS_Ratio
> )i Project

1

| FATALS-OMER(N) | | Frol

<Import settings> : W E R BIEELL « B ARAME 7 7 A VEER LEBRICRTESNERET 7 A V&
AR E T, HE T 7 A MiZE[Library¥CompareMP] 7 # /L Z NIZLLF D 7 7 A )b
LTHRIFENTHET,

Description CompareMPD.min

<Detail > D IEYEHRS KOV IR O AR A & BT 2 G h0BIRE LET, 774 R T
FtE s bEAFRAEEE (Fxv 7 HY) LET,
%Measure-Correlate-Predict (MCP) 14 T3k e 1500 i) i £ 73 & U & 73 T
7Y ETOTHEENLETT,

—Consideration of the deflection angle of the wind direction

v Reference site v Prediction site

Background turbulence intensity Ia IO. 1

—Peakfactor

Cbservation time T IGU 5
Evaluation time t |3 s

oK, I 7 |

<RUN> : 2 H R o JE A BIEGE L - BARA 7 7 A AV OER A FITLE T,
< Cancel > D EEMEAEEE U CRIEmICRE Y 9,
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2-5-2.  AMeDAS T—A ML IEEM M DRI T—5 T1ER
1. [Tooll-[AMeDAS data convert] 2 = = —ZFR L, 7 A ¥ ARFRINT —F WV ALY — NV ERE L ET,

File Edit Run View | Tool | Window Help

DEHA | 23 | & .:é Typhoon database...
Project Design site & Speed up ratio 4
S8 T:utoriaI[Project] Create wind speed ratio...
" [EtV] Convert time series data...
B [I_Vlonte-CarIo] !
E-MC Casel  |SNSMERES e

Divide the wind velocity according to the origin...

Composition of the tropical cyclone and the extratropical cyclone...

2. [Select Model 23 ) Fmr S5 DT, <From CD-ROM > #3&#R L £,

From CD-ROM... |

From Faolder. .. |

3. PCOCD RIATIZT AXAT—4 CD MHEARLEFTEE ¥ —) 2> L, <Laod>%7 Y v 7%
&, UTOHENPERSINET,

Drive |Browse..
— Browse
Data folder IZ:¥

Index folder (idx¥) IZ:¥2003_2

Load

~A&MeDAS data information
Date Delete... | Select sites New... | Edit... I Delete.. |

Year | Month | Folder | Files | No. | Site Name [SitelD | A

2003_2¥AM100307% 1318 11001
2003_2¥AM100308¥% 1319 1011
2003_2¥AM100309¥ 1323 11016
2003_2¥AM100310¥ 1479 11046
2003 2¥AM100311¥ 1520 11076
2003_2¥AM100312¥% 1482 m2
11151
11176
11206
11276
11291
11316
12011
12041
12141
12151
12181
12216
12231
12261
giH 12266
FAERIE 19901

€D 0D =l D N B OO RO —

Output folder C¥Users¥  ¥Documents¥MASCOT Samples¥Tutorial Offshore¥Library¥AMeDAS_TS¥

Convert
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4. BViAHZEITS TH) & TERHE) 221, <Convert>%7 U v LET,
Project-folder¥Library¥AMeDAS_TS¥AMeDAS_ID¥(ZT— ¥ % 7 4 —~ v MM L TRFL T,
x TH) & TEUAM S 350N AT hE

5. Y—LZE#HLEEEROCDEZE Y FL, <Laod>%7V v 27 LEd, (1] FRITT 7 41 b TERGIFHERR
el Zp 0 TEIHE ) IXRTEOZBIRERIIEEINTNEDOT, <Convert>%7 1 v 7 LET, KIEEAHY
KL, HERMBOT — % 2 AR E T,

% (M) RSEHIER X0 [T AZ A 10 5ET—4 (csv R | OffbE, 2009 4F3ETTHK T L
TEYETOT, 2010 FELUBEOKLET — XL, LTFTOFIMETERL TS EE0,
BT —HIE, KRBT HP BEORET —H « X yrno—F] O AFERARETT,

http://www.data.jma.go.jp/gmd/risk/obsdl/index.php

WDFNEIZT, Convert time series data] Y — /L CLEEFRE/R GRS T — & 2B L E 9,
1. 1#45075—% AA1HPH12A381HET) 2177 40E LT, BREREHSF 70— RLTLEEND,

H ez = R data.csv -

Tl H—h @BA A-Tlrot S T4 BE E-

H18 - £ |8

A | B | ¢ | D | E F | G H
1 | &7 a— FL7Eg ¢ 2020/01/23 15:37:51
-
3| T #®T #T T HF
4= )= =] 53 BE(m/s) BiE(m/s) Bi&(m/s) BE(m/s) BiE(m/s)
5 | J=lE =k
6| SEES ZEES oSS
7| 2019 1 1 1 42 8 8 1
8| 2019 1 1 2 24 3 EEA 8 1
9| 2019 1 1 3 5.8 s EHE 8 1

2. FHHBREOHRADINT “57 ZBMLTIEEN,

3. Xvrnwu—FRL7%CSV T —#i&, BAAREEILOET TR s TWET O T, Excel % T 360 4 16 &L
TEHEIC A LT EE vy, (46=0.0 : 0.0~337.5)

4. THDOATRETEIA L MITTOT, B3 A MIa®RT 4 2L TIEEN,

H ©- Q A R A Choshi_2019.csv - Excel

I AL BA AT ok K 74 B8  ®R AT DocuWorks Q fmELETH

N31 8 f

™A B c o | e | F | & H | v | K
1 T T T T T
2] # E A B % B&E(m/s) Bi&E(m/s) Bi&E(m/s) BiE(m/s) BiE(m/s
3| # Bm Bm | E8E!
4 SEER SEER HEES
5 2019 1 1 1 0 4.2 8 A 8 1 270
6 q 2019 1 1 2 0 4.4 SEER 8 : 247.5
7 i 2019 1 1 3 0 5.8 8 EitE 8 1 292.5

2-37



2-5-3. TFAFARRINT—2ORAEERMFA~DER

1. [Tooll-[Convert time series data...] A== —%BIR L, EH « WAFFRYT —F L#Y — L& L8 L E9,

File Edit Run View | Tool | Window Help

Q [E ﬂ | 23 | = u Typhoon database...
Project Design site & Speed up ratio 4
& Tutorial[Project] Create wind speed ratio...
" (B \ Convert time series data...
B- [Monte-CarIo] =
- MC_Casel AMeDAS data converter..,

Divide the wind velocity according to the origin...

Composition of the tropical cyclone and the extratropical cyclone...

2. UToOBmEAZERSNET Blid, /T A =2 ADF A T3, Y CITaEE AZEA T, ),
FLYEM R O AR« JRGRER N T — & & R B EGE L - JR AR A T PRI~ R L E T,

Ratio file I¥MASCOT_SampIes¥Tutorial_0FFshore¥Library¥CompareMPD¥CaseO1¥extract_$ite_result.csv | _g_J View file... |

—Time series file

C:¥Users¥  ¥Documents¥MASCOT_Samples¥Tutorial_Offshore¥Library¥AMeDAS_TS¥45147_1994.csv

C:¥Users¥  ¥Documents¥MASCOT_Samples¥Tutorial_Offshore¥Library¥AMeDAS_TS¥45147_1995.csv

Add... |
C:¥Users¥ . ¥Documents¥MASCOT_Samples¥Tutorial_Offshore¥Library¥AMeDAS_TS¥45 147:1996.csv
Delete | C:¥Users¥  ¥Documents¥MASCOT_Samples¥Tutorial_Offshore¥Library¥AMeDAS_TS¥45147_1997.csv

C:¥Users¥  ¥Documents¥MASCOT_Samples¥Tutorial_Offshore¥Library¥AMeDAS_TS¥45147_1998.csv

C:¥Users¥  ¥Documents¥MASCOT_Samples¥Tutorial_Offshore¥Library¥AMeDAS_TS¥45 147:1999.csv

C:¥Users¥  ¥Documents¥MASCOT_Samples¥Tutorial_Offshore¥Library¥AMeDAS_TS¥45147_2000.csv

C:¥Users¥ . ¥Documents¥MASCOT_Samples¥Tutorial_Offshore¥Library¥AMeDAS_TS¥45147_2001.csv

C:¥Users¥  ¥Documents¥MASCOT_Samples¥Tutorial_Offshore¥Library¥AMeDAS_TS¥45147_2002.csv
¥NAm T

"] ¥ W lac¥Titarizl Nffcharail ihrarMAMaNAC TEXAG147 NN ~ow
view file... |

Row
Last readi Extract row of column names ———
First reading |4 { ng r

& Endoffile € Specified |~1 Row of column names |3

—Wind speed

Column of time series file I-l Column of ratio file l4 Lower limit 0.0 Upper limit I 100.0
—Wind direction

Column of time series file |'1 Column of ratio file |5 Lower limit IO-U Upper limit |360.0

Inflow wind direction column of ratio file IZ [ Interpolation of the wind direction
—Output file
Descriptior  [Case01

Output folder IC:¥Users¥-p ¥Documents¥MASCOT_Samples¥Tutorial_Offshore¥Library¥ConvertTimeSeries¥

Header |Case0 s Footer _conv

Import settings...
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[Ratio file] : [Tooll-[Create wind speed ratio]l TEk L 7= &M BIESE L « BARA 7 7 A VERELET,
Extr, ite result.

T J « Library » CompareMPD » Case01 v ¢ Case01DIEE

zE - FLLWTAILS -

). Tutorial_Offshore A~ £z =F
1. Library
., AMeDAS_TS
.. CompareMPD
J, Case01
., case2
b test
4 testl v < >

|87 extract_Site_result.csv Microsoft Excel ...

J7AILE(N): |extract_Site_result.csv v‘ [Wind speed ratio files (*.csv v‘
| o || e |

[Time series file] D EHOTORN - FERRERS T — Z O ek, BlbRE L ORERE AT —F DY XA b ERTLE
T
KEERHN T —H T _RCRL 74—~y hTHAMLERH Y £7,
<Add> D BHSTON - JBGERE RS T — X DX kAR ) A MIBERLET,

<Delete> BT - JEGEEERSIT — 2 & ) 2 R B HIBRL 9,

T 1. « Library » AMeDAS_TS AMeDAS_TSDEZE P

=E - FLWTAILS - =~ [ @

. AMeDAS_TS A ZE &3 B4z A
| CompareMPD |@ 45147_1994.csv Microsoft Excel ... 2,71
, CompositionTand @ 45147_1995.csv Microsoft Excel ... 2,64
© ConvertTimeSeri E37) 45147_1996.csv Microsoft Excel ... 2,64
| PowerCurve £37] 45147_1997.csv Microsoft Excel ... 2,64
. Typhoon_DB 7] 45147_1998.csv Microsoft Excel ... 2,63
. WS_Ratio 03 45147_1999.csv Microsoft Excel ... 2,64y
| WSDB v < >

!
it
ki
!
it
k
L
ks

TPANA(N): |45147_1994.csv v| | Timeseries file(*.csv) vl
[ ®o || 3o |

<View file> : Z#scoin « FUHKRIIT —F 2R R LET, 2T, BIIOWEELITTVET,
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File IC ¥Users¥ Ul ¥Documents¥MASCOT_Samples¥Tutorial_Typhoon¥Library¥AMeDA! I 45147 _2005.csv

Coll Col2 Col3 Col4 Cols WindDirection | WindSpeed Cold ~

d8B8E58848888%

LR EE oo ;s |

£
(The display maximum is 10000 lines.)

~Row Column

First reading |4 3 ~Wind speed
~Last reading Column I? l Lower limit I0.0 Upper limit Ij_oo.o

* Endoffile  ( Spedfied |52563 3:
—Wind direction

¥ Extractrow of column names Column I‘i l Lower limit IU-U Upper limit |360-0
|3—|_—‘

OK | Cancel |

[Row] D ST O - B RS T — Z B D B IA TR EOREZATVET,
[First reading] D EAME - BURIEOHEAAL BT A HEE LET
[Last reading] s R+ JRGRAE D FEARATE TATHARE L E T
[End of file] L RERINT — Z DRAATE THIFIABHET,
[Specified] D RERFNT — 2 OFRE LTATHE E TRt iAB £ 7,
[Extract row of column names] : itk 7 7 A LD~y X —ITHWDITE S ZHELET,
[Column] DEGEE, JRFEORIR SN TWDEH T LB STERELET,
TAEAT =2 B UTEGEIET 7 40 MEEZRE L TLIEIW,
[Wind speed]
[Column] D EOEEOFEE STV I T AEFFERELET, (T 74V ME:T)
[Lower] s EHAE O AN O T IRME 2 E L £,
[Upper] ;R O A ZhEPH O _FIRIE 245 E L £,
[Wind direction]

[Column]  : EAMEOLRINTNEH T LESZEF/ELET, (F 740 M : 6)
EDHZhEPHO FHMEAHE L E 7
[Upper] ;A E DA ZhEIFE O HIRE A4S E L ET,
[Interpolation of the wind direction] : EmBIEH L, JEIAFA % E 208 T—EMHE 2 AV 2 B 2 — R E NG L
Al E VB ERELET,

ﬁ
=

[Lower]

=]

o— - —eo EVIETHHMEL-EEL |
‘A“ \\\
: R

o— .- — AR L TEHfi L= A&

5 ik B

v

EHITAR
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#
[\
Rl

[Output file] AT T ANDRIET AN ERT 7 A NVADEREETVET,
[Description] CHRE LI SCRA D 7 4 L 2 P TF O [Output folder] NICTERE S 41, TERR & 2072 Al Bl EGE
o - JRIAHRAIE T 7 A A DBRAFSILET
[Output folder] CHRE L7 AV HNIC, ERRd[Description] THRIE L 7= 3CFHID 7 4 VX BMERR S, 1E
il S i Jm B EGEREE - AR A 7 7 A VB RIFSVET,
[Header] CHRE LT SCFHNDNERITDO 7 7 A N OIS E T,
[Footer] CHRE LTSRN ITD 7 7 A VA DKRBIAIME I ET,

<Import settings> : R [A IR « B AHRAME 7 7 A VAR LTCBRICRIFE SR E T 7 A V&
FtRABE T, BRET 7 A /ViX[Library¥ConvertTimeSeries] 7 4 /L Z WIZLL R D 7
FANGTRIFSITOVET,

Description_ConvertTimeSeries.min
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2-5-4. FRXEEOHE

1. [Tooll-[Divide the wind velocity according to the origin...] A== —%EER L,
l./ijﬂo

IR JBIE O > — L % A8

File Edit Run View Window Help

Dmde the wind veloclty accordmg to the origin...

R | 23 ’ & Typhoon database...
Project \ Design site & Speed up ratio 4
B T:UtoriaI[ProjeCt] Create wind speed ratio...
" [EtV] Convert time series data...
B- [Monte-Carlo]
@-MC_Casel AMeDAS data converter
|
|

Composition of the tropical cyclone and the extratropical cyclone...

2. VUTOBEAPERSNET BlE, /T A—=Z ADJF A T3, Y CITeEA NZEH T,
JE\ ) - JRGR DRI T — & 25 I & FRERC B THE BRI BT 2 o R 2 i U ZREEIC X 5 A B

FHEZRH L E T,

Description lCaseO 1

MASCOT Typhoon or Offshore case
|Etv] - Etv_Case1

Site  |site

ol : : i i v¥...
Casel1, 45147 1996 _CONV.CSV C:¥Users¥ ¥Dommenis¥MASCOT Samples¥TuhonaI Offshore¥lerary¥...

Case01_45147_1997_conv.csv
Case01_45147_1998_conv.csv
Case01_45147_1999_conv.csv
Case01_45147_2000_conv.csv
Case01_45147_2001_conv.csv
Case01_45147_2002_conv.csv
Case01_45147_2003_conv.csv
Case01_45147_2004_conv.csv
Case01_45147_2005_conv.csv
Case01 45147 2006 conv.csv

C:¥Users¥ «¥Documents¥MASCOT_Samples¥Tutorial_Offshore¥Library¥...
C:¥Users¥  ¥Documents¥MASCOT_Samples¥Tutorial_Offshore¥Library¥...
C:¥Users¥ -« ¥Documents¥MASCOT_Samples¥Tutorial_Offshore¥Library¥...
C:¥Users¥ - ¥Documents¥MASCOT_Samples¥Tutorial_Offshore¥Library¥...
C:¥Users¥  ¥Documents¥MASCOT_Samples¥Tutorial_Offshore¥Library¥...
C:¥Users¥ « ¥Documents¥MASCOT_Samples¥Tutorial_Offshore¥Library¥...
C:¥Users¥ « 1 ¥Documents¥MASCOT_Samples¥Tutorial_Offshore¥Library¥...
C:¥Users¥ « ¥Documents¥MASCOT_Samples¥Tutorial_Offshore¥Library¥...
C:¥Users¥ « ¥Documents¥MASCOT_Samples¥Tutorial_Offshore¥Library¥...
C:¥Users¥uu¥Documents¥MASCOT Samples¥Tutorial Offshore¥Library¥...

Column
Recurrence period ISO ‘7 Wind speed |7 Wind direction IG

Output folder
IC:¥Users¥..l¥Domments¥MASCOT _Samples¥Tutorial_Offshore¥Library¥CompositionTandS¥

Import settings...

CHRE LT SUFSN D 7 4 L Z LT O [Output folder] MIZER S 4u, MENHERAMRE SN E T
[MASCOT Typhoon or Offshore case] : MASCOT Offshore /7 —A 7 7 A /L(CaseData.min) % $§7& L £ 7,
lr—A7 74 v iE MASCOT Offshore D71 Y= 7 b7 L HANICRIES LTV E T,
[MASCOT Offshore 7’ ¥ =7 k7 % /L X ¥ Project¥EtV¥CASENAME¥
o RRIRD AR i KRG 2 il H 9 2 Jalin) « JRUS IR R BT — & DGk, HIBRES K OVRERE AT — &
DY ANEFRRLET,
CALEE R oA - BURRESRYI T — Z OFE A FR LET,

[Description]

[Time series datal

<View file...>
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File ]Case01_45147_1999_conv.csv IC:¥Users¥'!ﬁ)ommenismASCOT_Samples!ﬂ'utnriaI__Oﬂ'shore¥Library¥ConvertTmeSeries¥Cas&
Year [ Month [ Day | Hour [ Minute | WindDirection [ WindSpeed [ cols A
1 # RAPFES AR PR, SRR, #BREC.. BECLE.. 2EGED..
2 #45147 HF F99 F 35 4.2 140
3 =5 A =] 5 7 o] 5
4 1999 01 01 00 10
) 1999 01 01 00 20
6 1993 01 01 00 30
7 1999 01 o1 00 40
8 1999 01 01 00 50
9 1993 01 01 01 00
10 1999 01 01 01 10
11 1999 01 01 01 20
12 1993 01 01 01 30
13 1999 01 01 01 40
14 1999 01 01 01 50
1 1000 nt nt n7 nn Y.
< >
(The display maximum is 1000 lines.)
Column of wind speed 7 I Column of wind direction 6 I
[ (==
.- |
<Add> B R O R - EURESR YT — 2 OB EREITVET,

1 1. « ConvertTimeSeries » Case01 v ¢ Case01DiE=E

EE - FUNTANE—

. Tutorial_Offshore A ZE B3
Ju Library
.. AMeDAS_TS
.. CompareMPD
1, CompositionTand
.. ConvertTimeSeri
) Case01
4. case02

]@ Case01_45147_1995_conv.csv Microsoft Excel ...
@ Case01_45147_1996_conv.csv Microsoft Excel ...
@ Case01_45147_1997_conv.csv Microsoft Excel ...
@ Case01_45147_1998_conv.csv Microsoft Excel ...
@ Case01_45147_1999_conv.csv Microsoft Excel ...
@ Case01_45147_2000_conv.csv Microsoft Excel ...

@ Case01_45147_2001_conv.csv Microsoft Excel ...
v <

TPAA(N): | Cased1_45147_1995_conv.csv v| | Timeseries file(*.csv) vl

[ o || #oer |

<Delete> BB O A - JRIRESR SN T — 2 OHIFRZITVE T,

[Recurrence period] BT FRENSEOFRYM AR ELE T,
[Column] D EGEE, REEOTERENTVWA LT LF S EIFELET,

[Convert AMeDAS] THLEE L 727 A &4 ARERHNT — & 2 AUPET 5 3545 IXFX EFE AL
T A K AMERG|F — & & [Convert Time series] TZEHA L 7= H2 55 — & 2 AL+ 2 B34 13
BREMEBAZRTEL T LIV,
[Wind speed] D HUEE OB ENTHDE N T LFFZEBELET,
(RREMEA:T, BREEB:11)
[Wind direction] RAEORRENTWA LT LB FERELET,
(RREEA:6, BREfEB:13)

[Output folder] HRE L7 A VA NIC, EiLo[Description] THRIE L 72 3UFH O 7 4 /L F BMERR X v, fif

WrE R B RFESNET,
<Inport settings > : MEIZAUHEZ LIZBRICRGFE SNTERE T 7 A VEBHRAHLET, FET 74 M
[Library¥ CompositionTandS] 7 4 /L ZWNIZLLTF D7 7 A W4 TIRIF SN TV E T,

Description_DivideWindVelocity.min

<View> CFEATRE R & U TR X AR KR O B MR R A R L E T,
<RUN> D ERT A SEE LE,
< Close> CREEPIEL, mmEACET,
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2-5-5.

BRLFHRICKSESRIRIZBTHIERRAENERHFHEEZHE

[Tool]l- [Composition of the tropical wind and the seasonal wind...] X = = —ZER L, B L FEHEIC L HEES
RAEICBIT 2 FEREOFEMFHEOREY — L2 EE L E T,

2.

File Edit Run View Window  Help

Divide the wind velocity according to the origin...

‘E DE - | da | & [ Typhoon database...
Pro;ect Design site & Speed up ratio 4
E'”T:Utorial[ProjeCt] Create wind speed ratio...
" [EtV] Convert time series data...
B- [Monte-Carlo]
- MC_Casel AMeDAS data converter...
\

Composition of the tropical cyclone and the extratropical cyclone...

DFOBE SRR SVET BT, /87 A — 2 ADFHBE T, PINBECIEAREHSZETT),
B L BRI L 5B AR BT 5 RRRED BB 2 ik L £ T,

Description ICaseO 1

MASCOT Typhoon or Offshore case
[ Etv] -Etv_caset ]

Site list Edit... Delete...

Site name | Tropical cyclone file | Annual maximum wind speed file
Site Site_result_ymxV_S.txt .¥Case0 1¥ymax.dat

< >

Recurrence period |5o FV Consideration of the uncertain— | Detail l

[~ op

Output folder IC:¥Users¥-¥Dommeni:¥MASCOT _Samples¥Tutorial_Offshore¥Library¥CompositionTandS¥

Import settings... View MCS... | View MCP... Run

[Description]  : f8& L723CF5D 7 4 L Z 3L F O[Output folder] NIZIER S, MEFTRERSRTEINE T,
[MASCOT Offshore Case file(CaseData.min)] :MASCOT Offshore ® /% — % 7 7 A /L (CaseData.min) Z48& L £,

br— A7 7 A i MASCOT Offshore D727 N7 A VA NITHEIEENTWET,
[MASCOT Offshore 7' 7= 7 | 7 4 /L X ¥ Project¥EtV¥CASENAME¥
ELATIC MASCOT Offshore T (BRI L2 ERERNAEOEERYHE 2B E L TBSERHD £7,
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<Load> 3R L 72 MASCOT Offshore 7 —2 7 7 A /L(CaseData.min) %A MEH L HM T =
L=y a VbR L BRI K SRR KRIBEE T 7 A Va2 G AR £ T,
[Site list] o IR PR R R R & filt 92 il a) « JBUSIRER ST — & DO Xkgk, HIBRE KOk 7 — &
DIYAMERRLET,
<Edit> : <Load> TREAIAATIZY A MEIZFHRIC L 2 FRKIEME” 7 A V2T LET,

Site name lSite

Tropical cycone file Site_result_ymxV_S.txt

e M ts¥MASCOT_Samples¥Tutorial_Offshore¥Library¥C itionTandS¥Case01¥ dat|2
ey lmen _Samples¥Tutorial_ ore¥Library¥CompositionTan ase 1¥ymax.dat| €.

ok | Het |

< Delete > YA FEHIBRLET,
<View> A, FEIR, RAEREIC X D FERKEEOIEBEMER M ER T LET,

[Recurrence period] BT 2 FEMAHEOFHMMZHRELE T,
[Consideration of the uncertainty] : #BfiE R O RFEFEMEIZ 1T 5 RO BT O BL ZET 50N EHEELE
R
[opl s B RGO AR EMEIC 1T D KUEDOBUFER O BB DG e fiE LT, A
BRITEL TR Y alb—va K DRERICOBR SN ET,
[Output folder] CHEE L7 W HENIZ, ERED([Description] THRE L 72 SUFFID 7 4 V2 BERR S 4,
PR R FSNET,

<Import settings> : WEITLIE LZBRICIRESNTZRE Y 7 A NV EBHPABLE T, RET 74 V1T
[Library¥CompositionTandS] 7 + /L X NIZLL F D 7 7 A VA4 TRIFSILTWET,
Description_CompositionCyclone.min

<Detail > R G L 1) B0 7 Ry D PR ER A 4 SRk ] U o IO RGP 2 4R L 9

{Design target direction of the wind

Moving average range Um | 1.0 m/s
OK I

[Design target direction of the wind] — : FAARIAJR M & 9~ 2 FELIFFE O R
[wind speed range] : EE##iPH (5 7 4 /L ME Um=1.0m/s = Ur£0.5m/s)

N
1
0=
1
N : Ug + 0.5m/sDF — % {f¥%
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<View MCS> : E 7 vr ¥ alb— 3 LD BROFRKEEE VT2 RAREIC L 5 FR KR
OB R ST 2 For LET,
AT HUS NS V. MATHLEAS 1 BIE UL E 6 72 WA — 1T b Rl L
ET, AU €2 220 v s FAEICEVITAE T, MIEE CIIEE, AR,
RESKWEED 3 MOERKEEOHEBBHENMRE 1 MEICERES LET,
Mu “| T B R R RO RIR AR 5 - L A TE (PR AR,
(KRUN>FEAT) BIZERLTLLEED,

[ALL -

Tropical Cyclone
Extratropical Cyclone
Combined Cyclone

B mrr sy v s aEc k0 BEEE CHEE L BRI 2 EES O RS0 G
ErFERLET, HEREEEUFOM®Y T,

[site namel] : FRAT HL R4 B

[Ucl IRARIEI BT D iR )RE

[6d] D IRATR G (B, LA HREEREI D o)

[UT] BRI XD EE (RiEEEOBEE G LIESHEIXo0 UT, o PT 2EJE)
[UE] D FEIEUC & 2 Bl (RHEEMEDOEE LA L L2583 0 E 25 E)

[oC] IRERRIC X 5 B O ER = %]

[oUT] D BJEUT X 2 R DA% R 2= (RO O BIRIEENT X 5 ) %]

[oPT] D BEUC X 2 B DR HER 2= GRUE OBLRIEENC X 5 52 8) k2]

[cUE] D FEHIEUC & 2 RGE O ER A []

[al U O ER 22238 D R O EARE %]

BRI N2 B8 L= 58 0 A 3R

Clipboard copy Export csv file... l

| uc | 8d | ut | uE | oC | out
.75 187.08 .75 35.27 175 0.26
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<View MCP> : MCP i (HiBHEE) |2 X % B RO R RIS 2 O 72 B A BRI X 5 4 Bl O Fs i
RN E TR LET,
FEATHLS AR O | AT MY 1 BT E B 72V A IR — DT 0 i L
ET, AU € 220 v s FAEICEVITAE T, MIEE CIXEE, AR,
BAEKMBED 38 MOERKEHOIMBHRSMRE 1 DO/ T 7 CEAHEE LET,
Mu “| T B R RO RIR 2RI 5 - L 8 TE (PR AR,
(KRUN>FEAT) BIZERLTLLEED,

[ALL -|

Tropical Cyclone
Extratropical Cyclone
Combined Cyclone

1|

B Ry ar ) v daEIc L0 BEmE T E L EIIREIC S 2 SR O a0
FrEFRLET, BRAEBIILLITO®Y T,

[site name] - AT HL S A R

[Ucl RAREICB T D R

[6d] : FRATSE B JE )

(UT] CEEUC XD EE (RHEEMEOEEEZ AL LI2Ha1T o UT, o PT 25E)
[UE] D RIS XD (REEMEDEE AR/ E L2 GI1Xo E 25 E)

[oC] DIRARURIC X D B O HER = [3%]

[oUT] D BT & D G O AR HE(R 2 (RUH O BUHIAEEUT K 5528 X

[oPT] D BT & D G O AR HE(R 22 GUE OB BT K 55280 %2l

[cUE] D EEEIC X 2 BUE O R K]

[al : JEGE DI IR 22 H51T D BRI O AR EL K]

BRI ENEZ B8 L= 58 0 A 3R
[3%2]MCP 4 TIZKEOBIHIFELIC L 2 BIBE SRV 0HIZ 0.0 L7220 7,

Clipboard copy Export csv file... |

[uc [ed [ur [ue [oc
5161 206.20 5161 35.27 2.37

<RUN> D ERT A SEE LE,
< Close> CREEPEL, mmEHCET,
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#3& User Interface (A—H— -/ 24 —2T1x—X)

AFETIE, MASCOT Offshore D—H—« 4 =T = —AZONTHPI LET,

B2 L N B ettt ettt
33, A T T o B (R ) oot a e
B8 L. L1 R o ch m ettt ettt e e e

3-1
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3-1.

A=ma— —8

MASCOT Offshore ® A A > A =2 —|ZLL FD T o bR SN E T,

b

Stop

Start EtV
Start Mante-Carlo

B

Create New Project...

Ctri=N

MY =y FOAER, FHIAT RIF, TV OB ORE, THT T LOKTE
AT — ADRRGE, M. A, HIBRT 2%

D RN — A DR R IAT, FHEPIE

DR, BENT A= ORI, FHRAEREOFR

RN G LR DB G, T — X R RADRE Y —VF

CUA Y RY TA arEoRR, Bk

A=V a U, 2P =2 T OFRIR

Users Manual...
MASCOT Website...

@1 Cascade
Tile Horizontal

@ About MASCOT Offshore...

Arrange Icons
@ Windows...

Typhoon database...
Design site & Speed up ratio 2

Create...
Edit...

Create wind speed ratio...

Convert time series data...

AMeDAS data converter...
Divide the wind velocity according to the origin...

Composition of the tropical wind and the seasonal wind...

[ZZ Open Project... Ctrl=0
u Save Project
Close Project
&3 Print... Ctri=P
Preview... ect was opened.
Print Setup...
Exit M ‘Log
Keaay CAP NUM SCRL .:
EtV <+ Create New Case... Condition for the estimation of tropical cyclone parameters...
Hontercarie iy / Limiting value of the tropical cyclone parameters...
i Reference roughness...
T B Case Option 4 g
Correction of Averaging time...
Delete Case
Create New Case... Consideration of the uncertainty...
=3 Copy Cirl+C Edit Case... Design target direction of the wind
Export | Ctrl=|
[ICELEEE e Tropical cyclone parameters...
Export CSV... Condition for the estimation of tropical cyclone parameters...

Extratropical cyclone parameters...

Limiting value of the tropical cyclone parameters...
Case Option > g e P

Reference roughness...
Correction of Averaging time...
Consideration of the uncertainty...

Design target direction of the wind...

Weibull parameters...




A= ()
[Etv 3R]

-

l File Edit Run View Tool Window Help

JMA Best track data...
Prediction sites...

Estimated probability distribution of tropical cyclone parameters...

of the annual

probability distril

wind speed of tropical cyclone...

Monte-Carlo Estimated probability distribution of the annual maximum wind speed...
List List of estimated probability distribution of the annual maximum wind speed...

Weibull...
Toolbars and Docking Windows

Status Bar

Output

The project was opened.

W« » M Nlog/

CAP NUM SCRL :

[Monte-Carlo 4R F]
-l

I File Edit Run View Tool Window Help

JMA Best track data...

Prediction sites...

Estimated probability distribution of tropical cyclone parameters...

of the annual i wind speed of tropical cyclone...

EtV
Monte-Carlo of the annual maximum wind speed...
List List of of the annual maximum wind speed...

Weibull...
Toolbars and Docking Windows

Status Bar

Output

The project was opened.

W« » ¥ Slog/

Ready CAP NUM SCRL




3-2. Y—IIN—§
NDEH 2| &
... Ty bR LET
([File]-[Create New Project...] A = = —)
= ... .. IuaVxl NEFAIAHFLET,
([File]-[Open Project...] A == —)
= fE¥ET DT 27 N EREFELET,
([Filel-[Save Project...] # = = —)
=L BIRSNTVB Ea—0WE ([Ma/RE) 220 v f—R~at—LET,
([Edit]-[Copy...] A == —)
o=y
oL, BIRINTWAE2—DRNE (Keu 77 y) 2L £,
([File]- [Print... ] XA == —)
|_gj:l

MASCOT Offshore ®/3—3 g EREZFRLET,

([Help]-[About MASCOT Offshore...] # = = —)
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3-3. #47nTJ-Ea—% (Az=a—3F

3-3-1. [File]A=a—
DA =a—FTnY =y FOERK, FEHRIABARE TV X ORE, T 0T T LD THEET) A =2 =TT,

[File | Edit Run View Tool Window Help

|1 Create New Project... Ctrl=N
p 5 Open Project... Ctrl<0
¢l save Project Ctrl=S
Close Project
d¥  Print.., Ctri+P
Preview...
Print Setup...
Exit

1. [Create New Project...]

MASCOT Offshore 712 5= 7 | & BTAER L £ (v—nrsie ),

Folder list Project name
- A I

[V Create folder of the project name

Description

[

"

l
|

&
5 ),
"
b
"
L
&
- Jy . —
&
&
"
&
@
&

¥

B
-

"
'

< >
Project file
C:¥Users¥ i ¥Documents¥Untitied¥Untitied. mof

Createl Cancel




2. [Open Project...]

Sy FEFEBARET (Y D)

© v 1 J « MASCOT_Samples » Tutorial_Offshore » Tutorial_Offshoreie= »

2 v FLNTAILS— = v [ @

4 | Tutorial_Offshore |~ zm &5 #4Z
b Ju Library
>} Project

. Library TP TS -
i Project TP AN THE—
ki Tutorial_Offshore.mof MASCOT Offsho...

>

TPANEN): | v| [ MascoT offshore Projects ( v

[ mo@ || 3o |

3. [Save Project...]

TuYxl MERFELET (Y —3— =l )

4. [Close Project...]
Juvz FEET L, FIEmEIEY £9,

- File Edit Run View Tool

DEH wae

Proje

Window Help File View Help

D@ - a8 e
Project 2
-. None[Project]

=f Tutorial[ Project]

= [EtV]
. @ EtV_Casel
- [Monte-Carlo]
@ MC_Casel




5. [Print Setup...]
ROV A X, HIROMmE 2 EOREEITVET,

g —

5-200: I -] 70/().. |
REE: EB/TT

b:=H

B8P

JAUP:

~ B EIRIDEIE
$4Z(Z):  |A4 (210x297mm) ‘ & $#(0)

A
BEHE(S): B . C HB(A)

FyPI-H(W)... '

6. [Exit]
MASCOT Offshore ##& T L%,

@ Save changes to [Tutorial]?

[FA(Y) I WAZ(N) Frool
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3-3-2. [Edit]l*=a—
RS ORIE,

BTG R NT A — & S O X6k & b it %
Case...] A =2 — 32— —RNUPRETDBMNEDOH LA =2 —T, BRAT —FX—27 7 A VOIRE, fHTI5
WS OFEE L IRED NS OFEEEFTVET, —J5, [Case Option... ] A == —LIFD

WRESNTEY, LEIG U CREMOEEZITNET,

File Edlt| Run View Tool Window Help
Qg B »
iect Monte-Carlo »
Project.
B Ut Copy Case...
E] Delete Case
B 23 copy Ctri=C
Export Image... Ctrl=|
Export CSV...
1. [Etv]

T fie R IR O FF BUIAHIE F & OV P 2 25 B8 L 72 PR JRGE O LS & 2 FIHpR 4 %

—AREEZLET,

'Edit | Run  View Tool Window Help

!

EtV

»

Create New Case...

Monte-Carlo

Copy Case...

Delete Case

Copy
Export Image...
Export CSV...

Ctrl=C
Ctri=|

»

Edit Case...
Case Option

3-8
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(1) [Create New Case... ]
FHEr— 2B HRER L ET,

Case name Icase 1

Description Icase 1

~Basic settings

i~ Generation of virtual tropical cydones

Latitude  [35 d [+ m [6.26

Typhoon database information file

Longitude |14o d |51 m |3s.98

IC:¥User. . ¥tutorial_1961-2007.mtdb Reference... I

Consider the correlation between parameters

Modify the parameters
to fit the original probability distribution

Simulation length 10000 years

i~ Prediction of wind speed

Vertical wind profile model

r~Evaluation of tropical cydone parameters
— Analytical functions

Central pressure difference
Radius of maximum winds

Translation velocity

Minimum approach distance

Annual occurrence rate

Approach direction normal v I
quadratic v I
Poisson v I

Consider the effect of local topography
Correction of averaging time

Consider the uncertainty

[eor = Site list file

IC:¥Users¥...¥h.|h0rial_sihelist.min

Correlations between parameters Yes

[~ Speed up ratio

8l Recurrence period

[Case name] CRHE — A ERE
[Description] CHENKETRT D

[Basic settings] @ fiE#T et D HARTE R A % E
[Latitude]l —: Bl N7 A — 2 OfH RO/, 47, B)¥bi+. MifE—. BAHIHSR
[Longitude] : f#eii/ N7 A — % Ot OREE(E, 43, BXARE A+, Wt —. AAHIHR
: [Tool]-[Typhoon database] TEXE L7z, HET —& X— A {FH

[Typhoon database information file]

< Reference >
[Evaluation of tropical cyclone parameters]
[Analytical functions]
[Central pressure difference AP]
- MPDF
[Radius of maximum winds R,,]
- MPDF
[Translation velocity CI
- MPDF
[Approach direction 6]
* normal
[Minimum approach distance dp;,]
+ quadratic
[Annual occurrence rate 1]
+ Poisson

[Correlations between parameters]

77 ANEIEE

CERT =2 R= 2GR T 7 A NV EER-RE
D BIENT A —Z DRI RIE DS & i)
s R A R E

CHPLDRER TR

CIRA MR BB
s LTI

s BRI BBk

s BRI R

s IRBEECK

R AR AR
CART Y oA Bk
CBENT A — 2 ORI DO FE &2 AT O EHUE

39



[Generation of virtual tropical cyclones]

[Simulation length]

e
w
Rl

AR B I LD S R E
ERRARE AT D FERERE (10 THERNE LTSIZEW)

[Consider the correlation between parameters]

C BT A — S B OARBEE B L IR AT O InE DR

[Modify the parameters to fit the original probability distribution]

[Prediction of wind speed]
[Vertical wind profile model]

+ Engineering model

D EBEE LTSRS ) KO, BE L RT A —Z OfuME
EZAT 9 D D ER

D JEGE, RmEESRIIFLE SR AR E
SHET T L DOBFRIR
D LERE T L

[Consider the effect of local topography] : EATHIIC & 2 AR OHEE & AR A & BB T 520G 0ORTE

[Correction of averaging time]
[Consider the uncertainty]
[Site list file]

<Select>

[Speed up ratiol
[Recurrence period]
<Save>

< Cancel >

MIIEEBRIRE R 2HAEZR L TOET

s RO O SV DR IE 24T 9 28 2 DR E

CREEREBET OINENORTE

D MHERF LS T 7 A LV OFRE

: [Tooll-[Design site & Speed up ratiol TRRE L7z, JEHFRF S
77 A N RIS E

s R AE A B RE LT IS K 2 S EGROF] Y 8 UREGRE D&
%5 E

CEID I UREE RUET D UM AR E

D RREE A PR AT

CETHRA), EE LREEAMEE LEE A LS
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(2) [Edit Case... ]

BRL TV DFIE — 2 ZifRELET,

Case name IEtV_Casel

Description ICasel

r—Basic settings

Latitude |35 d |40

Longitude  [140 d [
Typhoon database information file

IC:¥User...¥mtorial_1961-2007.mtdb

—Generation of virtual tropical cyclones
Simulation length
Consider the correlation between parameters

Modify the parameters
to fit the original probability distribution

—Evaluation of tropical cyclone parameters

—Analytical functions
Central pressure difference
Radius of maximum winds
Translation velodity

Minimum approach distance

Ap
Rm
C

Approach direction 8
dmin
A

Annual occurrence rate

v
MPDF v

Correlations between parameters

Yes

~~Prediction of wind speed
Vertical wind profile model

Consider the effect of local topography Yes
Correction of averaging time

Consider the uncertainty

Site list file

C:¥Users¥.. ¥tutorial_sitelist.min

—Speed up ratio
Recurrence period

XIBBRNZAIL. Create New Case...] &R—

3-11



(3) [Case Option]
FEICBET AR A R EERELET,

File | Edit | Run View Tool Window Help

P [ e » Create New Case...
Monte-Carlo » Edit Case...

| Case Option

g Tut Copy.Case.; Condition for the estimation of tropical cyclone parameters...

E| | Delete Case Limiting value of the tropical cyclone parameters...
il Reference roughness...
= I =3 | Copy AL Correction of Averaging time...

EApoIk ae i Consideration of the uncertainty...

Export CSV...

Design target direction of the wind

[Condition for the estimation of tropical cyclone parameters...]

BT —F =2 (DB) M oHEHEANT A —2 O 217 O BRic, 5 & 32 BROKMF2HE L ET,

[rsim] SR D O R AR E (T 7 4V ME 500 km)
[pcol : BRI T OREROREERRE (57 4V Mi 985 hPa)

[Limiting value of the tropical cyclone parameters...]

ARRRIE LR BT 2B BENT A —Z O ERERS L O FIREZRELET,

ds_min] :EHGFEEREO LIRIE GRERT : BFEARR/ T A — % ORI 21T 5 BICKIR & 5 B RO5M)
dp_min] : FLKEE T REO FRME (77 4L ME 28.0hPa)

rm_min] : FRFEMEEREO FRIE (577 4V M 8.3km)

cc_min] : EATHEED TR (77 4 /b ME 3.6m/s)

—_ /| o/
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[Reference roughness...]
TR HE FoOREA R ET SBEOMERZRELET,

[zo] MY FHEE (MASCOT Basic OfENTIFIZERE L7 FHME EOMER 52 ELET)

[Correction of Averaging time...]
SEEUCRE R IERE D /5 A — & 2R E L ET,

Proportionality constant IO. 1
Sigma minimum I0.0 m/s

[Proportionality constant] CAERTREICxT 528Gy (T 7 4L ME vy =0.1)
[Sigma minimum] D HIEJEGE O FBRAE 0 min (T 7 4/ ME 6 min=0.00m/s)

KMIERE 0 2 (THAUT IV B BN D

o a=max(y xut, o min)

[Consideration of the uncertainty...]
TSV DOBEHIC L DR DN T A —F 2R E L ET,

[~ op

Gamma E 0.5772156649  (Default : Euler's Constant)

Save Cancel

[opl s R G O A FEEMEIC B 2 RIEOBHER OB LZEBET HEICT =y 7 LET,
[Gamma E] A AT (T 74 ME Gamma E = 0.5772)

[Design target direction of the wind...]
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Wind speed range um |20

[Des‘gn target direction of the wind

[Design target direction of the wind] s BTG AR & D PRSI ARE oo U EE
[wind speed range] : EEFIFH (77 4/ ME Um=1.0m/s = Ur*=0.5m/s)

N
1
6, = NZ 0,
1
N : Ug £ 0.5m/sDT — X {f%k
[Monte—Car lo]

BTy al—ya IS AR EFEHROREEGZMEICE T DBERES X ORI O] 21T
I DD —AREE LET,

* File | Edit | Run View Tool Window Help

Rl EtV »
o) | Monte-Carlo ki Create New Case...

g T“‘i Copy Case... COEEE
El 1 Delete Case Tropical cyclone parameters...
E|| 23 Copy Ctrl=C Extratropical cyclone parameters...
Export Image... Ctrl=| Case Option
Export CSV...

(1) [Create New Case...]
R — 2B HRIER L ET,

Case name

Description

Prediction site Select site list... |

SiteID | Latitude | Lontigude | wsri

[Case name] CEEAS— A R RTE
[Description] L EHE A — 2 ONRE E IR
[Prediction site] : <Select site list...> TR L 7= fifbT S O FER
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<Select site list...> : FafIZ[Tool-Design Site & Speed up ratio...] TH&EE U 7T HIS U 2 - &2 824K

<Save> D REE & R AT
< Cancel > CHEEAT, BELUBREMEAEELEE AL S

(2) [Edit Case...]
BIRLCWDEHE S —AZmELET,

Case name IMC_CESEI

Description IMC7C3551

Prediction site Select site list...

35d 40m 41.875 140d 49m 35.91s

Save | Cancel |

XIBBRNZAIL. Create New Case...] ER—

(3) [Tropical cyclone parameters...]

BRDNTA—=Z 2R ELET,

Case name lMC_Case 1

Description lMC_Casel

~Tropical Cyclone D
Information file (*.mtdb)

lC:¥Users¥ W ¥Documents¥MASCOT _Samples¥Tutorial_Offshore¥Library¥Typhoon_DB¥tutorial_R15_1977-2014.mtdb L"T

~—Evaluation of Tropical Cyclone Parameters
[~ Analytical functions imulation length I 10000 years
Central pressure difference |MPDF j

Consider the correlation between parameters
Modify the parameters

to fit the original probability distribution
Translation velocity IMPDF vl

Approach direction |“°"“a| vI ~Prediction of wind speed
Minimum approach distance i Iquadratic vI Vertical wind profile model
Annual occurrence rate IPoisson vI Consider the effect of local topography

[~ Generation of virtual tropical cycdones

Radius of maximum winds MPDF v

Correction of averaging time

Correlations between parameters Yes 0l

Consider the uncertainty

—Speed up ratio
Recurrence period

[Case name]

2

ELTER S — A 23R LET
E LR —ANEZRRLET

[Description]

2

[Tropical Cyclone Database] : [Tooll-[Typhoon databasel CRRE L 7= BET — X X— A EREZ R T

3-15



[information file(*.mtdb)]
[Evaluation of tropical cyclone parameters]
[Analytical functions]
[Central pressure difference AP]
- MPDF
[Radius of maximum winds R,,]
- MPDF
[Translation velocity Cl
- MPDF
[Approach direction 6]
* normal
[Minimum approach distance d;,]
+ quadratic
[Annual occurrence rate 1]
+ Poisson
[Correlations between parameters]

[Generation of virtual tropical cyclones]

[Simulation length]

RA
AR B R A BT DR R R E

e
w
Rl

AT =S R= T 7 A NV ERIE
CRERT A= ORI RIE DR 2B E
s RO AR AR E

DD AUEAR R

B oA BRIk

s IR R HE s L 1
D IRAHER AT B ECK

B BAEUCK
s T R

© VAR R A 2R
AT AR BIEOK
CBERT A —Z I OMBRERORIE 21T O i

INDIRI
BB RIS DS 2 3R E
(10 TR E LTLEEW)

[Consider the correlation between parameters]

F BT A= Z R OFBEREE BE LI AEZAT 9 AR OEER

[Modify the parameters to fit the original probability distribution]

[Prediction of wind speed]
[Vertical wind profile modell
+ Engineering model
[Consider the effect of local topography]
[Correction of averaging time]

[Consider the uncertaintyl

[Speed up ratiol

[Recurrence period]

<Save>

<Cancel >

KITEEERE RPEHERLTVET

AR E LTCRERDAMITIR O L DT, BELI AT A—Z ORuIME

EZAT 9 IE DR

EGE . AR RER A BRUE SeAR A RROE

D BRIEE T L ORPUK

 LEMET IV

CRPFTHIZC X 2 B oo #85E & AR A & BT 2 SN ORE

s EGH O SEEEIRE R DM IE 24T 9 235 2 DFRE

s R O RSl Fe k2 BT D D D DREE
JIEOBBF R oORELEET S5 &1L, [Option]-

[Consideration of the uncertainty | CF¥& L £

R AR A B L T2 OB X 2 SRR OB Y UARECRE D S

G v

CENY H URER TLE T S LI A 5T

ARENE & R AT

CETHIANTD . BT U TS RREAE A A Ui A B U S
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(4) [Extratropical cyclone parameters..

FHIRD /T A — B & RIE

LEY

1

Case name IMC_Case 1

Description |MC_Casel

¢+ The database of the annual
maximum wind speed

~The Annual Maximum Wind Speed

" User define

Edit... I

Prediction sites

"1 Site Name
Site

<

ight

[ Power Curve File

Average U
30.9

Winc

Year ]

ul

Direction [

2000
2001
2002
2003
2004
2005
2006
2007
2008
2008

21.57
22.46
21.18
13.25
25.58
21.05
13.68
18.02
23.80
2118

183.35
18.45
160.01
37.92
194.81
292.42
9.38
208.47
44.13
150.00

[Case name]

[Description]

[The Annual Maximum Wind Speed]

ROE LR B — A 4 2 F0R LE S

CRELTRRE S - ANEE R R LET

S FNIB

[The database of the annual maximum wind speed|]

CERKIEGET — F RX—=2 o (BAN—T g o TTEEEL TV ER

[AMeDAS]
[User definel
< Edit>

< Close-up>

<Save>

< Cancel >

As)

T A — B OFETEITIE % BR

: TAMeDAS data converter| fifRDFEHRKEEH T 7 A LI HERTE
D=8

;RN RS & JERFER
([The database of the annual maximum wind speed]¥§EM D 72)

D REME Z ORAT

EH L%
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® ERKEHE T A —XDOREHIE
@D <The database of annual maximum wind speed>
ZHRDFER KJEET — & _— 2 DR E

7 =2 _X=2D YV J—AF THEEITFIFATE L)

Database management file (*.wsdb)
’.umenl:¥MASCOT_Samples¥Tuton'a|_0ffshore¥Library¥WSDE¥§Eﬁﬂi§ﬁﬂii2000-2009.wsdb =] Load I

Period ]2000 ~ |zoos Height  [10.0 |m

latiude 34 d [0 m oo s -7 d [0 m [o0 -
Longitude [138 g [0 m [00 s - [ a0 mfoo 3

Bin Latitude |0-0155567 Longitude |0.025 Deg.

[Database management file(*.wsdb)] CFEEIRT =X R—=REHRT 7 AL (K) ERIR-HRE
[Period] CHRE LT == 20O - W (BHAGE, K THE) BFR
SHET,
[Height] CHRE LT =2 R=20E# - TR Om S (m) BERRENET,
AT % i & 2RI L £ 77,
[Latitude] CHRELET = RN— RO - EREARRENET,
[Longitude] CHRELET = R— 20O - REFHEARRENET,
[Bin] CHRE LT — R RO - BT L OWEE O 2 2R
SHET,
<OK> P RENEEEET D
< Cancel > CRENBEREETITHR T TS
@ <AMeDAS>

[Tool-AMeDAS data converter...] #i5% 3%E

Prediction sites

Site Name Average U igma U Years

<Select> %+ L T, [Tool-AMeDAS data converter...] &0 SN FERKNEHT 71 /L (ymax.dat) R L F
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© v 1 .} « Library » CompositionTandS » Case01 v ¢ | Case01Di= »
=2 FULWTHLE— =Y M @
)\ Tutorial_Offshore A~ 2 & B B47
ki Library E CTS_CalucCmp_MCP_result.dat DAT J71IL 1KB
1) AMeDAS_TS
& CTS_CalucCmp_MCS_result.dat DAT J741l, 1KB
. CompareMPD i _
S 7Z site_mg_tc.dat DAT J74)l 14 KB
1 CompositionTand
s 7 ws_class.dat DAT J74), 7KB
- 'max.dat DAT J71) 2KB
J, ConvertTimeSeri (Zy
. PowerCurve
). Typhoon_DB
1\ Ws_Ratio
I wena X
FPANE(N): |ymax.dat v| [ YMax files(*.dat) vl

Prediction sites

Site Name l Average U I Sigma U I Years I
Site 28.0191555  2.0566823 13

[Prediction sites]
[Site name]
[Average Ul
[Sigma U]

<OK>

< Cancel >

s YA MR
IR LY A M
s AR R

s IR OAE (R
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Prediction sites

Site Name I Average U I Sigma U I Years |

Site

[Prediction sites]
[Site name]
[Average Ul
[Sigma U]

<OK>

< Cancel >

RENEE
RENEE

2.0566823 13

CY A MMEH

YA M

AR EGE u (m/s)
CARER R OIEHERZE o,

1

T 5
BEFIKTT 5

pa!

&
&

<Prediction site — Edit--->

Average u
Sigma u
Years

—Weibull

|28.0191555
|2.0566823
|13

Weibull K

Alpha

¥ Tropical Cycone

|2.07 Weibull C 15.28
’0.0059778

Weibull K

v Extratropical Cydone

I 1.87 Weibull C

[Site name]
[Average Ul
[Sigma U]

<OK>

<Cancel >

2

2

YA N
R EGE w (m/s)
AR RGE OIEHER oy,

WA & T
WA & T

ERA)
HFIKTT 5

& &l
B9

&
&



(6) [Case Option...]

File | Edit | Run View Tool Window Help

‘Dg_ = ’
Pﬂ)j!d 1 Monte-Carlo » Create New Case...

B T:ut Copy Case... Edit Case...
E Delete Case Tropical cyclone parameters...
B[ Ha copy Ctrl=C cyclone

Export Image... Ctri=1
Export CSV...

Limiting value of the tropical cyclone parameters...

Reference roughness...
Correction of Averaging time...
-

of the unc .
Design target direction of the wind...

Weibull parameters...

p.3-12 [Edit]-[EtV]-[Case Option] S

[Weibl| parameters]
TR X T A—H B ELET,

The number of dasses |51
Velodity bin width |1.o m/s

The evaluation number of years |215J

Save |

[The number of classes] : 7 5 2%k
[Velocity bin width] DB e
[The evaluation number of years] : FEM4EHL

3-21
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3. [Copy Case...]
BIRL CWDEHE S —A%Zab— 1L %7,

Source case IEtV_Case 1

Destination case |

[~ Copy Option
IV Casefile

[~ Calculation Result

[Source case] D A= — A4

[Destination case] o= —24

[Copy Option] CHERBRO a0 EA IR L 9,
[Casefile] AP —ORERMNE AT OHECTF =y 7 EANET (BEARW),
[Calculation Result] AP —KORERER L =T GBI TF v VB ANET,

4. [Delete Case...]
FIR L CWAHEE A — A 2R L E7,

5. [Copy]
View TERINDFHEBR (F779°%K) 27V v 7AR—K~ar—L%7,

6. [Export image...]
View TEREINDMYHFER (/T 7) A A= T 7 A NVTHRIFLET,

7.  [Export GSV...]
View THERIN DGR &) % CSV 7 7 A MW THRFE L E 7,

3-22



3-3-3. [Run]A*A=a—
FEFEIT, HEHEET, HEPEEITOCETAA =2 —TT,

" File Edit | Run | View Tool

‘D@ d

Window Help

Start EtV
Start Monte-Carlo

=- Tutorial[ Stop
= [EtV] 1

1. [Start EtV]
VU —TEIRF O TR KJEGE O B HRYIHER L ORI EHE %2 B8 L 7= EHRGE O I X 2 5IHE% % Ofif
MraFiTLET,

2. [Start Monte—Carlo]
VU —TEIRFDO [FTFHLr Y I alb—y g 3 B E FHRDORSRMBEIC BT 2 MEEEF L O

JRILOFAR ) DT 2 AT L ET

3. [Stop]
HEAPIELES, FIE LSS TOHEKRIIMEE SN ET,

SEFREMDOZ AT v ZRFRS I, FHRPEFRK T LETLAMO A v =Y BRRRENET,
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3-3-4. [NiewlA=a1—

BEGERE, BB NT A — X OfRSAX, FREEROZRIET 2 A =2—T7,

File Edit Run | View | Tool Window Help

- = JMA Best track data...
i’mject Prediction sites..,
- 'I:utorial[Proje« Estimated probability distribution of tropical cyclone parameters...
- [E] EtV »
- EtV_Ca
Monte-Carlo >

El [Monte-Carlq
- MC_Case, List...

Toolbars and Docking Windows 4
'V | Status Bar

1.  [JMA Best track data]
BHHE/RT A — 2GR & R o - B RO FEBE S ZiE L ET,

132 138 144 150
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2. [Prediction sites]
BT /T A — & WAL E & BB AR OO X 2 H L E T,

E Prediction Sites - [EtV_Case1] =8 ol =

-5000—

-10000—

~15000 b= | | | | | |
-15000 -10000 -5000 0 5000 10000 15000

3. [Estimated probability distribution of tropical cyclone parameters]
BIEST A — & ORI R ERS R & AR S R OR ARG R AW L E 9,
BAE. REARASLUSHERICKIEE/ NS A —2DEESH BRI A -2 OEESMEHRE L UEH

() Estimated probability distribution of tropicm parameters - [EtV_Casel]

Comear ison between the measured probablitiy distr ibution ! The model functions
of tropical cyclone parameters and the model function 1!
Cantral praccura diffaranca 4P FRadluc ta maximum mindé Re 1 e ameter name ytizal 1on name L perameter [ialon

= ET

:Z?_/

T T wiwads

foontral prozaure differance|2p

Fed e ibation
Logrormel &istribation

Leelan
Leel v

1

1

1

1

1

1

1 Padivs of macimm winds o) gisaribution
1 T T ihaion
1 ————
1

1

1

1

1

1

1

framlstion velocity F eibull distribution

Tranclatlan valaglty © Appraach dlvactian B

oo

o
. o Ninimm aprrosch diztanze i i P
/ e e [ o T ) =

Frequency distr ibution of annual maximum gradient wind speed

Fiod T ihaion

feproech direction & Pormal diztribution

Jale)

IR o S MR

1
T 0 0 = - + : 1 1
i u$ aeraisy 1 based on measurement and simwlation 1
: Minlwus appraach dictance dein z Annual accurranca rate A 1 1 i3 1
" ; _— !

A A 1
e ES s 1
I z. 1 & 1
ek B 1 1
- 2 1 1
1 1
| N s ke e S wew® oo !

Correlation coefficient between tropical cyclone parameters 1
! based on measurement 1
1 arralatian caafficlent baced an meacurqmant Carvalatian cagfficlant bacad an 1
1 adif1ed arthaganal decampacitian mathad
| Tozlary [ezlay ezl |8 Gatn Tozlary [iozlal  [iozl % @Tn !
| Taz [&PY [1. 000 1000 1

Tag [Fw)_|-0.373 T.000 0,367 T.000 1
1 Tag [ty __|-0.020 CEH] 1,000 0010 0363 1,000 1
1 B 0. 076 0. 069 0311 1.000 0. 028 0. 06q 0. 781 T.000 |
1 dnin 0. 266 0. 787 0. 367 0.3t 1,000 0363 0,773 0. 261 0. 360 T.000

BAELFREBERIZE T HER/S A —5 OEERK
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model function] (#RAIEE RHEAMICL ZBE/NT A —2 DHEES )

Comear ison between the measured probablitiy distribution
of tropical cyclone parameters and the model function

Central pressure difference AP

., Radius to maximum winds Rm

@ Uezur ement © Meazur wment
o — Funztion A - Fumztion
28 | Mol L8 i
T 22 =22
~1 74
g s
14 14
. 1 ] l 1 1 i 1 ] ] 1 1 ]
E. - - -2 -1 =3 - -2 -Z -1 [ |
In(=1In(1-F)) In(=In(1-F1)
_ Translation velocity C l\.Qpproach direction @
s 0.0
© Meezur ement
= Fumction
ol )
52
o8
2 LE
L4
1.9) = | L 4 o 1 1 1 1 1

InE:In(1;;]]

Minimum approach distance dmin

= -2 -1 [ 1 2 3

nornziny

Annual occurrence rate A

probability

[

o 3]
if(n+1)

[Central pressure difference AP]
[Radius of maximum wind R,,]
[Translation velocity Cl

[Approach direction 6]

[Minimum approach distance dp;,]

[Annual occurrence rate 1]

=4
D ELTHE
AT
: FctET B
BRI A

2 4 [] ]
nunbers of occurrence

DD AUEAR R

R T i R -

® (Ff ) : BIE (F=f2L. BREMELERIIEST S D)

— (B & :ETL

x (FNY)  FESA (L. SRAEMRERIIERT)
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3-b. [The model functions] (&E/XT5 A—% OFEERSMEAME & Vi)
Typhoon parameter name fnalytical function name & parameter Yalue

. - ; & |Mean 1.5838

Kognotimal. st nutien ¢ |Standard deviation|0.1147

Central pressure difference|/p Woibul| distributi k [Shape parameter 4.1582

21 WBETIPHRLRN C |Scale parameter 43.7328

Mixed distribution a |Mixing coefficient|1.0000

. X ) w |Mean 2.1016

Lognormal. distribution et o ndard deviation|. 2454

Radius of maximum winds Rm Weibul| distributi k |Shape parameter 1.9170
IR WSEIRHELCR C |Scale parameter 164 .6789

Mixed distribution a [Mixing coefficient|0.5210

. . , & [Mean 1.6677

hosnonad. 4\t gklon ¢ |Standard deviation|0.2266

Translation velocity C TR N A k [Shape parameter 2.4844

C |Scale parameter 57.4806

Mixed distribution a [Mixing coefficient|0.0000
; ; ; ; ; & |Mean 143.3489

Approach direction & |Normal distribution o R [
Mini h dist dninlPol al z |Model coefficient [-409.9805
inimum approach distance min |Polynomia e itioal dictance 15000000

Annual occurrence rate A |Poisson distribution |Am[Mean 2.7872

[Typhoon parameter name]
[Analytical function name & parameter]
[Value]
[Central pressure difference AP]
[Lognormal distribution]
[u Mean]
[0 Standard deviation]
[Weibull distribution]
[K Shape parameter]
[C Scale parameter]
[Mixed distribution]
[a Mixing coefficient]
[Radius to maximum winds R,,]
[Lognormal distribution]
[u Mean]
[0 Standard deviation]
[Weibull distribution]
[K Shape parameter]
[C Scale parameter]
[Mixed distribution]
[a Mixing coefficient]

[Translation velocity Cl

P RENT A =24

D HERAT AR L BN T A — 2 4
BB T A= ZERENE

CPLDREETE
s RPEE LS AR B %
VY fE
: FEYER 72
DA TG B
2N
L RERRE
R ARSI B%L
CRERE
G AN T B
C RPEOE RS AR B R
Y fE
IR
DA T VoA B
2N
s RERRE
BRI PR
CRARE
LT
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[Lognormal distribution] s PRI A BE 2K
(4 Mean] C P
[0 Standard deviation] : EEVER
[Weibull distribution] T T A TIIVSAREEE
[K Shape parameter] 2N T
[C Scale parameter] s RERREK
[Mixed distribution] R TR AT B
[a Mixing coefficient] CRA R
[Approach direction 6] s AT M
[Normal distribution] s IERL A B
[z Mean] PR fE
[o Standard deviation] : EEVER
[Minimum approach distance dp;,] s IR T EEE
[Polynomiall s BB
[z Model coefficient] HBUNIPYE
[r Critical distance] o PR R
[Annual occurrence rate Al s B EOFERFEAEK
[Poisson distribution] CART Y oA
[4, Mean] R A S

B

Rl

3-c. [Correlation coefficient between the tropical cyclone parameters based on measurement] (B I{E & {K

BEBICHEIT3EE/15 A —42 OEEEE)

Correlation coefficient between tropical cyclone parameters

based on measurement

Correlation coefficient based on measurement Correlation coefficient based on
odif ied orthogonal decomposition method

log{ AP} |log(Rm)  |log{C) 8 dmin log( AP)  |log(Rm) loz(C) 8 dmin
log{ AP} [1.000 1.000
log(Rm) |[-0.373 1.000 -0.357 1.000
log(C) |[-0.020 0.421 1.000 0.010 0.383 1.000
] -0.025 -0.058 -0.311 1.000 -0.028 -0.054 -0.281 1.000
dmin 0.265 -0.282 -0.267 -0.354 1.000 0.253 -0.273 -0.251 -0.350 1.000

[Correlation coefficient based on measurement]

C BUAMEIC L 2 BRRT A — 2 OB

[Correlation coefficient based on modified orthogonal decomposition method]

EEEREMEICESRBERDOERE/NT A —2E0OHEE

(In(AP)] C HIDREETEDOXHKIE
(In(R,,)] : BRK e ELE 41X 0t 4 fiE
(In(0)] D EITRE DX E

(6] ETAM

[dmin RiRIA R
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GEE

- [Frequency distribution of annual maximum gradient wind speed based on measurement and simulation] (&R;BI
EERBEERIZK S LERDERKEE)

0.0

o Measurement
50.0— |[—— Simulation
40.0—

20.0/—
0.0
2 ] 10 20 50 100 200 500 1000 2000
| 1 I I
| | | |
0.0; 0 7 1 3 :
-In(-In(F))

RO R RE [(3), (4)1 11X, V7 7BIORESVAERZ L TE TN )y 735 L BIFMLED
T T7BIOERBBY 4 FUTRRINET,

#il . (4) ®[Central pressure difference APID VT 72~ U RAERZ L TETINI U v I F5HE, FTRNFRS
WET,

) Estimated probability distribution of tropical cyclone parameters -... [fo-E- =]
. e
3.DCentral pressure difference AP 2
2.8 o Measurement é‘}
Function

2.6~ x Model

2.4
o
S 2.0
00
© 1.8

1.6—

1.4

1.2

M —— — 3 f 2

In(=In(1-F))
i EH B @ .| B . . .
EBIT, Y R— & ) REHT )7 TDHEe BRENTVWOE2—DNEL Y

Uy HR—=RF~ab—T&ET,
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[Etv]
Etv &R I

File Edit Run |View | Tool Window Help

D& d| o IMA Best track data...
pojed | Predictionssites..
= Tutorial[Proje( Estimated probability distribution of tropical cyclone parameters...

&-[EtV] BtV Estimated topographic multiplier...

- EtV_Case
Monte-Carlo " .v _— :

- [Monte-Carlc Estimated probability distribution of the annual maximum wind speed of tropical cyclone...

B-MC_Case List...
Site

Toolbars and Docking Windows

[V] status Bar

Clipboard copy | Export csv file...

Case: IEtV_Casel

No. | site etv| Ew@d)|  EtsEd)|  EtEd) | ad |
1 site 1.055 1057 0.955 0.903 192630

[No.] o R HE . No.
[Site] o R R R R AL
[EtV] : 50 FFHEIFHEIC G 2 Mg L (Typhoon #5250
[EtV(6d)] s EURRRME A B RE L 7o IS D BUE O EI D 1 L AREKL
[EtS(0d)] WU & D B G O A IEAR S
(EtI(0d)] s WU & % ELIESRE DM IEAR S
[6dl IRASEGRE I (BE, dEA BRFRHE Y O 4 )

< Clipboard copy > YR RNEZY v R—RiZay—

< Export csv file > : UA M2 CSVIEAT 7 A MITHIT)

(2) [Estimated probability distribution of the annual maximum wind speed of tropical
cyclone...]
BTNV ab—va KD A SRS RIS X B F R KEGE O R MR AT B L O L E &

© Uncertainty(Real)
*x  Uncertainty(Flat)

20.0—
10.0—
0 20 s 1000 2000
K | |
0:05 0 7 1 §

-In(-In(F))

AR B2 B AR R ORE A A
R PHUBIEIC 51 5 AR K DR 57
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5.  [Monte—Car lo]
Monte-Carlo R K

File Edit Run | View | Tool Window Help

DEd | g3 JMA Best track data...
Prediction sites...

- Tutorial[Proje Estimated probability distribution of tropical cyclone parameters...

& [Eev] o
| m-EtV_Ca
& [Monte-Carl Monte-Carlo m— - - Estimated probability distribution of the annual maximum wind speed...
=8 Mcﬁse List... List of estimated probability distribution of the annual maximum wind speed...
Site
Toolbars and Docking Windows Weibull...

[V] status Bar

(1) [Estimated probability distribution of the annual maximum wind speed...]
A I KRG OO FEFB I SR 53 AR 3 I ONREH G 4 8 L £ 47,

oL =® =
60.0 :g
iy | O P s
40.0
)
E 30.0
=2
20.0
10.0
2 5 10 20 50 100 200 500 1000 2000
| | | | | | | | | |
u.g 1 1 1 BI
-In(-1In(F))
Tropical Cyclone
Extratropical Cyclone
Combined Cyclone
e Extratropical Cyclone
< Tropical Cyclone > : B R DA i KR D FEHR M e 58 53 At % H
< Extratropical Cyclone > © ZRA B\ O 4F Fie K JBER O FE R Bl SR 45 AT % 4 T
< Combined Cyclone > 2 TR B\ D AP I B GE 0D e il 2R 45 AT A H
<All> s BT OHFER KRR O IR AT &
<List> D R EGEE N T A —& U A N DFRIR
< Export CSV > DR K EGEOIBBIRMER S OT — % (FRFIT—%) % CSV A CHI
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<List>

Cipboardcopy |  Exportcsv fle... | Numberofdecmalplaces  [3 <]

a e
[Number of decimal places] : /NS LLT D7
[Site name] : AT LA R
[R] D BRI ()
[Uc] RARBEIZI T 2 EH
[6d] : FRATS B A f)
[UT] AR LD (RHEFEMEOBE AL LI2EaiTo UT, o PT 2558
[UE] D RIS XD (RiEEMEDEE AR E LI2BEI1Xo E 25 E)
[oC] SIRARKRNC XD RO ER A ]
[oUT] RN & 2 EGE O AR 22 (R O BRI X 25 58 [x]
[oPT] BRI K D SO HERZEGEOBLIHIELIC X 2 528) [kl
[cUE] D ZEHEIC K D R O R K]
[a] D R ORERER RIS 1 D R 0 EALRE K]

< Clipboard copy > YR RNEZY v R—RiZay—

< Export csv file > : UA M2 CSVIEAT 7 A MITHIT)

ISV Z B8 L2358 D3R
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I

(2) [List of estimated probability distribution of the annual maximum wind speed]

& s ed probability distributic e annual maximum ... [-= | 5|
Clipboard copy | Export csv file... | Number of decimal places |3 vl
Caisacs IMC_Casel
No. | Site name |[R  |uc~ | ad | ur~ | ue~ | uc
1 Site 50 49.981 186.949  49.981 34,202 48.150
< >
(3) [Weibull]

W F7REAR O 72 80 DR BBHEE RS R 2 Fom L £ 77,

B

JALL
1,000,000 | Site
Tropical
100,000 Extratropical s
Comb ined
10,000 _
1,000 o
100 il
10 =
1 =
|
O B0 75

X #if : 10 4 ¥ JEsE Ulm/s)
Y il AR AR (5)

{ALL

B

Tropical Cyclone
Extratropical Cyclone
Combined Cyclone

1
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<Tropical Cyclone > BB Sy AR & H

< Extratropical Cyclone > : 2R D 53T A B

< Combined Cyclone > R D 53 % R

<All> : AT DA Z Al

<List> BB ROE ST A — 5 Y 2 S OFRR

< Export CSV> BT — & % CSV A THI

<List>
Clipboard copy | Export csv file... |

U(mjs [ Weibul - tc | Weibul - ec | Webul-cc[  Time(min)-tc[ Time(min)-ec| Tme(min)-cc|  Ratio(%)-tc|  Ratio(%)-ec|  Ratio(%)-cc A
1.0 0.32334 1.508005 1.502343 162.432195 157763.881034 157926.313229 0.32334 1508005 1.50234%
2.0 1.063448 3.815243 3.802092 534.231404 399141.726481 399675.957885 1.063448 3.815243 3.80209z
3.0 1.828752 5.656681 5.638388 918.688058 591788.649274 592707.337332 1.828752 5.656681 5.63838¢
4.0 2.579407 7.053603 7.032221 1295.785452 737931.318446 739227.103897 2.579407 7.053603 7.032221
5.0 3.28794 8.001641 7.979115 1651.722805 837112.839896 838764.562701 3.28794 8.001641 7.97911¢
6.0 3.932068 8.515228 8.493326 1975.305441 890843.12598 892818.431421 3.932088 8.515228 8.49332¢
7.0 4.493688 8.632165 8.612388 2257.440095 903076.744423 905334.184517 4.493688 8.632165 8.61238¢
8.0 4.958912 8.409724 8.393233 2491.145002 879805.547206 882296.696208 4.958912 8.409724 8.393237
9.0 5.318251 7.917849 7.905426 2671.665772 828346.722089 831018.387861 5.318251 7.917849 7.90542¢
10.0 5.566721 7.23166 7.223703 2796.486441 756559.200486 759355.686927 5.566721 7.23166 7.22370Z
11.0 5.703764 6.424574 6.421129 2865.331538 672123.737162 674989.0687 5.703764 6.424574 6.42112¢
12.0 5.732979 5.562815 5.563628 2880.007489 581968.53957 584848.547059 5.732979 5.562815 5.56362¢
13.0 5.661646 4.701696 4.706283 2844.173005 451880.319631 494724.492636 5.661646 4.701696 4.70628%
14.0 5.500115 3.883724 3.891448 2763.026728 406306.016628 409069.043356 5.500115 3.883724 3.89144¢
15.0 5.261067 3.138327 3.148471 2642939128 328324.366075 330967.305203 5.261067 3.138327 3.148471
16.0 4.958725 2.482851 2.494683 2491.054947 259750.049246 262241.104193 4.958725 2.482851 2.49468:
17.0 4.608055 1.924399 1.937224 2314.893078 201326.123257 203641.016335 4.608055 1.924399 1.93722¢
18.0 4.224017 1462099 1.475297 2121.968767 152961.299312 155083.26808 4.224017 1.462099 1.475297
18.0 3.82089% 1.089444 1.102498 1919.459141 113975.106382 115894.565523 3.820899 1.089444 1.10248¢
20.0 3.411766 0.796458 0.808956 1713.927773 83323.521059 85037.448832 3.411766 0.796458 0.80895€
21.0 3.00805 0.5714% 0.583135 1511118002 59787.984613 61299.102615 3.00805 0.57149 0.58313¢
22.0 2.619285 0.40261 0.413204 1315.818601 42120.145125 43435.963725 2.619285 0.40261 0.41320¢
23.0 2.252975 0.278558 0.287994 1131.799841 29142.109371 30273.909212 2.252975 0.278558 0.28799¢
24.0 1.914597 0.189328 0.197573 961.813262 19807.054623 20768.867885 1.914597 0.189328 0.19757:
25.0 1.607708 0.12644 0.133519 807.645027 13227.820114 14035.465141 1.607708 0.12644 0.13351¢
26.0 1.33413 N.NR79RR N.NRRIAT7 A70.210AN1 RAR1.973R25 Q352. 184476 1.33413 N.NR79RR N.NRRIAT

U(m/s)] PR R

Weibull - tcl CBEOT A TV

. e S
Weibull - ec] C ERIRO U A TV
Weibull - cc] RGO T A T NG

Time(min.) - tc] D BEOERFEAERH (5))
Time(min.) - ec] : R ORI AR (57)
Time(min.) - cc] CREEOFRITEAERR (5)
Ratio(%) - tcl D RERHI T D REEE (%)
Ratio(%) - ecl D RIS D IR (%)
Ratio(%) - ccl IRA BRI DR (%)
Clipboard copy] cVANEZ Y T R—Rizar—
Export csv file] LR b & CSVIBRT 7 A Ml S
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<Parameter >

[
[
[
[
[
[
[
[
[
[

Clipboard copy | gxportcsvﬁle...l

Item

| Value I

The number of dasses
Bin

Evaluation Years

TC - Weibull K

TC - Weibull C

EC - Weibull K

EC - Weibull C

Alpha

The number of classes]
Bin]

Evaluation years]

TC Weibull K]

TC Weibull C]

EC Weibull K]
EC Weibull C]
al

Clipboard copy]
Export csv file]

61

1.0

20

2.09

15.4

1.87

9.51
0.0047789

CEGR T U Ay Rk
DT g

© RS

R EBTA TG A—H K

BREICE DT AT NIRRT A—=%C

BRI LD T A TARTGA—F K
EEEWC LD TUA T NANRT A—H C

RATREK

VRN ETY T R—RiZar—
: UR & CSVIERXT 7 A Wiz
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6. [List...]
FEMTRER DU A N &2 HH L £ 9,
AT IZE R EINTWD 7 7 7IZB#T 5 U A M3 H DA A FEETT,

Clipboard copy |  Export csv fie.... |
Site name [ [uc [ 8d [ur UE oC oUT oPT GUE a |
Site 50 49.98 186.95 49.98 34.20 1.83 0.34 1.49 4.08 0.00
< Clipboard copy > VA NORREZ Y v AR — Rlicabe—
< Export csv file > : UAMOWNEZE CSVIERT 7 A LT

3-36



1.

8.

[Toolbars and Docking Windows]

 File Edit Run

View | Tool

Window Help

&=- Tutorial[Projec
- [EtV]
@-[Monte-Carlo

|

JMA Best track data...
Prediction sites...

Estimated probability distribution of tropical cyclone parameters...
EtV 4
Monte-Carlo 4

List..,

Toolbars and Docking Windows

v

Status Bar

Window

Help

Standard
Output

E\ [Monte—oado]
@-MC_Casel

@

Output

The project was opened. ® I
N ready ‘ﬁé\‘ — CAP. NUM SCRL j_l
[Standard] FRERY N N—QOFRTIERTEDN YRR ET,
[Project] 7 mYxl WYV —QOFR SRR ANV ET,
[Output] TNy Ny RUQOFRRIEEREL YR ET,

[Status Bar]
[Status Bar]

P AT = A AN—OOFRHFR T A ET,
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3-3-5. [ToollA=a—
BRETF—ZN— 2 EEER

(D@ d| -
o

File Edit Run View Window  Help

e (¢

=- Tutorial[Project]
=-[EtV]
e cosel
B- [Monte-CarIo]
&-MC_Casel

1. [Typhoon database. .. ]

MR K ORI E DR EICR T 2 A =2 —T7,

Typhoon database...

Design site & Speed up ratio 4

Create wind speed ratio...

Convert time series data...

AMeDAS data converter...

Divide the wind velocity according to the origin...

Composition of the tropical cyclone and the extratropical cyclone...

BT — 5 ~—ACHT B REETOET

Database directory
Kind of the database
Period of extracted data

DB information file name

[Database directory]

[Kind of the databasel

lC:¥Program Files (x86)¥MASCOT¥MASCOT Offshore V1¥TDB¥
[Rosct |
" All periods of data Beginning : |1951 End: l2007

& Arbitrary period Beginning : |1961 End: |2007

|C:¥Users¥.r¥00ments¥MA5COT _Samples¥Tuto. .. ¥tutorial_1961-2007.mtdb

Save

FRAT R ZDRIFENTND 7 AV —HIRELET,

MASCOT Offshore #7 7 4 /L kDA A h—/VHEIZA A =L S84
WDT 3 NVHE—IZEHESNET (KXPCOYVATARITA TN “C:” OEE)
“C'¥Program Files (x86)¥MASCOT¥MASCOT Offshore V1I¥TDB¥”

ATV A BT — 4 _R—ADREEfRE L ET,

WE L, B ETHIL “RDSCY” %, HLETHiUT “R-157 #@IRL £,

o

[Period of extracted datal : f#HTICHW A BRT —FZ X— 2D EZHEE L E T,

[All periods of datal
[Arbitrary period]

D BET - R—202HME R LTS
DR LT DM ARTET S

[DB information file name] : f#ATICHW D BET — X X—AERERET I 7 7 ANV L ERELE T,

<Save>

< Cancel >

BT —F_R—=AEW T 7 A VDT 7 AV NORGFRIET a2 s b T L F—
P ®”Library¥Typhoon_DB¥’ T,

REEDRAFEITOET,

DB AEMIZE L CRTEEIZREY £7,
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[Design-site & Speed up ratio...]
AT b 5 O SR LE 2 00 %k ik

File Edit Run View | Tool Window Help

DEHA I 23 | & (‘A Typhoon database...
Project | Design site & Speedﬂyp ratio 4 Create...
B..'l:utorial[Project] Create wind speed ratio... £

E‘ [!EtV] Convert time series data...

=-EtV_Casel
& [Monte-Carlo] AMeDAS data converter..,
= r\fIC__Casel Divide the wind velocity according to the origin...
... Site

Composition of the tropical cyclone and the extratropical cyclone...

(1) [Create...]
JR R M AT AR EZI TV E T,

MASCOT project file C:¥Users¥ . ¥Documents¥MASCOT_Samples¥Engineering_for_Offshore¥Engineering_for_Offshore.meg
Project tree Site information
[=)- Project

[ Default Site
B Tutorial

<

Site list file ] C:¥Users¥ . ¥Documents¥MASCOT_Samples¥Tutorial_Offshore¥Library¥\igy Ratio¥tutorial_sitelist.min

View...

MASCOT Project file : MASCOT Engineering D7’y =7 N7 7 A LV EEELET,
FHTZ MASCOT Engineering CYVHRUEDHIZIZ L 2 EIERBAEFE L TR MLERH Y £9, X
Project tree : [MASCOT Project file] THiE L 7= project tree NF R S IVE T,

¥16 FElm (225 Y v F) OFTFEROHITHIE L TWET,
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3

i_l : [Project tree] TR L7127 v = s MEHE MASCOT Offshore 7' m Y =2 MZ

AVR—FLET, 1A= bENDT RV 27 MERIZLLTD 75T,

- Site name : fRHTHISA

- Latitude  : AT HLS OO EE

* Longitude : fifATHIR DOREEE

- Height CfETHAEOE S (m)

CEtV o A EGE O M I & D FIHE R

* Yaw R 0D R R 4

< EtS o JRAI O Z B R O M I & S IR A

- FRLAOREBIOFERIZ OV T HRFE SN TOET 2, Wi ECIIMRT 52 ST TEE
oo TR LEE7RA 1L, MASCOT Engineering 7> H g8 L T 7230,

[Site information]  : A AR — b LIZffTHLSIE RO Y 2 MR RrEhET,
[Site list file] D FRNTHL S O GE L SO RERGTT D7 7 A NVAERELET,

AT LS B O LE R 7 7 A VDT 7 4V NORFRIETTa =7 TV FNO
[Libraryl-[ WS_Ratio]l T9~,

<View> : [Site information] TR L 7= i i oM@, mABIERA R RIS ET
(AHEE ZMH),

<Add> : MASCOT Engineering 7> b BB M AICET 2R ELTHO T, 2 —FIMERITHRIE
DEMEATNET (BEESHK),

<Edit> D AR M AT DR EDORER . BEEROMELZITNET (CEHESR),

KIMENAIL EFLO<Add> LR L TT,

<Delete > s JRELRE R LI BT D RE DRk . BB OHIREZIT O E T

<Save> CREMEDRAFEITNET,

< Cancel > D EEE A EE L CRTEEICR Y 75

View...

(A T )

No. 1
Site Site

Latitude [35° 407 41.87"
Longitude [140° 43" 35.91"

Height 100.0
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[
[
[
[

Latitude
Longitude

Height

Speed up ratio

|0

’ lo.o

|o

‘ |o.0

Edit...

g

Direction | Etv | Yaw |

Ets |

o ISE

4
5
6
7
8
9

Years

0.000
22.500

67.500

90.000
112,500
135.000
157.500
180.000
202.500
225.000
247.500
270.000
292,500
315.000
337.500

- Extratropical cydone parameter

1.000 0.000
1,000 0.000

1.000 0.000
1.000 0.000
1.000 0.000
1.000 0.000
1.000 0.000
1.000 0.000
1,000 0.000
1.000 0.000
1,000 0.000
1.000 0.000
1.000 0.000
1.000 0.000
1.000 0.000

1.000
1,000

1.000
1.000
1.000
1.000
1.000
1.000
1,000
1.000
1.000
1.000
1.000
1.000
1.000

45.000 1.000 0.000 1.000

pas s

Average U IU-O Sigma U IO-O

Site name]
Latitude]
Longitude]
Height]

<Edit>

OK

S

o R\ R M AL R
DHEEE (IR B ARRIHSR)
D RREE (1B B AHIHR)
c T E(m)

<OK>

<Fyrorer>:H

EDORFZATNET,
a2 U CRTEmE ISR Y £,
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(C i)

Site name lSihE

Latitude |35 ° |40

Longitude |1qo ° |49

Height ] 100.0 =

Speed up ratio

Direction EtV
0.000 0.959
22,500 0.998
45.000 0.998
67.500 1.070
90.000 1.060
112,500 1.052
135.000 1.049
157.500 1.050
180.000 1.062
202.500 1.057
225.000 1.061
247.500 1.034
270.000 1.013
292,500 0.908
315.000 0.866
337.500 0.898

Yaw EtS

-0.352 1.059
0.478 1.038
1.071 1.038
1.170 0.969
0.939 0.959
0.268 0.953
-0.414 0.951
-0.858 0.953
-1.080 0.960
-0.831 0.955
-0.218 0.959
-0.327 0.962
-0.168 0.986
-0.045 1.016
-0.128 1.038
-0.807 1.053

- Extratropical cydone parameter

Sigma u |0~°

(2) [Edit...]

oK I #v)t’}bl

Site list file | tutorial_sitelist.min
Site information

Add...

Edit..

No. I Site name

| Latitude

| Longitude

| Height

1 Site

35°40"41.87"

140749 35.91"
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<Add> D LUF OB 23R S, AREHUROBIMZTVET,

Site name

Latitude

Longitude
Height
Speed up ratio

Direction | Etv | Yaw | Ets |
0.000 1.000 0.000 1.000
22.500 1.000 0.000 1.000
45.000 1.000 0.000 1.000
67.500
50.000
112,500
135.000
157.500
180.000
202,500
225.000
247,500
270,000
292,500
315.000
337.500

No.

1
2
3
4
5
6
7
8
9
0

1

Sigma u IO-O

oK | el |

< Edit> U T OB A FE R E 1, [Site information] TEER L7 E OEEZITVET,

Site name lSite

Latitude |35 ° |40 ‘ |41.87

Longitude |140 ° |49 . |35.91

Height | 100.0 -

Speed up ratio Edit...

Direction | Etv | Yaw | Ets |
0.000 0.959 0.352 1.059
22.500 0.998 0.478 1.038
45.000 0.998 1.071 1.038
67.500 1.070 1.170 0.969
50.000 1.060 0.939 0.959
112,500 1.052 0.268 0.953
135.000 1.049 -0.414
157.500 1.050 0.858
180.000 1.062 -1.090
202,500 1.057 -0.831
225.000 1.061 -0.218
247,500 1.034 -0.327
270.000 1.013 -0.168
292,500 0.908 -0.045
315.000 0.866 -0.128
337.500 0.898 -0.807

No.

O WO NGO b WK -

—

¥ Extratropical cydone parameter

Years | 13
Average u |28.019 1555 Sigma u |2.0565823

oK | el |

<Delete> : [Site information] TER L= S 2 HIER L £,
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I

<View> U FOE RN F R &, [Site information] TR U 72z #S O EREHR, BRI RS TR &
nE7T,

No . 1
Site Site
Latitude [35° 407 41.87"
Longitude [140° 49" 35.91"
Height 100.0

o 7 7k
¥ired Dircoticn Deg)

X
3
)

R Tir L
¥ird Directicn [Deg

i3 b T
¥ird Direotion [Deg)

<Save> D REMEORGFEITNET,
<Cancel > : FEMEMEIEL CRIEEHIZEY £7,
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3. [Create wind speed ratio...]
2 Hit R o Bl s b - RERA 7 7 A SV OERRE TV E T,

MASCOT Basic folder IO:¥Users¥—-¥Documents¥MASOOT_Samp|es¥Engineer ing_for_Offshore¥

~Reference Site

Label !Eng ineering_for_ Offshore

Latitude 3/ 437 00 it
... I

Longitude 140" 507 3007

Extraction height 100

~ Prediction Site

Add from offshore case.. | Add.. Edit. | Delete |

No. | Site name | Latitude | Longitude
1 Site 35 407 41877 140° 49" 3591”7

Extraction height 00 m

Description ]caseel

Output folder IC:¥ Users¥ ¥Documents¥MASCOT Samples¥Tutorial Offshore¥Library¥CompareMPD [@]

Import settings... | Detail... | RUN Close |

[MASCOT Basic folder] : MASCOT Basic D7 u =2 N7+ A X EELET,

[Reference Sitel R A HET DG A OEUER S (D) LD MR ORE - RE - BESREREN
¥, T 74V K Tld, MASCOT Basic DT LB 2328 S E T,
< Edit> DU OB SRR S, FEUEM S ORI OmREEITTWVET,

Site name IEngineering_for_Offshore

Latitude |35 ° |43 ‘ |0.0 "

Longitude |14o ° |50 . |30.0 -

oK | e

[Prediction Site] EGEE A RET 25A O TR (57) &R UG OME - BE - B ERELET,
T 7 & /v kT, MASCOT Basic @ [Edit]-[Option]-[Site] Tk L /- S 38k S E
< Add from offshore case™> : MASCOT Offshore TH&k L7= 7 — AN HSEHRE A AR —FLET,
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MASCOT Offshore project file

C:¥sers¥ e ¥Documents¥MASCOT_Samples¥Tutorial_Offshore¥Tutorial_Offshore.mof

Case list

[EtV] - Etv_Casel
[Monte-Carlo] - MC_Casel

<Add> PUTOBEEART S, THMEOAT - (B - BREZHREERLET,

Site name I

Latitude |0

Longitude |o

<Edit> UL FOBEEAFREN, BEFELO TS OLF - 5 - REAZRELET,

Site name ISihe

Latitude |35 ‘ |41.87

Longitude |140 . |35.91 "

oK I %wwbl

<Delete> : BEFEHDOFRHSEZHIERL 3, BEFEHOFTRIHE Y A b2 SHIERG SO MR 2 8H4R (F
Kz) L. [Deletelz 7 Vv 7 LET, #HROAvE—UNFREINETOT, LALITH
X HEY) ) 22y LET,

Prediction site

Add from offshore case.. | Add. | Edit. |  Dekte | wiew. |
No. | Site name | Latitude | Loneitude |
i Site 35 40 41877 140" 49" 3591
2 540 4187

@ The site [Site2] is deleted. Are you all right?

) | wam |

<View> : 2 HigH O ARIEEI R K ORARSA 77 7 2 RR LEd, FoROpR, 2 HusfE o a5
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W X ORERA 2R (KRUN>ET) #BICFERLTLLIEE N, REROBAITIELLE
REINFERA,

Mind Speed Ratio

No. 1
Site Site
Latitude [35° 407 41.87"
Lonzitude [140° 49" 35.9717
Height 100.0

Rind 3paad Ratla
s errEE

T T e
Rind Diraction [04z.)
Def lection Angle

-3

)

Daflactian 4ngla
e

AR

T T e
Rind Diraction [04z.}

[No.

[Si

[

[

[

[Wind Speed Ratio] : HiJIZ X 2 E¥Jals o B HE LR 5L

[Deflection Angle]  : JEUIf {4

[~ 7] : MASCOT Project 7351 AR — b L7z & XS @M & B EiR (R BAFRREE

¥

[Extraction height] : FHIHSOE S ZHELET.
[Output folder] RUEH R ERE R A RIFT D 7 AV F EBRELE T, T 7 4Lk Tid, MASCOTOffshore
O7uYxl b7 4 FZANO[Libraryl-[CompareMPD] %8R L £,

4 |, Tutorial_Typhoon
4 |, Library
.. AMeDAS_TS
i L, CompositionTandS
b J. ConvertTimeSeries

J. Typhoon_DB
b s WS_Ratio
> )i Project

| FTIL-ofR®) [ oK




¥ 3
<Import settings> : WEIMEE LR ERMT 7 7 A L EH AR ET,

REGIET 7 A LA LS
ERER £ 7 L7 4 W H IR A S T\ [ Description_CompareMPD.min] % i
RLUET,

1 |l « Library » CompareMPD » v & CompareMPDDIEE
WY  HUWTHE-

1. Tutorial_Offshore A
1. Library

4= -
£
1. Case01

|Z case01_compareMPD.min

23
TP TS —
MIN J74

H4Z
1) AMeDAS_TS

. CompareMPD
1, CompositionTand

v

TrAVEA(N): ICaseOl_CompareMPD.min

v| [setting file(*.min) v
[ o

| | #even |

<Detail > DIEYERS B LO TR S O RMFRA 2 SET 2050 08RE LET, 7 74/ M TR
iR s b RMFEAEEE (F=v7HY) LET,

$Measure-Correlate- Predict (MCP) % CIZEEMEM SO JRAMRANKE WV ERENEL 2 T O THEENPMLETT,

— Consideration of the deflection angle of the wind direction ——

[V Reference site ¥ Prediction site

Background turbulence intensity Ia IO. 1
—Peakfactor

Observation time T IGO s
Evaluation time t |3 s

ok | xevt |

<RUN> c 24

Ao R BEGEL - JRRA 7 7 A LV OEREFEITLET,
< Cancel > : B

: RROEME & HEE LRI IC R Y £,
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4. [Convert time series data...]
FEYER S o JRA W - JRGERSRS T — & & R m B R - B ER A TR~ L E T,

Ratio file |¥MASCOT_Samp‘es¥Tumna|_0ﬂ‘shore¥Lbrary¥CompareMPD¥CaseO 1¥extract_Site_result.csv [ﬂ View file...
[~ Time series file
Add... C:¥Users¥ . ¥Doc OT_Sampl al_Offshore¥Library¥AMeDAS_TS¥45147_1994.csv ~
C:¥Users¥ ¥ OT_Sampl ial_Offshore¥Library¥AMeDAS_TS¥45147_1995.csv
C:¥Users¥ . ¥D OT_Sampl ial_Offshore¥Library¥AMeDAS_TS¥45147_1996.csv
Delete C:¥Users¥ 4D OT_Sampl ial_Offshore¥Library¥AMeDAS_TS¥45147_1997.csv
C:¥Users¥ . ¥D OT_Sampl |_Offshore¥Library¥AMeDAS_TS¥45147_1998.csv
C:¥Users¥ s ¥D OT_Sampl |_Offshore¥Library¥AMeDAS_TS¥45147_1999.csv
Ci¥Users¥ - ¥D OT_Sampl ial_Offshore¥Library¥AMeDAS_TS¥45147_2000.csv
C:¥Users¥ «  ¥D OT_Sampl ial_Offshore¥Library¥AMeDAS_TS¥45147_2001.csv
C:¥Users¥ o ¥D IASCOT_Sampl ial_Offshore¥Library¥AMeDAS_TS¥45147_2002.csv )
. AT R at: XNV NAC TCYAR1AT N2 reu
View file...
Row
5 Last reading Extract row of column names
First reading I4
& Endoffle € Specified |-1 Row of column names |3
~Wind speed
Column of time series file  |-1 Column of ratio file |4 Lower limit (0.0 Upper limit |100.0
~Wind direction
Column of time series file |-1 Column of ratio file |5 Lower limit (0.0 Upper limit {360.0
Inflow wind direction column of ratio file 2 I Interpolation of the wind direction
[~Output file
Descriptior |Caseo 1
Output folder |C:¥Users¥ S ¥De IASCOT_Sampl ial_Offshore¥Library¥ConvertTimeSeries¥ |@
Header Case01_ Footer _conv
Import settings... RUN Close

[Ratio file] : [Tooll-[Create wind speed ratiol CYERL L 7= &\ MBI AR LL « JBERA T 7 A VEREL T,

Extract_Site_result.csv

1 . « Library » CompareMPD » Case01l v ¢ Case01D1&% »p
=E . FLLIAILE— = [ @
Jo Tutorial_Offshore  ~ £ " - H4Z
Ju Libi
B ‘@ extract_Site_result.csv Microsoft Excel .. 5K
1 AMeDAS_TS
1. CompareMPD
. Case01
\ case2
b test
b testl v < >
TPAILA(N): | extract_Site_result.csv v| | Wind speed ratio files (*.csv v|
o) | | #ma

[Time series file] AT O AR - JRGRRE R BT — & O Xk, HIFRE L ORGEEFHT —F DY A MaRRLET,
<Add>  BHITOJEIN - JBGERRSIT — X OBEFREITVET,

1 M « Library » AMeDAS_TS v| ¢ | | AMeDAS_TSo= P
=2y HFWIHLS- B~ @ @
L. AMeDAS TS A  Z& ’ B2 B4L A
1y CompareMPD \@ 45147_199%4.csv Microsoft Excel ... 2,71
1. CompositionTand 3 45147_1995.csv Microsoft Excel ... 2,64
1. ConvertTimeSeri £33 45147_1996.csv Microsoft Excel ... 2,64
1. PowerCurve 33 45147_1997.csv Microsoft Excel .. 2,64
1. Typhoon_DB 33 45147_1998.csv Microsoft Excel ... 2,63
1 WS_Ratio £33 45147_1999.csv Microsoft Excel ... 2,64y
4. WsSDB v < >
TPAIE(N): | 45147_1994.csv v| | Timeseries file(*.csv) v|
o) | | #ma

<Delete> : ZHITOJE N - FERERINT —F OHIERZITVNE T,

<View file...> : ik L7 i - EEHIERS|T —Z OFEM A TR LET,
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File lC:¥Users¥.¥Doq.|ments¥MASCOT _Samples¥Tutorial_Offshore¥Library¥AMeDA ]45 147_1997.csv

Column

>

(The display maximum is 10000 lines.)

@ Endoffle  Specified |52553 3;

Wind speed
’»Last reading é Column |7 l Lower limit I0.0 Upper limit I 100.0

Row EN

Wind direction
V' Extract row of column names écoﬂm I6 I Lower limit 10.0 Upper limit |360.0

D, ©. ® FEELET. FlaaTRLET,
<OK>%7 Vw7 35E, UTICKMINET,

Ratio file I¥MAsc01'_5amp|es¥1'umrial_oﬁsr]me¥Ln;rary¥cmawpo¥Caseo1¥extract_sma_res.ultcsv [ ﬂ View file...
[~ Time series file
Add... C:¥Users¥ . ¥Documents¥MASCOT_Samples¥Tutorial_Offshore¥Library¥AMeDAS_TS¥45147_1994.csv "~

C:¥Users¥  ¥Documents¥MASCOT _Samples¥Tutorial_Offshore¥Library¥AMeDAS_TS¥45147_1995.csv
C:¥Users¥  ¥Documents¥MASCOT _Samples¥Tutorial_Offshore¥Library¥AMeDAS_TS¥45147_1996.csv
Delete I C:¥Users¥  ¥Documents¥MASCOT_Samples¥Tutorial_Offshore¥Library¥AMeDAS_TS¥45147_1997.csv
C:¥Users¥  ¥Documents¥MASCOT_Samples¥Tutorial_Offshore¥Library¥AMeDAS_TS5¥45147_1998.csv
C:¥Users¥  ¥Documents¥MASCOT_Samples¥Tutorial_Offshore¥Library¥AMeDAS_TS¥45147_1999.csv

C:¥Users¥  ¥Documents¥MASCOT_Samples¥Tutorial_Offshore¥Library¥AMeDAS_TS¥45147_2000.csv

C:¥Users¥  ¥Documents¥MASCOT _Samples¥Tutorial_Offshore¥Library¥AMeDAS_TS5¥45147_2001.csv

C:¥Users¥ . ¥Documents¥MASCOT_Samples¥Tutorial_Offshore¥Library¥AMeDAS_TS¥45147_2002.csv
‘ o . ewo¥ d ¢

v Y. dreial v NAC TERAG1AT NN rev &
View file... | >
Row
Last readi v Extract row of column names
Firstreading |4 -
& Endoffile € Specified ]52563 Row of column names |3
[~ Wind speed 2

Column of time series file |7 Column of ratio file |4 Lower limit IO-O Upper limit |100.0

~Wind direction
Column of time series file |5 Column of ratio file |5 Lower limit  {0.0 Upper limit l350-0

Inflow wind direction column of ratio file [2 ™ Interpolation of the wind direction
~Output file

Descriptior ICaseOl

Output folder IC:¥Usefs¥- ¥Documents¥MASCOT_Samples¥Tutorial_Offshore¥Library¥ConvertTimeSeries¥ Gy

Header Icase01_ Footer _conv

Import settings... RUN Close

[Row] ST R - EGREESR ST — 2 1B S
WET
[First reading] JEAE - BEUEHE OB AA B MIT AR E LE T,
[Last reading] CJERE - BUEHE OB AARKE TITERE LE T,
[End of file] D RERINT — 2 DERHATE THAPAZFET,
[Specified] D RERENT — 2 OFRE LTATEE TRt A £7%,

[Extract row column names] : {TO%4 i LE,

[Row of column names] L OITRERRELET,
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[Wind speed] D REHE O AR A EE LT,
[Column of time series file]  : JEUREDH|Z45E L £,
[Column of ratio file] CREEOHEE LET,
[Lower limit] s EUHAE DA ZEIFH O TIRE AR E L £ 7,
[Upper limit] s BOEE DA PO _EIRMEZHRE L £,
[Wind direction] s R A E DA ZhEE & R E L E T,
[Column of time series file]  : JAFMEDH|Z45E L £7,
[Column of ratio file] DR AEOF AR E L ET,
[Lower limit] s R A E DA ZEIFH O TIRE AR E L £ 7,
[Upper limit] s BB O A P O _EIRME 2R E L E 9,

[Interpolation of the wind direction] : B A BIEGEL, BAIREA % © 0@ T EE & AV 5 2380 4 — R N F
LB AWE»EHELET,
[Interpolation of the wind direction] : A\ ZWNIFT 25 513F = v 7 2 AN ET,

I ety
A e —e EUIETHELERL I
gl | e WELTHEELEEL .
= e,
H >—-\—+———o
.
i aAa
ZEHTTEM
[Output file] AT FANDRIET A VERT 7 A NEDREEATVET,
[Description] CFRE LT FRN D 7 4 V2 LT O[Output folder] NI ERL S AL, VERE S 7= JEL ] B &L
I - JRERAE Y 7 A VB RIFESNET,
[Output folder] THRELE 7 VNI, EEED([Description] THE L 72 LD 7 4 )V 2 DMERL S 4,
VERL S Av7c Jm ) Bl EGE B - B AR AIE 7 7 A VMRS IV E T,
[Header] AR LI SUFFIN BT D 7 7 A V4 O SEFIAIN S v E T,
[Footer] AR LI SUFHIN BT D 7 7 A V4 DORBITAINES v E T,

<Import settings> : WE IR AR EGHL « BIERAME 7 7 A VA ER L TCBRICRESNTERET 7 A V&
FARIAIRE T, FRIE T 7 A MZE[Library¥ConvertTimeSeries] 7 + /L ZNIZLL T D 7

7TANLTRIFSHTOET,
Description_ConvertTimeSeries.min
<RUN> T A SR L £ T,
<Close> U5 s T TT G £ R
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5.

[AMeDAS data converter...]
T AXAF—BDF—F T p—~ v NEEHEL->>, MASCOT Offshore |ZH Y iAZFE T,

From CD-ROM...

From Foldet ...,

<From CD-ROM...> : 7 AXACD (CEFEM) HNoHHT288I08R L £1,
<From Folder > PCHRDO T 3 NVFEAERIEENT-T A X AT =2 b+ 584
(BRI L F 9,

[From CD-ROM...] &3&4R L7354 OB 4 LL FIZ#P L £,

Drive I Browse... LI
- Browse
Data folder |z¥ I
Index folder (idx¥) |Z:¥2003_2 |@|
Load I
~AMeDAS data information
Date Delete... | Select sites New... | Edit... I Delete... I
Year | Month | Folder [ Files | No. [ Site Name [steld [ &
2003 7 2003_2¥AM100307% 1318 1 FEug 11001
2003 8 2003_2¥AM100308% 1319 2 #2:8 1011
2003 9 2003_2¥AM100309¥% 1323 3 M 11016
2003 10 2003_2¥AM100310¥ 1479 4 1L 11046
2003 11 2003 2¥AM100311¥ 1520 5 JERER 1076
2003 12 2003_2¥AM100312¥ 1482 6 p=1l]] 11121
7 CliE 11151
8 2% 11176
9 HELRRI 11206
10 PRI 11276
1" LR 11291
12 HE 11316
13 Lalll 12011
14 BT 12041
15 E£F 12141
16 [l 12151
17 B 12181
18 FEELE 12216
19 T 12231
20 il 12261
21 g8 12266 <
29 FEERIE 192901
Output folder C¥lsers¥  ¥Documents¥MASCOT Samples¥Tutorial Offshore¥Library¥AMeDAS_TS¥ LJ

Convert ] Close I

[Drive] :CD-ROM K74 7HIBELET,
[Browse] (T AXAFT—=H LY A MERT 7 AL IDXyyyy.mm) ORIFIE T 45 BERESNE
¥ (%1)
[Data folder] T AP AT = Z ORI T NV ENERENET, BHF 1L CD-ROM K71 7 TT,
[Index folder(idx¥)] : ¥4 MMEH 7 7 (/L (IDXyyyy.mm) ORIFIET NV FRFRSET, @HITZAMN
FRENET,
<Load> NS CD-ROM RT A TNDT A X AT — B DRz Gt rirTr £,

[AMeDAS data information] : FtAIAENT-T A X AT — X EOIEREFR L, LHEEZIT B 1 F 2 @R L F
7, (3%2)

[Datal : CD-ROM [Tk SN TN\ DT A X 27— 2 O & ARlIcEK R LET, LHE1TO A%
BIRLET, 7740 FTREEABREIREE TR RSN ET,

[Select sites] A MERT 7 AV (IDXyyyy.mm) \ZFEl S 7B S4 & B SE S (54T 2
FRENET,
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[Output folder] : CD-ROM 0L HRVAATET — 2 OBRGFEHR 7 A VX e Frm LET,
WAFE 7 AV F LT O@EY T, AET DI LT TEEEA,
. BMASCOT Typhoon Priject Folder ¥Liblary¥AMeDAS_TS¥
WOIANIZET =2 D7 7 A VA TR AE S (BH) +F (FEE) T,

11111 _yyyy.csv

<Convert> T AFL AT — O B GABRMIREFITLUET,
<{Close> A A TICmm A CE T,

1 (M) RBEBIER X =000 [TAX 210 5ET—2 (csv B0 | O#EMEX, 2009 £y
ETTHKRTLTEY 90T, 2010 FLUEOKRSRT —#1E, LLFOFIETHERL TS0,
(@ 1#507—% QA1HMHI12A8LIHET) #1770 E LT, BEREHSF T r— LT
<TEEW,
(b) FYrm—FL7ECSVF—2E, AP RIEFEILOK L TR S TWETOT, Excel % T 16 iz
OHEAEIZZER LT ZE W, (23 0)
(0 T—HOATAHETIEIAL MITTOT, BT AL MTEERT ¥ ZRAMLTIZS0,
X2 W, T AL AT =5 CD-ROM O 7 4 L ZRERUTLLT O D T2, T<RITET & ITRR D1
KD CD BNEELET., T O A X [Drivel T [Browse] % 4R L, [Data folder] [Index

folder(idx¥)] 8% & L £ 7,
ENNT LDy ITERBE (44D ZwlITEE (F2HD) Z, mld

2. F4L 7B ZCTE
¥ BERLTLET,
README. TXT (S38RZ (Ch7 5 4)1,) ) n(ITOEQRRE (1) XIAEF (2) ZRY .
_MDI0.TXT (F—RT#—<wk o, yIABET, WG RODREY
COPRIGHT. TXT TG %
AMEDAS. TXT (7 AH R AT LORS) 199445, .. 4
1995%. .. 5
toowwwy on e e e e e e e e
1999%. .. 9
+AMD10yymn (7 A & 105 B —R) 2000%. .. A
Bymiiiii.CSV (10 MEQEEIT—2) 2001%. . . B
2002%. .. C
+-1DX
[DXyyyy.mm (ERBIPRIESR =7 7 L) m(ZAT, HSLROEY,
SIDNyyyy. mm (ERBIP1EFRE = 7 1 JL) iﬁ%ﬁ I
2H. .. 2
108. .. A
11H. B
12A. C
11137 A% S ES (547
AE
7; S21 0BT —R(I. ST TEHE (ED ONREQALTLELA,
fhoERliE. BalEs onElva CIERO FCHIRRELET,

Drive | Browse... LJ
Bffe——- e -
Data folder I [z¥ - Gyl |1
. I | %7 4 02 %5 |
Index folder (idx¥) |z Hid¥ =INL
____________________________ a4

[~ AMeDAS data information

Drive Browse.. ~| _ A [Browse] %3 _|
o TR =
Data fold 7 [ CO=ROM (2] — — — — — — -4 E]
Index ’ aler @

Load I

[~ AMeDAS data information
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6. [Divide the wind velocity according to the origin...]
Ja\a) - JRGE OB RIT — # & B R & ZFETEU BT TEARIRIZ B 1 2 ER KRG 2 U, ZRERUC L 2 B BRRHE 2 5
Hjl/iﬂ"o

Description ICaseO 1

MASCOT Typhoon or Offshore case
I [EtV] - EtV_Casel ;J
Site  |site =

Time series data Vview file... | Add... I Delete |

Filename | Folder I ~
Case01 45147 1995 conv.csv C:¥Users¥ . ¥Documents¥MASCOT _Samples¥Tutorial_Offshore¥Library¥...
Case0D1_45147_1996_conv.csv C:¥Users¥  ¥Documents¥MASCOT_Samples¥Tutorial_Offshore¥Library¥...
Case01_45147_1997_conv.csv C:¥Users¥ «  ¥Documents¥MASCOT_Samples¥Tutorial_Offshore¥Library¥...
Case01_45147_1998_conv.csv C:¥Users¥ « ¥Documents¥MASCOT_Samples¥Tutorial_Offshore¥Library¥...
Case01_45147_1999_conv.csv C:¥Users¥ « ¥Documents¥MASCOT_Samples¥Tutorial_Offshore¥Library¥...
Case01_45147_2000_conv.csv C:¥Users¥  ¥Documents¥MASCOT_Samples¥Tutorial_Offshore¥Library¥...
Case01_45147_2001_conv.csv C:¥Users¥  ¥Documents¥MASCOT_Samples¥Tutorial_Offshore¥Library¥...
Case01_45147_2002_conv.csv C:¥Users¥ - ¥Documents¥MASCOT_Samples¥Tutorial_Offshore¥Library¥...
Case01_45147_2003_conv.csv C:¥Users¥ « «¥Documents¥MASCOT_Samples¥Tutorial_Offshore¥Library¥...
Case01_45147_2004_conv.csv C:¥Users¥ « ¥Documents¥MASCOT_Samples¥Tutorial_Offshore¥Library¥...
Case01_45147_2005_conv.csv C:¥Users¥ « /¥Documents¥MASCOT_Samples¥Tutorial_Offshore¥Library¥...
Case01 45147 2006 conv.csv C:¥Users¥uu¥Documents¥MASCOT Samples¥Tutorial Offshore¥Library¥...

Column
Recurrence period |50 { Wind speed |7 Wind direction IS
Output folder
lC:¥Users¥.‘\¥Documents¥MASCOT _Samples¥Tutorial_Offshore¥Library¥CompositionTandS¥

Import settings...

[Description] HEE LT SLF AN D 7 4 L H LT D [Output folder] NICHERL S v, FEHTHS BAMBEE S L
\i j—o
[MASCOT Offshore Case] : MASCOT Offshore D7 —2 7 7 A L ZEE L E£T,

[Time series datal BRI A e KRG 2 b (9 % Ja ) - JEGEHIRE R 817 — & Ok Gk, HIlBRES K Ok 7 —
ZDY A baFRLET,
<View file...>  : AHESFR O - ERFRYIT — & OFM a2 TR LET,

File ]Case01_45147_1999_conv.csv lC:¥L. OT_Samples¥Tutorial_Offshore¥Library¥Convert ies¥Cast
1 = EBFTES AR,  EEMRC. IR, BEdLGD.. [BEd. SEGED.. BEGE
2 #45147 T FY FOY 35 .2 140 517
3 |ll== A B B el 5] BE barkE
4 | e oT oT o 1o -
5 1999 01 o1 00 20 0.0
6 1999 01 01 00 30 0.0
7 1999 01 01 00 40 0.0
8 1999 01 o1 00 50 0.0
3 (7)) 1898 01 01 01 00 0.0
10 1999 01 o1 01 10 0.0
11 1999 01 o1 01 20 0.0
12 1999 01 01 01 30 0.0
13 1999 01 o1 01 40 0.0
14 1999 01 o1 01 50 0.0
1< 1000 a1 n1 a an an bd
< >
e display maximum is 1000 lines.
Column of wind speed 7 I Column of wind direction 6 I il g
x| o
L <l

O FE~SETIIVNEER T,
QXHEIH 2T DL aAxAy MTITRY £,
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<Add> B RO LA - JBIRESR T — Z DR ATV ET,

1T 1. « ConvertTimeSeries » Case01

EE - FLWTAHILS—

| Tutorial_Offshore A ZE
. Library
1, AMeDAS_TS
.. CompareMPD
1. CompositionTand
.. ConvertTimeSeri
1. Case01
1. case02

-

‘@ Case01_45147_1995_conv.csv Microsoft Excel ...
£33 Case01_45147_1996_conv.csv Microsoft Excel ...
@ Case01_45147_1997_conv.csv Microsoft Excel ...
@ Case01_45147_1998_conv.csv Microsoft Excel ...
@ Case01_45147_1999_conv.csv Microsoft Excel ...
@ Case01_45147_2000_conv.csv Microsoft Excel ...

@ Case01_45147_2001_conv.csv Microsoft Excel ...
v <

TPAIE(N): [Case01_45147_1995_conv.csv v,! Timeseries file(*.csv)

[ @ || o |

<Delete > D ALBE G O JEL] - JEGERE R BT — Z OFIBREITVET,
[Recurrence period] BT AERMAEOFERBE ARE L £,
[Columnl] CJEGEME, RAEOGRRENTWAE LT AEEERELET,

[Convert AMeDAS] CULEE L 7= 7 A X AW RFNT — & 2 ALELS 5355 1 3R EME A,
T A K AWERYT — & Z[Convert Time series | T L /2R 5T — & 2 ALPE4 5 3
BITRREMB 25 E L T Z& N,

[Wind speed] CEEEOFIR SN TWD T T AEFEERELE T,
(BREMEAT, BREMB:11)
[Wind direction] CEAEOFIR SN TWD I T AFBERELE T,
(REfEA:6, FRAEMEB:13)
[Output folder] HRE L7 A AF IS, RO [Description] THE L 7= CFHN D 7 V& MERL S Hu.
AT R DR A SIVE T,

<Inport settings > : W EIZAIHE LIZRICRIFESNTZHRE T 7 A VA AABRET, RET 714 VT
[Library¥ CompositionTandS] 7 + LV ZNIZLLF D 7 7 A W4 TIRIFE N TV ET,

Description_DivideWindVelocity.min

<View > CFENTRER & U CEHIRUC X A E R RKEGEOIEFEEMER MK E R R L ET,
<RUN> s AT B I L E T,
< Close > CEREEFIEL, mMEmAACET,
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1.

[Composition of the tropical wind and the seasonal wind...]
HE L FHRIZ L DIRA RSB T 2F R KEEOFIRMGELRE LET,

Description |Case0 1

MASCOT Typhoon or Offshore case
| Etv] -Etv_caset ]

Site list Edit... Delete...

Site name | Tropical cyclone file ] Annual maximum wind speed file
Site Site_result_ymxV_S.txt .¥Case0 1¥ymax.dat

< >

Recurrence period Iso v Consideration of the uncertain— Detail l

[~ op

Output folder ]C:¥Users¥'¥Documents¥MASCOT _Samples¥Tutorial_Offshore¥Library¥CompositionTandS¥

Import settings... View MCS... | View MCP... Run

[Description]  : f87E L7=3CFHD 7 4 /L Z BLLT O [Output folder] WIZIERL XL, AT R BZRTE I ET,

[MASCOT Offshore Case file(CaseData.min)] : MASCOT Offshore ® % — % 7 7 £ /L{(CaseData.min) Z 5 & L %
T, r— A7 7 A VX MASCOT Offshore D7 2y =7 N7 A VA WNIBRIFES N THET,
[MASCOT Offshore 7' &= 7 k7 4 /L % ¥ Project¥ EtV¥CASENAME¥

<Load> 3R L 7= MASCOT Offshore @7 — A7 7 A i(CaseData.min) DA MMEH L HES I =
L=y a U b e BRI K 2 FRKIBGEE 7 7 A V&Gt iA B £ T,
[Site list] ¢ BRI IR f KRG 2 Fft HH 9 2 Jal i)« JRUS RS R 517 — & Dk, BRI K OVRERE AT —F D
VA MEFRLET,
<Edit> : <Load> CTHAAATZY A MECFFHIBUZ K D FERKEEH Y 7 A LV ERELET,

Site name IS“E

Tropical cycone file lSite_resuIt_yme_S.b(t

Annual maximum wind speed file
(ymax.dat)

l ments¥MASCOT_Samples¥Tutorial_Offshore¥Library¥CompositionTandS¥Case0 1¥ymax.dat| ©.

oK | el |

< Delete > A FEHIBRLETS,

<View > CEE, FER, BERKEIC L DFRKEEOIFBIREESMER R LET,
[Recurrence period] CHEHT 2 ERMAEOREMARE L9,
[Consideration of the uncertainty] : ME B O A HEEMEIZIS T 5 AR OBNER DR B L EEBTH0ENEREL
7
[op] : HIE RO D R AR SEMEIC B 1T D KUEDBUIFER OB 2 BT D ENEEELET,

AHERRIZT LTI NAR Y I 2 b —3 a3 VL L ARERICOBRR S UE T,
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I

[Output folder] HRE LT A VNI, ERRo[Description] THRE L7ZXXFHN 0D 7 4 )V X 0MER S, 7T
FERPRIESNET,

<Import settings > IR BITAERE LT BRI R SN E T 7 A NV E A B E T, BRET 7 A V1T
[Library¥CompositionTandS] 7 4+ /L % NIZLL T D 7 7 A V4 CHRIFENTHNE T,

Description_CompositionCyclone.min

<Detail > - TR S G R v B0 A R D PR B A SRk ) 0 oD U RGP 2 F 2 L 9

[~ Design target direction of the wind

Moving average range Um | 1.0 m/s

[Design target direction of the wind] AN & 7 D A BRI E o JRE R
[wind speed range] JEGEFPE (57 4L ME Um=1.0m/s = Ur+0.5m/s)

1
0, =NZ 0,

N : Ug + 0.5m/sDF — & {H%k

<View MCS> : BV T hA v Y alb—a il & 5B ROFERKIEZ AV REG IR X 5 R KR
EOHHBMER AT & FoR LE T,
FRATHL S AR D V) | EAATHLSEAS 1 BHEICILE S 72 VAR — D27 v i L&
F, = TENE € 22V s AEICE VTR ET, VG TSR, SE, &
RO 3 MOERKNEHOEBBMRNMXNE 1 MK ICEREX LET,

[ALL ~| i 2 R EE O RRIK 2RI B - L A TE E T (it A1),
(KRUN>FEFT) BICETRLTLIEE N,

[ALL -
Tropical Cyclone

Extratropical Cyclone
Combined Cyclone

soic. Bl ns vy da o k0 BEEECIRE L BT B 5 R R om0
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KeForLEY, ZREBELITO®Y T,

[site namel] : fRAT HLE A R

[Uc] DRE RIS T 5 R

[6d] : HRAT R G L 1)

[UT] c RIS KD (RiEEMEOBE LA E LIz%E813 oUT, oPT 2% )
[UE] DA LD EE (REEEMEDOBE AR L LT235E1L oE 25 8)

[oC] DIRARIAIC X D B DR %]

[oUT] DRI KD EGHOEERE (R OB L D) [

[oPT] DRI KD EUE O R E (KE OB X 58 [kl

[cUE] D FEEUC K D EUE O ERZE [%]

[al D EGHEORERER ISR T B IR o EALEE K]

BRI RSV Z B8 L2358 D3R

Clipboard copy Export csv file... l

Site name | uc | 8d |ur | uE | o | out
Site 48.54 186.68 48.54 35.27 0.39 0.39

<View MCP> : MCP i (fRBE) (T X % B BOAER RJRE 2 7o IR A KRNI & 2 455 R B 00 3 8 i e
ROMEE TR LET,
FEAT H R AEER B 0 | RARATHLSAS 1B UL E S 22 WA IR — IS T v i L
ET,N—UEVIE € 22U v s A EICL VAT E T, W IR, B,
RAKGED 3 MOFERKEHOHEBBIERIMXE 1 SOV T 7ICEHAEE LET,

[ALL ~| - 2 R R O RRIK 2RI B - L M TE E T (Fit ).,
(KRUN>FEFT) BICETRLTLIEE N,

[ALL -

Tropical Cyclone
Extratropical Cyclone
Combined Cyclone

soic, B Ry ars) o Eic ko, BEmE cEE L EELIIC I 2 R O R o —
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RREFRLET, RHBBLTO®Y T,

[site namel] : fRAT HLE A R

[Uc] DRE RIS T 5 R

[6dl : HRAT R G L 1)
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[About MASCOT Offshore...]
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@ MASCOT Offshore, Version 1.2f (1.2.0606)

.
(C) Aquatic Zone Network Co.,LTD. All rights reserved.
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| RE DS AR A B L C BT FoREARE LET, SHIC, BIRKIY I 2 b—a v L VRO 7R
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HaFFo LUE L, RENTRT L OISR RIT Vg OEEIT 0 & LE LT,

R
(F) = pe +Ap exp(—ij @
2
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ZIZT, p(NIFEErIZBITLIKE, polTPOLXE, ApIFFOKER TR, R, TR RKEMERE R, ridam
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. FIRa VAU RT AL p i 3EETT,
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B RHEICONWTIRARE T,

—HRHLEE o - EEOFEILAR D 2T X 0 HE SN RIB OIS £ 0 BIE LE L, BRSO
KREBERBAOREN A Up ¢ (2) & RRS O ¢ (2)IX%RIC L0 RO ET

Ur e (Hy ) =g (Hy /2, )™ Uy = V2 +V3 (4.10)

0, - (H) =0, +0, (1L0-0.4(H,/z,))" . 6,=0 (4.11)

TITT Ug & Oy I3ERGE & A 2R L, BROBEIE & HIZEL TS, Hy 3T @E, g 3R &
o, FEEORE M AR T RERR, O, (TEERE S L HEREICB T HRAFES T, Zhbo/RT A—2 3
KEHER 7o . MEXHRE ;| IMEOFE—EMEZ KT RTA—F EEEMRT A —HR,, Z W TUTDO LI

RDDHZENTEET,
a, =0.27+0.09l0g 7, +0.018(log z, )’ +0.0016(log 7, )’ (4.12)
\") -
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A

6, =(69+100¢)(logRy, ) " (4.14)
V

R,, = =2 (4.15)

(o) f/1 ZO

6V v 0.5 v 05

fi:(ﬂjLﬁJrfj [ ﬂ+fJ (4.16)
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AREITH, [URFRITICE > T, BRI 2 b—y 3 > L0 HEE L72 PP O —FHE Lo am - EuE % ZE Lo
JEVA - JEGE A~ & BT D TR OV TR E T,

JRTE) + JRGH 2 254 5 72w o AR A & R b A R D B 7260 FERIEIRDL T I 7L MASCOT % fiv CEMIE Eo
S & MY EOKT T L E 3, B EOKRIT (X - 4.5a)) Tid, ERHEDOHIZS L OHHIFIH %2
FIREZRBR Y FEMICAFEL L, BB 16 B O 24TV E T, ZORER, AR « BRIk LT, gHRic s
2 EGH - JBM AR E 2, ARMEE (224006, u,) LB RMICI T 2 mmEE (ZhEh, . uy) O
R LV JAFE Dy 35 X OV Cp & LTHRIARNICKRD 5 (R(4.18)4.19), = ZTDy B LVCy i3, A
A 6, DBt E L TRLTWET,

CIR (9| ) = UR/UI (4.18)
D (9| )= HR _6’| (4.19)
a)E s Uy O b) T 1H H#h 5

rﬁ NIESE ||

A
NIgs >

u
y

NIE
FAME i FAME

X - 4.5 EHFE L L FHHE FI2BT 5K OERK

MY ORI (K- 4.5b)) 12O\ T H RERICKIINT 217, B BB DA RE u, &%
*HGH AT 1T B SR U DA RS Cp & LCHIINT 5. THHIE LKA OB, B o St S 2 AT b O
A TH R WRITBEIR A4 3 E L 7o 556 113 R LRI 38 1 2 TG U WA RMIIRFEE T —ETH 5720,
Cp IFIAJEM 6, DBt L 13720 A (K4.20)),

SEH A | O SRR TITE R I R RIC BT M 6 1. B EMERICK T AMARMR G, LRLUTY (K
(4.21)),

Cr =U: /U, (4.20)
0. =6, (4.21)

K(4.18) B L UK(A.200 6 u, Z#HELERT 5 &R(4.22) &7 £,

XUg (4.22)

Ug = Cr(6) xUg (4.23)
Cir
QR =Dy (HF)"'QF (4.24)
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M Flcs T pEMEE (ZRENG . u) E. EHE EORMEE (ZAENL0, . Uy) IKEBTELZ L
HE. AR (D) LI (Cp/Cp) %#3(4.25)4.26)0 % 51K+ = LN TE T,

C..(0.) = Snl) (4.25)
Ce
Dr: (QF )= D (HF) (4.26)

- 4.6 [IEARFEIC L0 ROTFHMIE | & EHE RId T 5 R I K ORI R A O BUn 28 kX AR L E
D

2.0 . . . | | T T 10.0
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X - 4.6 KHEHTO KV RO EELE X ORERA O RFZEL

F7-, (4.25)(4.26) % HX(4.23) (4.2 RANT 5 L K(4.27)(4.28) %15 5,
Ug = Cpe (6-) x U, (4.27)
0z =D (6:) + 6 (4.28)

A ffR7E (Dg) BEOEGL (Co) 1, “FHM FiICBIT 2 EM 6, (=FRARME, ) 1B LT 16 f# (16 Ja
M) OEERBIZRERE UCGIHME L £ Lz, Fo, BRET MK > THE L FHM Lo m miE 2 FZi Lo
R\ G L2 ZE S B U1, B RE T K o T B B A 16 IS A L, 352435 A O A7 7% ( Deg )
BLOWE (Copr) ZFIALET,

K(4.270@.28)DETOERIINT E S B LORRINT =2 D H 2 2 L 27T Hy 8L Ut & BEERTR
ZFT Z2MT5 kDX HICETENTEET,

uT,R(Hh’t):CFR(GT,F(Hh't))uT,F(Hh7t) (4.29)

HT,R (Hh ,t) = DFR (HT,F (Hh ,t)) + HT,F (Hh’t) (4.30)
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JRGH DEBERIL DR KME 2 B FH AV 2R S LCRVWE T, 2o FEIHEROMRmARE L ORRE S L
TWRNZ8 | AR TIlAR 2 5RO B R 2 BT 2 Fik & il L CORICZ M OFHIE & 72 0 | BRI iE K
LR BREN S Y 3, WEOHBBEITRAIC X > CTRR D720, BB OHIZIC L 2 5 EE O R D
BRMEZF AL Z L0 T LHABMTIIH Y TH A,

TN OMBEE R DD, 4G - AR N K o TRE SN HIBIZ X 2 P RGE OB IR 5 E Fik 4
WET,

B - 47ICEFERYI2b—va r X0 ROFEEEERMAICBIT 27 /S TOREME E (5f)) BXO
EHY b (ER) OER KRB O @R i 2~ L ET

HIRAC & 5 TR EEOFIBIRE E,, (H, ) IXEHIE LICHB1 5 50 FEREBIEHE Uy (H,) & FHHIE EickiT 5
50$ﬁﬁ%ﬁﬁum4H)@%&Lfﬂ@gnziDXW5_kmf%i¢oﬁ%\ﬂ%:iéﬁﬁﬂk I
REUZ 1T OBAIZ L E LET,

Ev (6,) =max| Ug, (H,)/Usor (H,), 1.0 (4.31)

ZIT, O, 1T U (H) IR T 2mATh D, F7o, HIC K2 EBEHEOHM ERFUIT(4.3212 L v ke £
75
E.(6;) = GSO(Hh)/O-SOF (Hy) (4.32)

o (H,) HIBE RIS 0, 1251 % EHIY_EOREAT 6 & DRSO EHREOEAERE, oy (H,) 13F
HHIY bR &4 5 B 1 0 25 B O R (55 T

S5I, WA X B ELNRE D MR E, (6,) 1EHIUIC X 5 BBEE O ERIK Eg(6,) & M X % FHE
HEOFIEI E, (6,) P& LTRASDICL 0k E T, Ads, M LB ELNREDHIERK E, (6,) 13 1L
FOHAITL L LET,

E.(6,) = maX[EtS (6; )/Etv (%) :1-0] (4.33)

HRA e G2 Ja\ M) Oy 13 B £ 0.6m/s o EUHFEIR 2 361) 5 A 2 sk ed . MRADS G & LET 9,
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E
e
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B
K
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g 20
— Hini
10 - BERAM (5 :
2 5 10 20 50 100
[ [ | | |
0 1 1 1 1 1 1
-2 -1 0 1 2 3 4 5

HEEH-InCIn(F))

B - 4.7 SFHHE L EHE O BRI X 5 FEEREEDFHEBEBERSAR OF

(2) &EHEED

1t

ANT S ICBIT BB & 2 FHREOEBIEE E, (H,) & T L et 5 HUSIC 31 5 I o i M T

(RBE,, % BRIV, 127 U T, B EHAD AT 8 S0 2R EHREU, 243510 & 0 R,
U, =Ey (ed)'Epv Vo (4.35)

T 2T, FHEL B D HLRITIS U D PG O R AR IEAR S E ), 133(4.36) I L WSRO E T,

17[ij Z,<H, <Z,
ZG
Ewv = } (4.36)
17| %) H, <Z,
Zs)

ST HEATESMITHY . Z,. Zg. o WRHEORENERT ST A— 5 T,

(3) EhREDFE
NT B EITBT B EIRE DO BISF RS |, OFIE, W L 2728 5 M 57 B S TORNME |

\ZHIE I K D ELAVIREE ORI IERRELE, (0,) 2R Licbo & L, RU3NDT LV KD ET,
Iy =E, (6,)- Ip (4.37)

TR L BT D HURICE T DT | & TORASRE || 13043812 LV R £,

—-a-0.05
0.1{2—“] Z, <H, <Z,
= ¢ (4.38)

p Z —a-0.05
0.1(—*’] H, <Z,
ZG

ZZT, Hign7@mEmTho, Z,. Zy. a ZEEOHEDMERT/NT A—4TT,

3
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$5E Data Format (F—42224+—< v k)

AFETIZ, MASCOT Offshore (1757 =% 74—~ v MIOWTHPIL £,

BB TE Data FOrmat (T 4 7 4 =0 % B) oottt ettt ettt ettt ettt ettt ere s 5-1
5-1. MASCOT OffShOTe 7 7 A JL 7 =0 5 B oottt ettt et e e e etee e et e et e e eaeeeetreeeraeeeane s 52
511, BJAT —Z XA (FITVIDIERE) oottt s s s ens s eaennenaas 5-2
5-1-2. BB NT A =2 T 7 AL (F20ULLSID]) .o 5-3
5-1-3. s A B K OHBIGRE R & F O FBEE B RS T A —4% 7 7 A )L (correllSIDI ) ...ccoovvvviienicieann. 5-4
5-1-4. FBERICBITDERMANT A =2 7 7 A (dprmISIDIAKE) oo 5-5
5-1-5. ERIRKEGE 7 7 A /b ([CaseNamel_result_ yIXVIEXE) ...ocooveeeieeeeeeeeeeeeeee et 5-6
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o-1.

MASCOT Offshore 2 74 I T+ —=< v k

AHiTlL. Mascot Offshore T 5> 7 7 A LD T —~ v MTOWTHRLET,

5-1-1.

HoO—EERLET,

BRAT—2R—X (y[ TYID] txt)
BEEDOR B STA—ZRERG T 7 AL TT, K- 5. UIIERET —F =277V OFERL, - 5. UIIFTFLIRS N TODHE

B y7207 txt — JTE g@@|
FrrE) HREE) IO FTOM ALHH)
72, 70,3189, 7, 5,21, 1,27, #
7, 5,21.0, 9.00,150.00,1008.00, -1.00, -1.00, O0.00, 0.0
7,5,21.2, 9.00,150.00,1008.00, -1.00, -1.00, O0.00, 0.0
7,5,21.3, 9.00,150.00,1007.99, -1.00, -1.00, 0.00, 0.0
7,005,215, 9.01,149.99,1007.97, -1.00, -1.00, 3.12, 134.6
7,5,21.7, 9.01,149.99,1007.95, -1.00, -1.00, 2.34, 134.6
7,05,21.8, 9.01,149.98,1007.92, -1.00, -1.00, 3.19, 153.1
T,05,22.0, 9.02,148.98,1007.89, -1.00, -1.00, 3.76, 134.6
T,05,22.2, 9.03,1498.97,1007.85, -1.00, -1.00, 4.%6, 134.6
T,05,22.3, 9.04,148.96,1007.81, -1.00, -1.00, h.16, 134.6
T,05,22.05, 9.05,148.95,1007.76, -1.00, -1.00, hH.63, 134.6
7,005,227, 9.06,148.94,1007.71,  -1.00, -1.00, 6.00, 134.6
7,05,22.8, 9.07,148.93,1007.66, -1.00, -1.00, 6.31, 134.6
7,05,23.0, 9.08,148.91,1007.60, -1.00, -1.00, V.01, 138.0
T,05,23.2, 9.08,148.90,1007.%4, -1.00, -1.00, V.19, 137.6
T,05,23.3, 9.10,1498.88,1007.48, -1.00, -1.00, V.73, 139.8
7, 0,230, 9.12,149.87,1007.41,  -1.00, -1.00, 8.20, 136.9
7,005,237, 9.13,148.85,1007.34,  -1.00, -1.00, &.61, 138.7
T,05,23.8, 9.15,148.84,1007.27, -1.00, -1.00, §&.98, 136.5
7,6, 0.0, 9.16,148.82,1007.20, -1.00, -1.00, 9.30, 138.0
B- 5.1 ylTYIDIDH
%£-5.1 ylTYIDIicEERENDEHNO—FE
1T7&R | JIFE= el B Al
1 YY B R EFEOFEE T 2 #7 B
2 ID HRES L g
3 N T4 L
4 SM AR A A B
5 SD HIEFE A A L
6 SH RS A R L
7 EM B ETE A B
8 ED R TEB A L
9 EH 5 JE T Ly
2 1 MM A B
2 DD H L g
3 HH | E¥
4 CN FEEE (B, N+,S:—) FeK
5 CE R (B, Er+W:—) E¥
6 PC HL 5 (hPa) E¥
7 DP LSRR T & (hPa) FeK
8 RM Fie KT SR =% (Km) E¥
9 C B PRI R HES T8 (mifs) E¥
10 DIR I BT AT 1A (FE, 3 B D S IRt EI oD 4 i) £y
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5-1-2.

REBEB B/NTA—ET774 I (y2out[ SID])
BT —Z R =2 LT i BEERFIC BT D RE T A—Z T 7 A TF, - 5.2 T EL R ST A—
TrANOFIERL, - 52T RSN TWBEHO—EERLET,
B y2out[SID].txt - AE ¥ i - <
FrE REE B0 FTl0 AJLHH
wyid,mm,dd.bh, cn,ce,pc,dp, rm, e, dir, de min, dde, drm, dec, 43 [~]
6104, 5,27, 4.2, 23.46,121.38, 980.00, 5H2.78, 194.28, 25.57, 92.40,-422.76,-100.000,-100.000,  0.000, 42
6108, 7,13, 9.0, 21.40,122.50, 985.00, ~-1.00, -1.00, 11.83, 142.90,-471.10,-100.000,-100.000,  0.000, 43
6113, &, 7,14.7, 23.75,121.42, 979.63, -1.00, -1.00, 18.80, 102.60,-408.34,-100.000,-100.000,  0.000, 44
6116, 8,25, 2.2, 21.88,121.83, 950.00, B0.22, 69.71, 18.20, 132.10,-493.09,-100.000,-100.000,  0.000, 45
6118, 9,14,16.3, 24.85,125.80, 905.68, 108.49, 86.06, 28.04, 96.20, 355.99,-100.000,-100.000,  0.000, 46
6120, 9,11,16.8, 23.70,125.27, 912,77, 95.72, 41.84, 29.57, 179.80,-120.76,-100.000,-100.000,  0.000, 47
6122, 9,27,23.5, 21.66,125.46, 980.00, 33.25, 194,63, 34.29,-177.70,-347.14,-100.000,  0.000,  0.000, 48
£123,10, 3, 9.5, 26.51,125.61, 940.00, 74.46, 85.47, 16.77, 172,10, 193.37,-100.000,  0.000, 0.000, 49
6203, 5,21, 1.8, 22.25,128.77, 980.89, ~-1.00, -1.00, 31.23, 55,10, 454.08,-100.000,-100.000,  0.000, &0
6205, 7, 9,11.2, 25.49,126.48, 985,00, -1.00, -1.00, 24.87, 125,60, 143.78,-100.000,-100.000,  0.000, &1
6206, 7,23, 5.2, 24.53,121.33, 977,17, 29.31, 133.75, 31.30, 93.10,-400.70,-100.000,-100.000,  0.000, 52
6209, 7,31,21.58, 25.44,126.70, 969.88, 41.26, 176.42, 21.64, 126.10, 160.37,-100.000,  0.000,  0.000, &3
6210, 8, 5,20.3, 23.46,122.38, 909.14, 100.75, 45.29, 25,81, 101.40,-329.41,-100.000,-100.000,  0.000, 54
6213, 8,19, 3.7, 24.74,126.11, 975.30, -1.00, ~-1.00, 27.1%, 8G.40, 84.24,-100.000,-100.000, 0.000, &b
6217, 9, b, 4.7, 23.03,122.91, 940.00, 68.90, 77.71, 26.26, 128.70,-310.10,-100.000,-100.000,  0.000, 56
£221,10, 2, 9.8, 20.69,125.60, 955.00, 5H7.29, 90.37, 24.26,-174.80,-455.22,-100.000,  0.000,  0.000, &7
£228,11,15,14.8, 23.46,1258.78, 934.06, 89.57, 101.26, 30.90, 76.60, 385.14,-100.000,-100.000,  0.000, 58
6304, 6,18, 8.7, 24.83,125.34, 960.00, 55.93, 85.35, 24.78, 113,30, 7.59,-100.000,-100.000,  0.000, 59
6307, 7,16, .0, 22.96,122.80, 936.71, 77.85, 57.58, 2b.64, 127.00,-323.73,-100.000,  0.000, 0.000, 60
6314, 9,10,19.0, 24.19,124.83, 921.74, 90.19, &7.29, 16.54, 143,80, -80.%56, 0.000,-100.000,  0.000, &1 ]
11715
X-5.2  y2outlSIDI D]
#-5.2 youtlSIDlICT R EN B EHHO—E
1185 | IIES EEA4 B 7l
1 1~15 217 B PRI RRi S A B E O 3
16 im Rm & drm O F N5 —7 57 TlIRWBE R, MARDTT—757 o
IZENZEh, [-1.0]&[-100.000] =
2 1 yyid B RS L
2 mm FeHEr A FiSg
3 dd FepEi A K
4 hh B HET i (hour) FEH
5 cn FEJE(N:+,S:—) FE
6 ce TR (B, W:—) FEH
7 pc e BT R DR FH
8 dp TR ORI T & FH
9 rm B AT I Fe K e e R ek 12 K
10 cc I BRI R A T FH
11 dir I BRI RS T J7 1) FH
12 dx_min T BT R EE2
13 ddp BRI IR 6 BEfEoD dp 75F =2 (1hPa LA _EiZ—5—[-100.0]) %4
14 drm TR 6 RFfRID rm 225 =7 (1km LL_RiE=7—[-100.0]) FEK
15 dec FHET IR 6 RER O cc 25T =7 (Im/s LA ki3 = —[-100.0]) =2
16 N R B
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5-1-3. MBS IUHBRBEEEROREREE R/ ASA—2TF7A Il (correllSID] * )

AT DI BET /RT A—2T7 7 AL (y2out[SID]) BB BT A—F R E CE B BOLEMH L7 7L T1, K- 5.3121%
A Bk X OB B E ER ORI B RNT X —& 7 7 4 L OflERL, - 5.3121F

FLMSNTWDEHO—EERL

*7,
B correl64B.txt - A FIE E
ZrfIWE REE FINO FTW ANIH)
de rm cc dir o min
1.809896231 2.243236042 1.985606074 154,60 -394.05
1.627979994 1.958802700 1.769525051 137.90  -7.99
1.728191376 1.8375H20368 1.243781924 191.70 14217
1.566319585 2.253895044 1.661528707 144,200 199.47
1.547651649 2.286927700 1.946599603 122.40 -273.43
1.430880904 2.143451929 1.954430468 137.40 -23.82
1.635983137 2.121936389 1.887673497 152,90 -423.73
1.669595718 2.212533951 1.914660454 152.40 -241.88
1.669130802 2.101781368 2.023663998 128.40 296.68
1.591954589 2.269839764 1.800579667 138.60  83.58
1.587935328 1.952598510 1.112269759 140,50 232,35
1.649724126 2.210826635 1.629307628 134.50 -197.67
1.586699543 1.829946637 1.393575191 247.90 -453.91
1.655297658 1.899601693 1.166430116 160,40 372.51
1.465977311 2.396687508 1.784260631 169.30 -305.90
1.509605765 2117470264 1.941461682 132.00 212,08
17 15
X- 5.8 correllSIDl.txt DF]
#-5.3 correllSIDI.txt 2R EN B EHDO—E
1185 | IIES B4 B Al
1 1~5 247 H BRI Al SN LB O Pt
2 1 dp BT/ 8 A—4 log(dp) (hPa) FH
2 rm A/ 3T A—4 :log(rm) (km) S
3 cc a8 A—4 :log(cc) (M/s) FEH
4 dir BB ST A= 1dir () EH
5 dmin BT/ 8T A—4 :dmin (km) Eey
3~ 1~5 (dp,rm,cc,dir,dmin) DIRE, & BHIESN- B REL ) Riad Fetx
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5-1-4.

REERIZEITEER/INGA—2T7 AL (dprm[ S/D].txt)

B

1t

EHOEEOBENT A —F ORI, BErThray Ial—i g 0l k) A THICHEA SE7-RE/8T 2

—F 77 ANTY, K- 5. 4IMARERICBIT OB R RTA—EZT7 7 AL OHlZIRL, - 5.41T1

ALET,
B dprma64B.ixt - AT ¥ nfi=f><|
B REE B0 FTW ATH
1.447157979 2.452754259 1.685050011 1.481870300  -0.762599707 ]
1.636857312 1.761244893 1.963505007 1.525303364  -1.019697309 b |
1.774634242 1.886928082 1.451792836 1.994878031  -0.415521562
1.447157979 2.372326374 1.943839312 1.392047024  -0,280815959
1.579796672 2.376841068 2.010619402 0.950777531 0.083365381
1.657273769 2.352661133 1.913528515 1.663447022  -0.597893536
1.479808807 2.248568035 1.686475398 1.300703878 0.514052629
1707171679 2.086342335 1.580173261 1.548241735 1.250000000
1.519712329 2.156241655 1.430875897 1.407061696  -0.192691043
1.644890785 1.865648985 2242467403 1.087234974  -0.519675314
1.539054036 2.103730447 1.108007471 1.679790854 0.285431862
1.447157979 1.749854088 1.315089293 1.499390244 0.164460182
1.773464799 2.184417436 1.897906899 1.767054796  -0.440407753
1.679627112 2.434323788 1.807075739 1.432320080 0.474133501
1.660994857  1.912610054  1.571809888  1.032834888  -0.272617552
1 ARRTREATN 1 RTARTIRAS 1 RATORRATA 1 290RORRRA - 9122NR7Q
- 5.4 dprmalSID].txt OH)
#-5.4 dprmalSIDl.txt IZFERENHEHDO—&
1T&S | HIES T4 B! it
1 1 dp BT/ 37 A—4 :log(dp) (hPa) F
2 rm BBt /85 A—4 :log(rm) (km) FEH
3 cc BT 3T A—4 :log(cc) (m/s) FE
4 dir BT/ T A—4 1 dir/100 (J£) FE
5 dmin BT /3T A—4 :dmin/400 (km) FH
2~ 1~5 (dp,rm,cc,dir,dmin) DA, N THNCHAE LBl 6 m g sy sk FH
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5-1-5. FEREKEFEI7AIL ([ CaseName]_result_ymxV.txt)

BREET LY EE L2 BEEOR RS X0 i Lo ko E2EREB X O ERT —% 7 7 4 T, K- 5512134
BREGET 7 AV DA RL, F- 55T REN TOWAEE D —EE2 R LET,

Vi E¥typhoon_n¥part5¥calug¥020 666¥090907 01 666 01 12 3m P10¥us666 I 12 3m r0140_P10_ymxV. txt — WZ PROGRAM EDITOR

FIKE REE BERE FRA FAD WO D I ALTTH)
DeEES Q hal I A
10 20 30 40 50 &0 70 a0 a0 100 110 120 [E1]

1 ymxeg  ymxedir  ymxghve ymxghve d ¥iK ymxdir yimkhve ynxfivedir]  con_ymx conymxdir conymxfive conymxd d Peakd A~

2 18.82 211.16 73.68 213.46 3.76 154.52 10.83 186.96 11.29 194.82 14.33 206.77 20.244

3 40.58 142.45 55.81 154.72 20.67 112.57 28.42 125.85 27.83 96. 46 35.88 125.85 50.684

4 24.98 162.07 31.13 26.25 12.86 131.53 15.28 359.32 16.00 128.97 18.04 121.58 25.48.1

5 36.07 193.01 48.74 200.94 16.55 165.23 22.14 173.75 20.03 178.28 27.058 173.75 38.214

B 45.53 177.48 53.09 185.83 22.18 149.15 25.83 157.80 26.65 136.77 30.49 141.10 43.064

7 23.56 42.14 31.96 5.49 11.28 15.71 14.60 338.12 12.58 B7.18 14.47 67.27 21.154

3 38.99 ?55.23 52.25 272.40 20.94 225.68 27.87 243.38 31.83 225.59 42.30 243.38 53.75.

9 21.62 33.85 26.58 12.48 10.70 4.88 12.97 16.32 3.65 B8.00 11.80 77.258 16.391

10 11.64 £1.98 14.03 61.08 5.64 36.19 6.65 35.34 G.74 64.66 7.42 54.68 10.49.

11 14.28 78.83 17.24 75.74 7.03 49.87 3.4 47.21 9.60 67.94 10.48 70.98 14.804

12 35.4 225.2%2 43.36 198.85 16.27 1495.02 20.49 59.29 22.37 216.75 26.63 214.49 37.614

13 25.47 176.35 35.51 185.75 12.24 146.01 17.08 156.97 14.85 134.85 19.48 156.97 27.514

14 5.86 20.36 11.53 33.86 4.50 352.98 5.70 G.65 2.89 337.69 3.36 336.97 4.751

15 15.97 An.88 PRPR 79,149 9.27 4.3R 11.53 | 7.537 AL 7.R4 44,137 11.N0R7L v
£ >
1131 HwA

M-5.5 FHIFERERET7ANDH

#-5.5 FRBRKERZ7ANVICEEREINI2EHEO—&E

1%5 | HI&S I B it
1 1~13 21T H DRI RE R S o A 78] L
2 1 ymxg ABLEE J T (m/s) FEH
2 ymxgdir B TR [ () e
3 ymxgAve A4 b IR A T A0 R RS (ms) [BRAE DR CI: ymixg & [R1ii] FH
4 ymxgAve_d P bR A 1 2% {52 JRL R [ () [BRAE ORI T ymixg & [RIE] K
5 ymx IR bR (m/s) FK
6 ymxdir SEH R E R A () Fe
7 ymxAve LA LR A IE A% LR bR (m/s) FK
8 ymxAvedir I RS R 10 LM |- L) () FEH
9 con_ymx FEHAZ - EGE (m/s) FEH
10 conymxdir FEHE R A () K
11 conymxAve P RER A 1 4 SE M B JRGEE (mifs) =ty
12 conymxA_d S IR R AT A% SR L) () FH
13 Peak [ B K L3 [conymxAve X sqrt(GF)] (m/s) K
3 1~13 LIRE, 247 B LRI A E O A f R B2 8 $ps e ik
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#6E Reference (BEXiR)

1)

2)

3)

4)

5)

dom, WHIER, BE—F, PO RKESE IR 5mEORELSMEE 202 |EARORE, BARELS
2k, #6675, TR 8F1A

LRE, BEAKRL, FarF—Uary, EHFE=, AR 2 lb—a OO ORAHN SR L ETRERE
BUEORZE, H18[FH MIFY ATy LA (2004)

R R, AJEE, AR R AR & M O SRR A B8 L 7 BB R ORI A ORE, 5 21 [\
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I BEOATIERECE (T3 RADNES IS
E02 BEBOEE
Characteristics of the vertical wind profile in neutrally atmospheric boundary layers

Part 2: Strong winds during typhoon climates

=AY WHER® oh-ge
Yan MENG, Masahiro MATSUI, Kazuki HIBI

SUMMARY

The wind field in a typhobn boundary layer (TBL) has been investigated by a numerical
model. The results show that vertical profiles of wind speed and turbulence intensity in the
TBL can be satisfactorily expressed by conventional power law expressions. Basic parameters
in the expressions, with the exception of the gradient height z,, can also be predicted by
formulas proposed in Part 1 of this paper. To describe characteristics of the TBL, two new
parameters have been suggested:one is a dimensional parameter, f;, representing the absolute
vorticity in the wind field, and the other is a non-dimensional parameter, £ characterizing
heterogeneity of vorticity in the radial direction of typhoon. Substituting Coriolis parameter
f with the parameter f,, the gradient height z, during typhoons can be presented by the same
formula as that during non-typhoon climates. The characteristics of the drag coefficient C; (=
usx/Ug) and the surface stress angle 7; in the TBL are also examined using the present
numerical model. The results indicate that C, and 7, are a function of a modified surface
Rossby numeber R, (=U,/(f;320)) and the parameter £. .

1. gL &IC . . MEE (typhoon) K&L-ThhdshTWws, L
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SR B LGB LEETH S, R, BRI M ORELAEZRD B DO EFI, IEEREOM
BROERICH DD, ZLOBHEHBOERARE ROBWNF—7icBSWTHELNL DT, ARAEOR
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L AHMFROTFRER TS ARORR, BEOBRNTE
FECERT B LHHRIATHEY, LAL, 20
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Fig. 1 BREFNOME

(Summary of a model for describing the wind field during a typhoon)

—5 -

6-4

B

1t



z A >
B
N
: (4 East

r

Fig. 2 AR Ba
(Coo;dinate system in this study)

X @) D) Eo0TOBRKHE, LETIR
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Karman ¥, 2o W REHETH 5, Fig. 213K
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Fig. 3 f & EOBAERAEOE/
(Variation of the parameters f; and
£ with radial distance r) )

~Ho = (K,,.%"z'f) )
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DRAEFOVHBOED S IMRT T A -5 T
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Data Time ' Latitude Longitude
(J.8.T) (J.5.T) (deg) (deg)

B c P, AP m
(deg) (mfs) (APa) (AP:) (Km)

91.09.27 16 32.8 120.7

50.09 17.13 940.0 73.0 8543

Table I BR/ T LAY 0—%&R

(Summary of the typhoon parameters used in this study)
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Fig. 4 EHRE LN OMBEAFOBREEHEDOELL
(Vertical profiles of (a) wind speed and (b) turbulence intensity at
various positions in the radial direction) .
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(Variation of the wind speed ratioG(r)
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distance 7) .
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((a) Wind speed and (b) shear stress angle profiles showing a comparison
of the results during typhoon and those during non — typhoon wind climate)
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((a) Normalized standard deviation a/U and (b) turbulence intensity profiles
showing a comparison of the results during typhoon and those durmg non -

typhoon wind climate)

MBS, Chi TORBABN' L ARIEEL S

BHBEIIT, BEEE bIBEERIICED L, Kt

DEHIERINB,
W=7, (10— 0.4 2P (12)
2g

R oB#Riz (12) Nk HRDA DT, BITEEEEL
SCEPLTOB I ENYN B,

Fig. 8 (a), (b) RENTHMEFEES U, THKT/L
LEBBEROEERELILNORIONBELH LT
Fo KROEMIIBEBOET, MVERIIIEARROM
ERT. MRTEHREOEREE -S>V TRBER
DEFEEAROME HAE T2 TVAY, AhoH
T, ERAKIEBOTHEOMIZIREALENRSR
e Thih EEBHAIcH TR, GRECENES

BEOEL O BFRE LTV B, BEASKTOR

NOMIIEHNR SN OERIE, SEMOFYREE
EHRROEEREE LFARBOBLIIRE -
fete® T, ERIRGEERE L RSSO, S 3
ANDOMINBERUIR L o1 &It 3 HDTH B,
BREEEESRKROENOBE LOMICIEEA LER
Bohigh- kil coBigR® e R omaot
BERBMLTOVWEELEL S, CO& ST, RHEMFIZ
BREOBRSE I RICERNEIBRRESE L 32 &0
TE 7,
4.2 REBUREOEH
FEBREOATBAEIC S BERAIL, 1961 Fic

Kazasky & Monin'® iz & h 1 T8l s h, 0%z
IZE UBHic % 2, Csanady (1967)!7, Gill(1968)'),
Blackadar & Tennekes (1968)'?, Zilitinkevich &
Chalikov (1968)* 1z & » THIZ & hize T DIEHA
3, REWWIEHEERO R E—BKR, s 0BFKEEET
HRIT, REPWIEADA S S GERAHC, = uw/U,
EIFENE) EEDABERROL S H20DRICL T
EZbxhs,

In (C, Ry) — By = (cig)z - A2 (13)
4
sin 7, = ~7C, (14)

ZIC, A B MR AEEEERTH B, BIE,
Zilitinkevich?" 3B £l R S W R 35
XEREL, Ay ByDEIIMISENERENLS, 17T
BBHIEFRELI. LML, (13) & (14) TEX
N3 REMWISSH & RED R €~ & OBRRBN S
BeloTOB o, MRAERETHS. £, JOR

RFEDEANOXIRABOERMERLTOB 1D, &

AROASHABO Tz ERATE R, TIT, &
KT, BERFEREAVTERALALHIBOAS
BREOREHWIST & T OmBEERTHNERESE
B3 %o

TIT, BERT -V U/f xR (10%m) &L, #
REMEE 2o & MRTT/S5 A — 5 ELRHEMELS
oo Bz DN, PIHSHRIES b KW OHL

=1 -
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0.07
%0.08
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wa%_
~ 0.2

0.01

/U

=u,

Y, (deg.)

s 5 6 7 8 'eyxw
log (R, )

AR C, & REYAMIE A 7, DHEIER
HORE Ry &5 A —F Flc L BTL
(Variation of (a) the drag coefficientC,
and (b) surface shear stress angle 7,
“with the modified surface Rossby number
Ry, and parameter £)

Fig. 9

% COECHEE A ~TEB LI 520457 Y
(0.001, 0.01, 0.1, 1.0, 3.0m) i=f3if, £, WK
FE8F A — & EOMEE 1 ~1.6  TRE(L S ¢z, Fig. 9

(a), (b) RIEFFRHC, & RHWHIENE 7,0Ry 12 &

BEALERT. BRI T eREhAERRKOR
iR (EERE10m/ sLlEOF— Y 04ERA) 2%
Fo Fi, HROBREI (13), (14) itk kDb d
DEERL, Ay By EhEN40, 1.0& L. BH,
BHfA, B=AREhEhE=1, 13, 1.6 DEA&OHIE
RFERERT, F= 10BE& AR ERAKC,
LA ORERITRERIE, AR T — ¥ F
MBI —B LT B, EDERIEDKELED
BE (BEB), Eolne & bz, BRERC, LBE
TsEBRELCHL TV B, ENKGHRBROREDE
MRHORE—BEERT A —F &R -TWBI L
EEXDL, LOHRIREOEMAROIE—HRLEAK
SHABOWMENECSAAREBERL TS, Hf
DEFIZ, (18) & (16) Rz & DRDIERT, BIF
BRELGEULTOARZ EXGDH B,

Cy = (0.28+0.07 £)iog Ry )% (15)

75 = (8941008 )log R (16)
&30, AREFARBOXTHABOERARC,
EAE Y FBERTOAL —BR,, &85 2 —FEick
o TH—MIc R T ENTE R,

5. FE®

AWETR, CRBOXIKRBLEL TS IMEE
FNEHREL, BRRORTRABOUREERTH LV

S5 A=Ff & EERE LR, LT, BRTII0 A

Yilab—bFaiizdh, AREOFHREL LN
DH S OHEAHORHET Y, B, GRAEIERR
HOBBIBORKETS> ik, BRLEAAKD
FEB ORISR U T OISt OMEE R L .
ZORR, UTO LIt 5,

1) AEKOEHRAERUVENOBI ORELMIT 2
BREF VL » TR RT Z ENTE, 12
REFREFNPOER NS A -5 b, HERSS 2,
EBROT, KRXEO I TREINZ—EORITLY
FRATEEI LD -T0 £, BRBOHERS
Sz, 03, AR L EMT, ARBABO b KRER
BERT =N U,/f, LBERED AL —HR, OBEK
LLTCHRT LR TEN,

2) ThETOHRNN S RoALERBOBEBO VL
OOORERHRSLERMFILDHAS Mz SN B
RADISES o WEREAAE (B DR, AR
FMEERI 51 S EERR S OBDI LB bD LB
HTE, i, ARBOEERE S A Monsoon FeD{E
ENELRSIEVS DR, FRBORTHEABO LD
BEHMEERBOBEL O KE{BsTVEZ EIRLD
LOEBETE K,

3) BRLFLGAKORES RY — N U/ EU/HRL
Thhif, E L ESRBOBRTENREDOHNES
fHRBEFE LT, BEZ 0 bOREAMOENETK
E{MoTn3, —H, FEHBEIZ>0TR, kS
BREOELDERABOERNMEDAS (LTS,
%t EERETERIT LA EDREIEREER, kS
RO LD SRABOENSETFRE {524, iLho
BMEIOVWTYH, EEARIK BV TR &SR
DEIIBEAEENRSOE V. Thid, GRKOFE
HEE & BRI OEREZOEIERIIAKE L
Kb ERATER, ‘

-~ 12—
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4) B Cy & REHWIS A 7,1}, EERED R
E—3R,, £/95 2 — 4 EQBME »TOB L &4t
Ghotie B, KHRTIR, Cho0BERTEEN
ERE L.

T &
FHRFEL S/ ShichIBOARBRRBORER L Z

| OBEATRET B TR, UTOLSCE &ni,

cHERES 2,
2z, = 0.08 —f—%(log Ry 45 (A-1)
2
s FHREOE K, ;
a, =027 + 0.09log 2, + 0.018(log zo)?
+0.0016(log 2)° (4-2)

c AN OBE 1,60)
1,(30) = 0.253+0.15log 24+ 0.0462(log 2,)?
+0.005(log z)° - (A-3)

« ERRSEEREOXE N
ap = -0.0025 - 0.73a, + 48a2 - 10503

(A-9)
PR C,( = 14/ U,) ;
C,=(028 + 007E) log Rgp) ™ (A-5)
« REWMGHABK 7,
75 = (69 + 100¢)(log R,y) ™18 (A-6)
- BIWIG AR y DSBS ;
72 = 7,(1.0 - 042/z)"! (-1
» ZEPREOBERE 0, ORE LT ;
0,2 = 2.1u (1.0 = 0.72/Z )7 (a-8)

s HhoWE I, OMBELH ;
1@ = 1,(3002/30)"F “(1.0-072/z,°%  (A-9)

T, Zg=01Tus/fL TH B, Ef, RRKTI
fi= B Yoyt et s
(G2 4284 fyis, FARHTIA =/, E-1TH
B
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E18E BIFEL K7L (2004)

BRVZAL—Ya OEODOREHESHEURLBEIERERZORE

A Mixed Probability Distribution Function and Modified Orthogonal Decomposition for Typhoon Simulation
AR ED RE A KD D FarF—Yard PRI =
Takeshi ISHIHARA", Ho Thai HUNG?, = CHEONG Chee Leong® and  Yozo FUJINO"

ABSTRACT
A mixed probability distribution function (MPDF) was proposed for typhoon simulation, which is
applicable to any locations by changing a weighted parameter. A modified orthogonal decomposition
(MOD) was also proposed to simultaneously reproduce probability-distributions of typhoon parameters
and their correlations. The annual maximum wind speeds at the five typical sites in Japan simulated with
the proposed methods showed favorable agreements with the observations, while the conventional
methods overestimated those for the long-term return period.
Key Words: Typhoon Simulation, Mixed Probability Distribution Function, Typhoon Parameters,
Modified Orthogonal Decomposition

1. FLESHIZ

WERHEH ORBULIC A, #HEY oA L 2M O LB OABLO 7= I B VBRI OREHEEN
VEED. BERACRT 2EBMTRE 70 ER LW, ROEHESE (Fl2E, 1000 F) owd 58
BRBEOCHERSMEL 2> CTLEIMENSHD. ZOMBEEMRTHLDIZ, ARV Iab— 3 MITXHRE
B OFHEEESRERE SN TE R V.

BRIz LY a L OREHEER T ORI ERAT A ORGSR RBEL EHT S 2 LBE
BETHD. LHL, HEROMECRVONICHERSHAERIEICE > TRZ5. AL VITREROHLRERT
BAP 2 ERSHCELUL TR0 LT, TAU I TRIA TAGRBHNLNTND 99, F-RKHET
RLELOICHHHADERNT A—F % L EUT2BBELSH2MOMIUTERTL L, RERBRENELTL
9. KK, BENRTA—FOKINLEERBTCL > TRR TSRS Y, B—ORESHTTTOME
DEEAT A—FEEHUT D L IRETHD.

RNV I 21—z FETEHEENAT A4 OROHEBEZFAICERTERVEELHD. TORER, BE
FERAERTVEERY I 2 —¥ 3 VFEEIVKDLNIERKRFIIER T A—F OERT — & b LEHERD
LN FEREARBEICLS, ROBEHAMOBEMESEBRICGFMHISNATLE Y. Vickery b Y32 00EMNRT A —
SEOHBEBEREFRTAFRERZRELEY, TXTOERT A—IMOHEL2RIFBCHERT 5 2 LN TERD
—F, BHLNIERERFICESE, SRETHR, #TEE, PORERTE L RKRIEEREFER O
TREARIMR 2 RIRICEET D FESRELED, BR/ T A—FBOWME LT A — 5 OMBL 4 RRFICEER
KBRTHILMUTERVEVIBELDHS.

VERARERFR LR RTER RETEHE BhEdE (T113—8656 CREIRAE)

DORHERERER LERPARER AR ER KREBRAE

P RRAFRERTERER HoERYER #HiF (T113—-8656 SCHEAL)
— 5 j—
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Zr T, ARFRCHES EOE & I bEA T 5 ENERESTIREREL, £ LTARA T A—¥
BIOMMBEEE L HRTE, 1oBRAT A—¥ ORESHOELRE B2 bRVY 2 L—y 3 Vi
RRETS. AWK CRESNET LV FREOEHEERT DI, BREACKELY T2V EEROERTAR
HEOHEEST LT 5T L b L, '

2. BRYVIaAL—LavOBE

ERYIal—varTCROETREOERBNT —2ic k0, AROFERER L, BIERERE d,,, ETHR
0, HFTHEC, TORER TR AP, BXEERHEER,D 6 S0/35 A —5 DENfERDD. KIZ, @
BT A—F ORRHAEHE, AIHICERERESED. LT OREShEBRORES)L EZER%E
R, HEBOHELCHBOBELZE L TH ERICERL, HEROERRAELRDD. Rz, @V I1a
L— b LERTFE~FHEROERKREE KEWVIEICIE <, FRARECHERNMERD, TEFHHMOR
HWEFHTS.

ERMO LR, BESNERORE, ETHE, SESEEFET IO, Me0BRNT A —F OfR
SHEEERICHERT AT TRZRL, BRI A—FEIORBRFEOFRVEETHD. TIC, AFETRA
By al—va Y FHEOBIKELRIIDE, REOCERNT A—FIZL ) BH S5 REEEEV 2
R ET-7. AFE TR, SRBO LEROEEICITARD AL VRERENLBITESNVER W, 8
BT A—Z T BT — F 3R 7 R TART -4 —R 2B, BROREREELHRELLER
YIal—var7ues 7 AMOST (MOnte-Carlo Simulation for Typhoon) M L7c.

22 T 22

. BT
21 —— HUGEMSH
Rl 07175

Ln(AP)

-l ] -t 0 1
BREEHIn-In(1-Fv) LAEERIn-In(1-Fv)

K1 SEETROMBESSTE VA 7ML DM

« w5 - s
21 pemmsw 1 21 —— RAREHN

N ] | #m

Ln(aP)
Ln(AP)

T2 45 4 a5 0 85T 1 15 2 2

RS I (-F) iRy
X 2 SERTEORASHRESMEHICL DR
3. RERESMEHORE
HERAATITONTEEERY I 2 b—a U TIRERER L IIRT V01, BEEIERE 4, (X—8am,
ITHM O LIER ST, ETHEE ¢ PORERTE AP BAREER LITHEEHRSMAERESRTE . Pl
CREEBETEOMESMOELR L LTIEARTHEMEERSHFBBOLNTWADWIEXH LT, TAY A TEHDA
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TAGRBREREN TS Y, FLRERTROERSAIIAEOTEICHEORELEEESXHILEEL
L, ETRERTRICH L THEERDH L VA TANTHOERREERCEOBEAMREEZH LT 5.
HITEBLIVHFCBITIREETROBAT —F LRFOREBEIMICLD 7 4 v 7 4 VIR E OLLE:
BT, fEISRERTEZHHTRRL, RETEECERERT. EBLEEHERAE INE? YEBEHAMIRN
LISHEL TV, ERERPOEREENT—F 2. ChHOEMALANE £, HEERSH (EiR)
ETFETOBRT — 7 2 L GERTE 50, MBETOBMT— 7 E2BEL GERTERY. —F, UL 5%
(S8 BEFOBMT — & 2 L GERTE DI LT, FETOEMT—F % X GERITE 202 &340
5. CHETREIFICEY 2RV EROBREEDRNM L5 b0 THE, FETHROERNEIC Lok
BROOIH LT, RBETHBOERASLCERTS. 20X ) ICKBIICRAEHBICH LT, B—08BRSH
WEBDHED LIVELUIIRETH Y, LEENREESHMORESLETHS. BAIZ Georgiou 53 BT 7L
SO EPREEN KW S 7 v ) SIS IBITE.

BT, KR CIMBER SR L TIATAnHLEOMBEDLEICLDREFERHMEE MPDF (Mixed
Probability Distribution Function) #BE T 5. ZOMEHEEREHIARICLIRESES.

2 k-1 k
MPDF = ax ‘/_2_;10_]“ exp{_%[@i’;ﬂt‘m] :{+(1—a)x£(%J exp[‘(%] ] aefo, 1) m
SIT, 2lHRANTA—FTHY, OIRXTATANH, 1EMBEERSFEERT. JOST A2 IR ORE
KEYVRDLND. ZOREGHERIMETERLBFIFECER T L, TETR a=1, Thbb, MRERS
mERy, —F4, WBTEL 0.2, VA TAGHTENGHLizofz, K2 KIZRARESHEKEETRICER
LR RL, BHF—F 25 T4 9T 40/ LTOB D Edbhs.

BB ALER I AT 5 A GRS, =8, KR, TIE I8 KRARESHERZERNLELL
FRE/T A—F OEETY. EHALILCTUCLIzi 2T, BA/ST A—4F a DEILH 0.2 75 EFHIC ML,
M EYBAD L 1KENET S, T7bb, [UEK TR APOIIMILT A TS50 LA IERSRICBITL
TWBZLBHn5. ZRIERWEROBEEFEENEPLIANT RS TRLP LTV ZEITHEL TV S,
RAMERSMIFOREERTEOALGT, BRXEERIFREETEE CILEATE, LVIrtBEERES
NTWS, FITEITEEICBIT 2BA/7 A2 XTLRERTRLE S 2EmERL, EALIE~T >
T, BRENRTA—EBEITHILHBONS. CHEERDETEESIE~MT U LA > TEL 2o TWBH D
LIZRIE LTV S,

f T 0 T T T T T T

RBERSH
K wh | EROETN |
0.8 g e AP] .
—— HLLEFI
" C 50 [
J‘F 06 *‘é wl
- ®
;")01‘ S »..v‘ ﬁnof
b ‘ |
02| 4
. w0k
"
o L _or7nss R I I
% £ E “© 2 4 0 1 2 3 & 5 6
Hix EELEH -InC-In(1-Fv)
K3 RAENRTA—F aDBEECLDENL X4 THIZBTD EEROEREAEERESSMN

HLBELAERAMENMOPREMRTH0C, BRI A—SOBRMBL VY EESN: EEROFER
KRGEE, BRMEEEE L ARESMICHEVRBE LEERAZ A— 2L L)k o EEROERRAEREE
Bl B4IC3TRICBT 2 EEROERKAEDCHERRE R T, (EROFE (REERASM) LR
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BRI O FE R AR OB AFEMIT AR CTRE LREHEESTIC L D RELHBESh. 2k, TECRW
TLETEEOHES IR 2 RAHELSHOBASERRBEDOFRMFEICKR b REREEL 21,

4 BEEXTREORE
F1DCRTESSEEF0E L, & 500km LPNICEE LB RO /ST A — ¥ BORBERE 7T, /<7
— it EoT 0.3 #RAAMEKESRONS. Blid, APE dw b OMCEQOHBHER KL, ThidTHE
SHEBICH L TERMICEBEBT 2 BRSO T EATRL, AFREMICER LEEREL~AS L, ERERICERLE
BIROFB LB R L TWA S LIRS LTS, S0k 5 2% EET 5 & B2 @8 L a R0k
EBRBRICTHEE N, FENAEDBARIMIzSRMRS. fE-7T, EVTANBRYIab—Ya itk YV BRE
B0 TR, BR/ITA— X ORENHEE L FERT 570 TR, A5 A~ OROMEIBIR L BRI HR
THOLERDD. )
F1 TEIRBTIBRENT A—FOMEERK

a) BRI b) BRI HEEERERIE
FE (4P | IR,y | IO | 6 dy, |4 | In(R) | In(O) 4 dy | I(4P | In(R) | (@) | & o
n(4A | 1.00 1.00 ) 1.00
In(&,) -0.28 1.00 -0.28 1.00 -0.28 1.00
() 0.01 0.37 1.00 0.02 0.35 1.00 0.02 0.35 1.00
g -0.03 -0.03 -0.27 | 1:00 -0.04 -0.02 | -0.25 1.00 -0.04 -0.02 | -0.25 1.00
i 0.33 -0.25 -0.37 | -0.28 | 1.00 0.33 -0.24 | -0.37 | -0.29 1.00 0.33 -0.24 0.37 -0.28 1.00
# 2 Vickery DFE 9
R A= xil FesEgE FERK FHBIBAER
A RhPa) Weibull PR 51 C=a-bg
E[E] R (E) k=¢
Ru(km) LogNormal 1 o _l(lnx—ﬂh‘("‘)}z M,y = G2 -b,AP
R 270, 2\ Oy Ouir,) = C2
Olm/s) LogNormal 1 P 1 1nx= e 2 Hin(e) =33 —b3(0
C\/ﬂf’wn 20 Ouo Tinfe) =C3

PR HERAT A - S HOMBEEERT 5 FHIIRREN TE I, R 2101 Vickery FIE U LK /3F7 A —
Z OREFRST L REBKRE RS, KEETERE L EITEETRE o OB, BAEEREEERIERTREOREE

LLTRIN TS, fIXiE, Bad APOBOMEBEFREIR@OLIICRENTNS.

EREERL, snené oneaidZThTho n(B)0EHE L IEERETH S.

I, f(Bn) IHERE

1 ln(Rm)_ Miucr,) ! (2)
R = — —_—f—_— =7
SR.) R,2mo P 2[ O inr,)
ZITC, e, 2 APORBKLELTRE)TET. ZORUCLY, Bl APOHBBERZFRLL.
Mgy =GAP+D (3

a, bIXRETHD. RO ER@IZL YV RELN R b APOHEBEEKIZ—0.26 L2y, BAELIIEF—-KTEZ

ERZND.
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L2, Vickery H DFEILIZESHORBERHS. H5ICEAELE L BxDHERS T & Vickery FHEIZ LY
RO ORI KEERE YR BaDEESHE2FT. Ial— SN RaDHERSTITEEL LIRS &
—EHL2NWZ EDBHDD. ZHITHBEEERT A0 R OFEBEETLEEEILICL 20 THSE. DY,
Vickery FIRIXBE T A —F ORERSA L MBEBRMHCFR L TW W E8¥b?5. I 0FETE, 2o
DBEMANT A — S EOBBELIBRTELNEVSHBLH S,

AWRTHE, BR/T A—F HOFERERG L RN 2 RRFICIERE T 27201, B EBAZERE MODModified
Orthogonal Decomposition) £ #RET 5. ZOFRIILUTFOZD0ATFT v 7h5i 5.

1) MSRT A= ~OERER

BREEBTEHTA—F L LTRRERTR AP, RAEERFER R, $ETHEE C &ITHM ¢, BEE
BB doin B35, TNOHDERNATA—FNEHEREND Y bk Ric L0 RT.

{e} ={in(aP)In(R, ) In(C),0,d,,,} (4
BRENRTA—ZMOMBETHEZS L L, BAEALEEZ ML DERIIUTOL 5127423,
[S-AEl{g =0 (5)

HEZ b ORRNRT A —F 0BT — & xi b EHBEOMSI NS A—F 22RO LI EBRT A2 LB TE 5.
{z:} =[){x;} v ®
IDEIITELNIMIAT R —F X ERI L — KT b 12 BIREHRSTERIC X v i3 3.

2) fAEOESBR/ ST A —F ~DWLEH .
WIC, HEEENTHEEARIHEST, FIEFERAOBRIIET ML T A—F 27 &REL, BAHSY b
DHITFIE DT THEEHSBEST 2 — X I ERT 5.

{x} =61 {23} : )
ZOESCHRULAEAT A-Z 55RO LNAMEMRE R 1b)IZBUAF — & 5 bEEICRD b R
(Fla) LES—HELTWAZERPMS. L, ZOLEIICRELEBRANT A —¥ ORERSHII™ 6 O L
SIZEEE LSS L BRI — B LTV,

- - T
A —B#5T

,,,,,,,,, Vickery

< BERXENE

1.5 L L . . L5 P .
-2 1 ) 1 2 3 2 [ 1

A&!ﬂ:ﬂm =in(tn(1-Fv)) ;*ﬂ:il& -in(=In(1-Fv))
BI5 Vickery FIEIZ & 5 1n(R) DREESF M6 BEEXERIEICES In(R) DHEESFi

2 k]

3) BRELICHESH~OELE

ZOMBEBRRT 570, FEMENTLERAT A—ZITH/MEEZMA D2 LIZ LTz, BEREIALER
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Prediction of Wind Speedup Ratio Considering Wind Direction of Typhoon and Speed-up of Complex Terrain

i HfE AR
Yuka KIKUCHI" Takeshi ISHIHARA?

ABSTRACT

[t is important to assess the design wind speed reasonably for wind resistant design. In the current design
in Japan, the maximum of the topographical wind speed-up ratio over all the directions is used, which
may overestimate the design wind speed. This paper proposed a method for evaluation of speedup ratio
considering wind direction of typhoon and speed-up due to the complex terrain. Speedup ratio is defined
as the ratio of 50-year-recurrence wind speed over a real terrain to that in a flat surface. The wind speed
estimated by the proposed method shows a good agreement with the measurement data at meteorological
stations of JMA. Finally, the reduction factor and coefficient of variation of topography are proposed and
the relationship between speedup ratio and topography is investigated by using several three-dimensional
steep hills.

Key Words: Speedup ratio, Typhoon simulation, Reduction factor, Coefficient of variation of topography
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RISK MANAGEMENT FOR POWER DISTRIBUTIONS BASED ON LOCAL WIND
PREDICTION AND TYPHOON SIMULATION

Takeshi ISHIHARA, Kota ENOKI, Keiji TAKAHARA and Hiroshi ARAKAWA

A framework for the risk management of power distributions was developed, which consists of the
fragility curve of the electric pole, the typhoon hazard curve and the minimization method of expected
total cost. The fragility curve of the electric pole was constructed by the damage data caused by Typhoon
0314 and the local gust wind speed in Miyakojima evaluated by a CFD model. The typhoon hazard curve
at the individual location of electric pole was constructed based on the annual maximum gust wind speeds
obtained from the typhoon simulation and the local wind prediction. The optimum design wind speed for
each pole was decided by using the minimization method of expected total cost. The expected total cost in
the design life of the poles by the proposed mitigation measure was reduced by 13% comparing that by

the current design.

373

6-39



SEH 5

EUTHILAYZAL—30E MCP EFRAWWRESRIRIZHITH1BIEEED F A

Prediction of the extreme wind speed in the mixed climate by using Monte Carlo
simulation and Measure-Correlate-Predict method

EEYa hm &
Takeshi ISHIHARA  Atsushi YAMAGUCHI

SUMMARY

The extreme wind speed at an offshore location was predicted using Monte Carlo simulation
(MCS) and Measure-Correlate-Predict (MCP) method. The Gumbel distribution could successfully
express the annual maximum wind speed of extratropical cyclone. On the other hand, the analytical
probability distribution underestimates annual maximum wind speed of tropical cyclone. In the mixed
climate like Japan, the extreme wind speed estimated from the combined probability distribution
obtained by MCP and MCS methods agrees well with the observed data as compared to the combined
probability distribution obtained by the MCP M ethod only. The uncertainty of extreme wind speed due
to limited observation period of wind speed and pressure was also evaluated by the Gumbel theory and
Monte Carlo simulation. As a result, it was found that the uncertainty of 50-year recurrence wind speed
obtained by MCS method is considerably smaller than that obtained by MCP method in the mixed

climate.

Key Words:Monte Carlo simulation, Measure-Correlate-Predict method, mixed climate,
extreme wind speed, prediction uncertainty, observation period
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BHVERD, ZoX 5 B RAUEIZ X2 BB
BB REZ BN AR O ke LT, BT HL
133 2 L—3i 7 (Monte Calo Simulation)iZ X v
BV SR IR 2 5RO FE R & R 2
Fii IMBR SN T Y, HABE:£(2004) 9,
ASCE(2000) 945 > 5ot 12 FIV B TN D, BT
Ay alb—a Al AR, BRBRIZEY
RRAE IR 2SR D DIER FBIT S, FFHZEE L,

*1 HURRFLFRNeR iy s #d®  E-mail: ishihara@bridget.u-tokyo.acjp
Professor, Department of Civil Engineering, The University of Tokyo

*2 HURRFTERNGER HE2FRFHE M

Research Associae, Department of Civil Engineering, The University of Tokyo
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N EDFRORMED 2OV CERMIZEHM L
TBITIEE AR,

ZZ°C, AWFETIE, =T MCPIEICLY, K&
BB G S 7 O A et R e T AR L, A
RER L UBEHEREICER 5 AoV, %
NENT VPR L OARFECIRE LV
UVOMAR & BRSO 70 B 72 B IR HEE AR
&Y, AREBICARERE A 5, &I, €Y
FRANARY R 2 b— g Dk Y ERKEEOM
FOME R, BT —F LT 52 L2k Y
O TS A FAMT 5, ki, RERoFEE,
BT ANR Y a b— g VOBITESB IO,
BUFHINBYR ab—Ya AV AREDE
BUFESL D R R O A fg s S b 2 AR BE ER
MNZRHT 5 & & B, IBHFERLE & B RRIED
BEIESTRR 5 AR S 2 B8 U 7o b iE
Dl IR T 5,

2. JEERINZ - < HRfif G O FFAMG

MCP 1L, T35 5l g T o Fshi 7 —
& LR AEELSORYBNT —4 #RME L, W
Fr OB &R ORI R - /67— &R
DHFETHS Y, BT — 2 BELH TRV
BN, RIEATIZ 0 ME OB E 55 Z &8
e ChD O | KB CH, SRR T
e 70 MASCOTIZ & ¥ 3K b 7= s b & FV T
ST R BH ORGE - BRI T — 4 i EO%H G
SR LT, DA, MCP I K5 mEin s —#
OEMTFEL RS &L b, ZhboRERT—
202 X D BERGEO RN 24T 9 .

| Choshi Local
+ | Meteorological
, 7=/l Observatory

Offshore site

1 PELRAFEFOTEH (Location of the offshore
wind power plant)

2.1 MCPIEIZ X587 — ¥ D2
AWFIEO R G EE, TIEESTFmivhodbH 35
FE 40 45 41.87 B, BTRE 140 B 49 43 35.91 BO(H A

HR), S 100m O LR CH 5 1),
JRVEAT — 2 131995 4E~2007 £ T 13 FEM D
B RS RICBIT A 10 SRR - BT
— & Z v, G - FUEOERYF— # 13 MCP ik
R ERAFEEOR RIS U, TR
HiZ, FERERMLT-HEF L MASCOT? iz & vk
Wiz, BRI - K& o i - HIROR
RHNF— & 2 X (1) LA Q)% A CHE s o L]
RGO B RHN T — S A LT,

U=t %S5 (1)

Os =9M+DS (2)
LT, ug & O, 13 & 1 RS O RGE & 6], a,
& 6, 1342 B - KB B TR S h 7o i &R
MZFRT, Sg& DgiE, 1 Ess & @ifls & o/
e R AR L, KRBT LD R, o
ZC, KA CHER S EI 6, ST & 1E
ENEBEDLRWERE L,

R ‘ [}

®)FERA (Southerly wind)
2 PELRAFEERHTHLSIC IS 0T D RO 22/ A
(Spatial distributions of wind speed at the offshore
site for the northerly and southerly winds)

X2 L2 PR AT IS K 0 R 7o ek Gtk oo [ >
ZERAAG g, ACE(EENAIR < AR 2a)iT,
FEEVHERD 23K < A (K 2b)bbs, Plth g
27, FETREMETLTWS, ZOENEK 3
IOR T OB ST bIT-& 0 LBh TV 5,

X4 20k, ERGEO R Lo BmZ L AELE
RS, TSR OREE S(100m)E, #k1-HG

—106—
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200

----- Northerly wind

150 Southerly wind

100

z (m)

50

0.0 20 40 60 80 100
u (m/s)

3 AbJEl & B R D $ B JEGE 53 AT o T HIME O LR
(Comparison of predicted vertical wind profiles for
the northerly and southerly winds)

41208, PRREOREL ORI X 5 &L E
AT, TG R ORF i S(100m) 1%, 8k T
LQGE ORI S(28m) £V BN Z L, FRE
DRFICEWTREIIE T L0 Ro T D, fF
(2135 E~270 FEOFIFRIZVTiE, $h s a%s
TR S B i OB A 2T 57280, JRGH
FLIE A &0 27 ) R&E L 7o Td,

Wind direction (degree)

4 SEREGEOEGE o A L A 25 (Variation of
speed-up retio of meen wind speed with wind
direction)

2.2 EHRESEIC & SIBERED MR
RRIRBUSRENT 24T 5 7= D12, R rid sz R
500km o> PN 4 BV EARUE 2388 L 72 RF R o i
TR R EERRIEIC L b DL L, FNRLSOR
-2 RRERREC LS oL Lz,
RGeS N T2 R O RS T— Z 0 6
RS 2RO BRI, 1D & DERKEEE
HHH L, NARRTIZ 3T 2 Rk BUg 2 S 3 OV
R 17, ZOERRBUEDOIEBIBMER AL o~
OIFFEZ L VKA THREIND,

F(u) =if(N+1) (3
IIC, u, 1 B RO REETH D,

A= G- Ve

¥, ==In(=In(F(u;))) 4)
EHHERUE IS X DR BRI L4
D Z N MENTWD, IEFBIBHERF N
SUVGAZHE O G, IRAHRAUEZ L AR R
ORI U . 1, AR LERIZ L W w5 9,

ug =V +0,(y-7)/(/6) )

ZIT, V bo 1T, ENENRERT — 4000
NBFR NGO VI G 25 R, y i34 A
Z—E$5(0.57722), YITEBLAKTHA,

51ChE, H i EBGE L CRO TSy
A & AR EGE OB T — & O AR, 2(6)
WORTHHBIME R L IERBIRMESE F(u) ORI,
50 FEFIWIRTZ s d 2 e y13 3.90 &7
Y, ZOREOEES 50 EHERIFOERKEED
WEM 722, M4 55, 13 FMOBIAHED 5RO
ST LR, IEHHERUTEIC X D HERKR
HE ISR LTWD I ERSND,

Fu)=1-1/R (6)
E 50
£
3
§ 40
2 33.3(m/s) -
£ iz ame——
30 O - -
§ L _oeeeTtT <
gy
K
E H
< 1o Return period (years) |
‘Z 5 K‘G Z‘O 5‘0 1‘00

2 1 4 1 4 5
Reduced variate ~In{-In(F)}

IR SE DR REVED T-HIE & BHHE & o
F 45z (Comparison of predicted and observed
extreme wind speeds caused by extratropical
cyclones)

X 5

2.3 BHEREIC KL HBEREDSHE

TR AUEIC & DRI & v, B
JER ERELZRVERS D720, BV KR)EICERY
DHRKEE Omis LR DERDHY, HorULhy
Tk FOEEMNDZENTERN, 2T, A
JeCIE, BRI E T 2 SR RS Om/s
L IR DEOMER A % F . TSN OFEOHERSy
A% Frgo & Ly 2UNNART A V534 & Bl
SO A E L IR TR A R LT

Fucs = oo+ Fronser (7)

BT n, FOILENHKRIEIC I AFR R EGE
P 0mis LIRDBERE n, LT 58, F iRz kn#
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TIENTED,

erro = nO /n (8)
F7z, 0m/s Ch7ay VERRRGEIIH >~V 234 G(u)
&L, ﬁmméwaimibﬁbk,

F (u)=(n-ny)/nxG(u) (9)

nonzero

PHIRREICER T 2o v 1T, F(10)i2 &

DKL BEFEEELE y 1L, kR 5,
U, =V +a,(y'-7)/(7/\6) (10)
¥' = =In(=IN(F oo xNf(N=15))) (1)

-
ZZT,

V., o iEERER Omis LIS O R iR
DIHE LR TH D, AEEET MEn, =0
DEETT SN oi & BT D,

X6 (Zig, FERAUEIZ & a*F%ﬁﬂi%ODEﬁi
ik mT, IEPODEI}fL ¥, 13 Mo IRRE
HERRBEE S L, MR, ABFSECIRR Lﬁ_(u:
/\ﬁﬁ+ ML D RO TR SMAERT, BEET

X AHEEMIE, 5 4LV EN FHEUIR CER &
ot < —%L, Ly EVWEE ,ﬂ;ﬁF'aEJ T E 2 s
Pl LT D, ZAUTEERHRA & 2 hm i R 2
13 Fo BT — 5’%>Bj’?®é%€&l$ﬁ%£‘lﬁﬁi

BN EERIRL TV,

[}
€
£
3 (o]
g o T
o -
H P 2

30
£ OO
£ Q0O

wl
£ e
3 i
H H
< r H Return period (years)

H 2 5 10 2 5 i
! [ L 1
@ .
B’Z R 0 1 2 3 4 5

Reduced variate —In(-In(F)

6 FRIRKEDOFRANRH OB & TR & 0
M #: (Comparison of predicted and observed
extremewind speeds caused by tropical cyclones)

2.4 RERIEIC J’o('f%)ﬁﬁﬁﬂ:zd)nﬂﬂﬁ

HARD L 9 IR T, BurRAE &R
RES K DRI 5 w"Cth/”JIJWﬁE%u FiEe i
L7tg, MR E Gl 2 ENH D, BHER

SRR T AR R RE v, & B REE ISR T
DEFER KRB u (TN DOFERTH D EIRE LTS
&, IRHHERRTEIZRR T 2 FER A EE O I B

Fo(ug) & BHEEE ISR D FER R BUEOIER
ﬂﬁﬁ+ Fo(uy) & BB UTZIRE TSR Fo(ug) 1T
WAL VI cE 5,

FC(UC):FE(UE)XFT(UT) (12)
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Y, Y, WmEOB

7120, K122V TRO IR AR %
ERCRT, ZOEBEERSAME, SFELYENE
IR TR & L <L, FRk v By AEERR
A AN LN D

o]

Annual maximum wind speed (m/s)

1 Return period (years)

A S P

2 1 [} 1 2 3 4 5

Reduced variate ~In{-In{F))
B7 MCPIEIZ LY sROTIRERBEIZIS 1T 2 MR

O FRME & B HE & o g (Comparison of
predicted and observed extreme wind speeds in
mixed climate by the MCP method)

3. EvFALOLIaAL—2a VITEDIEER
ED T
ELTFANARYI o b—va R AVTERK

JEGE DA A T A6, REMOY 2L

—a VATEDTLD, EERL LE’D < Az s,

RHEFEMEDMEV EIFF SN D, AT T, Ishihara
et al. WOWIRITRE ;h“(b‘é%‘/?‘ﬂ/lfl“/l
L—3 3V OFEEIRAD LI, FEERSEERT
T 381 DIRHTRERIZ DUV TR,

Tropical cyclone
database

Evaluation of tropical cyclone
parameters
v

Generation of virtual
tropical cyclones

v

Prediction of surface wind
speed and direction

v

/\ N
Simulation period °
T
Yes

Extreme wind probability
distribution for tropical cyclones

Speed-up ratio and
deviation of wind
direction

8 BREKEDT T HNARY I al—Ta D
7 11— (Flow chart of the MCS method for tropical
cyclones)

[X] 8 |2y M*t@x:;V~y5/m7u o

BT HAERORIE
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LOBPT 2128y, BMWFRREORIES 2R T
52087 A—F (PR T &, RRhefmib:
PR, HEITRREE, WcBSIEREE, 1707 ) R UK
JEOFREIOWMHENMZRD D, RITRD b
RS2 ANT, T FhruyrIal—iay
IZE YN THES ORI ERE S H, &
L CHRAE LT BV IR AT O KUE 5 2> 5 8 B RE %
R, MK OMEERLHIE ORIR A ZE L 7 EHE
EOBGERAHEET D, BRI, HEE L7 BUHORSR
BT — & % R BT @@%ﬁﬂ*%ﬁmﬂﬂj L,
FNEZA~, FEREMERS A A RD D,
3. 1 BEEKE/ S A —42 O
HARSUE/ ST A — 8 ORI E RD DB,
Wg'k 123317 % 1961 4272 & 2007 LEDOEHHRE D
REET— 4, KUEOH EBIT — 4 3 L ORI
LT D H ML SN TR & SR ERIC &
WEINEZBWRRTET —# =22 e,
BHARSEUE OFEAEE N 131 R gt s &
DR 500km PN % i L 7= B IREIE O
ELTEEL, BEOBIRIT — 22 HHERIOFALH
Easkwsn, £, BMHRKIEOFLEE e, i
EEC, T, BEHIEEEEd,, IR EoB
W7 — 205K, BeRBEfEENEER, 1X, &
273 Schloemer™ |2 L W 2L s RIESTT

1

Uz L RD D,
pir)—ps [7
pepe P

T, pr) IXBEARREO LN r DATETO
KGR C O < ERHIE
ERIEGTT N EDERRNEIRD XD
INCFRFEIC L FE LT, JEDR

HEXEDHTH D,

CERIRIC

;Hz/

P LDRER TR Ap= p, - Pg

#* 2
(Correlation

PR ERRIE AT A — % OB

tropical cyclone parameters)

(13)

\ZR, Hk
SUE p, bR, &[FER
TvikEt sz LN TED, 208
2k vk s,

O A B4R
coefficients  between  measured

In(Ap) | In(

Re)

In(C)

0 dmm

In(p) | 1.00

-037

-0.02

-0.03

0.27

InR, | -037

1.00

0.42

-0.06

-0.28

InC) | -0.02

0.42

1.00

-0.31

-0.27

[4 -0.03

-0.06

-0.31

100 -035

Chnin 0.27

-0.28

-0.27,

-0.35

1.00

BT, BVFRR
AR AN

UED 5 DD/RT A—H L3
ORISR R L 0l LT,
Ap, R,, CIIHHUER AR & U A TN BA0 DIRE

534ii (shihara et a.10)),

mi

Lo TIET %, SR E1

@ IXIER 534 (Vickery and
Twisdale12)), d, (X ZWKBIH, 4 1EET Y L6
B2 EHRR

BHARSIEDF /8T A — X DRI B3 (Probability density functions of tropical cyclone parameters)
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Parameter Distribution Probability density function Value
u = 1584
Central pressure o= 0.115
difference Ap ko= 4158
¢ = 43733
) a = 1.000
1 1{Inx— g = 2102
F, (x)=ax 7_[ ] “
Radius of maximum _ ! V274, { 2\ O o = 02
wind R mixed " . k = 1917
m (1-a ><k/x ool [ X c = 164679
)'ELE' PI-ls a = 0521
u = 1657
o = 0227
Trandation velocity C k = 2484
¢ = 57.481
a = 0000
- 1 1 x-uY = 143349
F,(x) = exp| ——| —£ H
Approach Direction ¢ | normal v (X) > Xp[ 2( - j} o = 25738
Minimum approach ) 2 z = -409.980
distance d,,, polynominal uin(X) =26 =(Z-2r)x-r ;= 500000
T exp(~
ﬁnnual ocourrence rate | oL Ax) = expf Am) 4= 2787
x!
5
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ERT A — 5 OFEREEBEEIR L U2 0EEDE

(k) (k) _

BEVTRLE ©oC 4 ko 1k ET 5% [&% EJat =0 (19
T A2 OV L OFEHERE, k LcldTUA T P, 5 EOEZ D7 ) BRI OB 2%
SATOIGRIRE - REERE, alRRARE, 213 ﬁmﬁz% B Al =1 & 9 okt
BSOS, r I3 AREEEE (B00km), A (AP %g¢5gqmﬁ CREWTRAESES, 1L, HED
BN, xR B, RN AIAE ORI D 2T 5, 22

T, HBAEZE L7 3T A—2 O x, 13z ko
3.2 (REMBESEDER BH L RTED,

£ 2104E, BUIRSIE OB — 4 s bR T < 0 ot

5 A — HOABIREE T, — DFME /T A— x=[o" ¥ .. 0]z (16)

ZIZE 2T 03 ZBADHEBRER A LN D Z EAS ZRHEDRY X BABEHRGE AT A— & g)ﬂfﬂ
ShB, ZHOMBAL Ishiharaeta ) Ik TR Lz 2L, x Ol x OBEREOERIL B

G U IE I S M (modified omhogonal 32 AT LTy B %, HS vt B B
decomposition) % FIV  THHL L, MBIRILR Aii7= 7" & bl s L ICIEE T B LERH S,

07837 A= 5 OITR SN D AR AR BT, x A TN OREZ, WesRm s H AR

JEERAESE D, U MCBIRERIMROFMNER i3t deiii= & 5 Wi« DBFHEMIEET 5, =

7o DL XRG A—F DMBEDRELEZ N0,
HHRRUE T A —F DOEED/ T A—H &K 5 A— ZRIOFENTITIE L A SR B2 2,

fEL, KOLS AT PADFTES, #3043, EERB AL L 0 kb7 FABHREK
X :{m(Ap), In(Rm), In(C), 0, mm}(14) %Tﬂ;‘ EIEEAZEHGEIZ X0 RO T-FHEIREN

B E ORLNF — 2 10 sk - FRNRE (38 2)

HHRRIED RT A — &Fﬁ@/\ﬁkitéz\ﬁ&ﬁﬁll% &'ii BLTWDZ NG5, ZOE5ITRD

S &L, EEMAY EEERT BAATHIOW &k t?ﬂ*‘*ﬁ SIEDFK /T A — 2 ORESREERIY, X
Ik osRbdz, QIRT L IZEF —# b L aRlLTnab 2 &

o Measurement o Measurement
—WPDF ——MPDF

o Neasurement
—HPDF

ooe®

In=In(1-F)) Int-In(1-F)) In=In(1-F)

(a P ORIEE TEAP (b) FHbEfEGER - R, (o) HEATHEEC
(Central pressuredifference AP) (Radius of maximum winds R,,) (Tranglation velocity C)
360 500 0.
° leasuremen’ © Measurement leasuremen
315 . ——Polynonial wg@@’@ o
e z
= 0 5020
< g 3
) a
250 g 010
= = 4 0 1 2 3 e 02 04 06 08 10 O s s 1 5 v o
normsiny i/ n+) nunbers of oceurence
(d) AT HE 0 () ekl iRt d (f) FEFEAESREE A
(Approach direction &) (Minimum approach distance d,;, ) (Annua occurrencerate A1)

9 BFRRIEDS /T A —F OReRE LRI L BRI —% & ok (Comparison of probability density functions
of tropical cyclone parameters and observation data)
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T,

z 3 BAHFHRQIENRT A —% 0T HEO MR
(Correlation coefficients between estimated tropical
cydone parameters)

In(4p) [IN(Re) [ 1N(C) | 0| hun
Inap) | 100 -036] 001 003 025
In(Ry | -036] 100 038 -005 -027
In(C) | 001] 038 100 -028 -025
o | -003] 005 -028 100 -035
dun | 025 -027] -025 -035 1.00

utwkmtm¢%7w B RECYS R WAt s
HHERIEORIESORBEZREET 572012, f#x
DT A—H ORREIATTH Y, ABGECIIE
FERGH AR LTt 217 - 7o, RS, &UE
HEBSEOSE T VAT T RT AT B LGE

U7 B R ORD A Z LT, AUy
FzENn5,
v, =0 (7
vﬂg:Csinefr+\/(Csin6frJE+La_p (18)
2 2 paor
::'C, Vy &V, i%ﬂ%ﬂ*?’éﬁf’lﬂ&%ﬁﬁfﬁl@
TREERR ) %TL FIEm VAV T A—=% plI7E
R, AR ST DT H T Aot Y,

QO Measurement it
50| | ——Monte Garlo Simulation

Gradient wind speed (m/s)

Redused variate —In(-In(F))

X 10 #hrRgeatmizisl) 2BEROFEED
T & B & o B (Comperison of
predicted and observed gradient winds a Choshi
M eteorological Station)

10 12}3, @E—EH%%M’ Lo Lk rR
BENIBT D 1 THESOBEHRAGED 10 5535
HORERYT — & H SRR KIE G O B R RSy
i & FERITB & 7 BV IR KU ORI & SUE D
T 5%%:#&71&3&(11@%7‘#‘ AN 384
Lt’fﬂ BT X0 SR 7o A BE G 0 4 J5e K i

HITRE iaa)ﬁﬂ«ﬁlf AT 30 R T AHFE K &

—HELTWD I Enh, APRTLVHE LBV
BREE T A =23 R X CERlsh 2R ES %
FERLTWD Z EN005,

3.3 i EREDHE

BT L 5 M b JRGE V3o 5 i s oD JE] 52
ﬁ%%iﬁﬁf@gg%ﬁﬁJMMmadeib
BEBINERIUCL Y RoT,

U, =Ug xS (19)
8, =6 +D, (20)

U & 6 V3PE b et S T O BHHR RS
TR & A AR L, v &6 T HEHED
SEHHE b C oo BARR RUT A 18 R oD JEGE & R A A
EE %Fﬁl’rﬂﬁé@%ﬁ@ X B JEEOBIEEE S, & B
A D i ERGERRRTIZ &V kT,

—REHLE O ot S s BT A KR
JEGE DERTE /3 A u (2) & AR DENEL A y (2) 1E
GO LS ckEND Y,

G

u(z)=y, [Zi} (21)
7 1.1
]/(Z)—;/s(1.0—0.4—] (22)
ZQ’
T, Uy (= Vg + Y WHBUERGE, z, 1 2BV
é , ‘iﬂﬂi%ﬁﬁ LOEE, o T EEGEOESY

MO~EERE, 5, Liﬂﬁ%ﬁi f:ﬂiiﬁﬁllk‘ﬁ 2 B\

WATHL, FlZNE0/RT A — 2 TEE R, ,

HREHEER z,, MR 1, MEOIE—FRIES
FF NG AL ERHOTUTOL 5 12T = &
NTE D,

a, =0.27+0.09l0g(z,)

(23)
+0.018l0g? (z, ) +0.001610g° (z,)
U, 145
2, =0.082-(log Ro,) (24)
A
=(69+100¢)(log Ro, ) (25)

5 % %
fﬂ:[ﬂ;rv"_%r fj (zv’i+ fj (26)
o r r

YA
g=£2%§+fj /Ti;g+%%+fj 27)

ZIT, Ro, (=U,/f,z)3EEHHK A —¥L
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RN e TH D, DT AORHIL, #E
KR TEOSE CHWLh TE X BT L
OGS X OEFTE el 220, U OSRE S5A
OXfEE, BERES, RRORA & M e
E, BEHEKTEORME & OBMEI LIRS 2 5
NG ThD, ZOXHIT, MEHEIZEIT A3
HHERA 525 &, —BHES Lo Eo
AR AU R o0 U & JRL A O SR TEL 53 A A SR 30

Hhb,

AMF e T M oo BGE &,
1S04354™ % 2 BRI IR D ~ & 58 0, =0.1 2
WTRWDTz, EIJEUME OB E ST - Bt
WS ToRM & JREORSRYT — 2 1%, FEERN
FHRIEF /L MASCOT 12 & 0 sk 7= JRK o Bl iRk
& AR A 2 O TR(19) L R0 KL W EH LT,

X 110, FERERURTRIET U X D R
YR OBIHAEE O BT & A B2 a3, JRE
67.5~180° DOFPHOEBHEFRENL, a1 TH Vi
USRS LTS, ZRLIAA OO RMIZ 1 LY
M0 NS S EORBE R ZIT TN D, 20 L)
AT T, MEEHE SR —Th D, MR
TEHLEE 33 X OB M 0 25 % B 58 U 7= B O 3T
MRSETHD 2 Ebnrb,

2.0 .

r/*f Wﬁ\v

0 5 ) 185 180 5 70 as 360

Wind direction (degree)
SEREGE O FFE R O BRI L A2
(Variation of speed-up ratio of mean wind speed
with wind direction)

4 11

FELTFANATYI 2l — g LS VHEESH
% AL 1 R 5 3 R o RS TAHYS 35 &
EhhTn g YRR 10 45 TR 2
T 5 BRI U R D 2 B JE L 724 TR
ECHhD, Yasui et al. i, BEREOBNT— 2 %
FRAT L, 3 RERSERUE & 10 45TE1ERRGE & oze
ERGATERTE S Z L%, RRITE DV IER
3R OIEHERE 0, TSRO T2,

o, =0.1xu; (28)
HeAIESL 0.1 1 Yasui et a.'? |2 L v iRE S ET
BB, ZORBIEEOEE R L > TEL LT

WA Z LSR8 12 L W RS TV A,

X 12 2%, ErFhruasIal—iavick
Y KD T Bf KRG O FE LR R4 A1 23, T
W, BEE (AR £E—BL WA Z ERnhd,

O Measurement.

Monte Carlo Simulation
50 - 48 1(n/s}

OO

nnual maximum wind speed (m/s)

2 5 1 20 E 00

-2 5 [} 1 2 3 4 5
Reduced variate ~In(-In(F))

12 BVHERRE DGR R BUE O T IIME & BE &
@ bt (Comparison of predicted and observed
extreme winds caused by tropical cyclones)

JRELZVER T2 AT E 2 3l A BRI, MRER
D 50 FEHHIFHE DI 5T, FHREOE
A D& PRt X OVELIRIRE & 3R 5 LB
o5, AWFFETIE 50 FEHBMIFRHEIC RIS T 5
JrLE] (50 AFEFBLEIAHiE00.5m/s oD R FHPY D JR\A]
DIEIHE) ZoR¥d, Z O Z EIEGEOSRIE A
DX U X ONELTTRE & 3T 2BV S
AR & U 7o, AR OIS S350 2 AT
EREEEA T D, Z OBBNIKRET 5 FGED
NPT 04, ELTREEIZ 011 TH D,

3.4 EASREICHIT ABEREDEMR

24 F Gk~ IRA KR T s VT A AE G O R
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